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1 Welcome

And thank you for using CardExchange™ Producer for producing your cards! We appreciate

your business!

CardExchange™ Producer offers a multiple card-template interface that allows you to

produce cards in just a couple of clicks. Our CardExchange™ Producer Card Production

application is 8 years+ in the market offering you an solution containing all our experience

and knowledge available for secure production of your cards!

We strive to innovate by offering market leading solutions. Now with the release of the 9th

generation of CardExchange™ Producer, we offer the complete new Service Center section.

This section offers you all the tools you need to create, produce, deploy your cards. When

needing support, this is the place to be. Always wondering how to get fasted support, in the

Service Center you can find all the information from your CardExchange™ Producer reseller

including his web address. In the Service Center CardExchange™ Producer, your Reseller, the

Manufacture, etc., we all keep you posted with important information about your software

and hardware.

Also new in CardExchange™ Producer 9 is support for Biometric devices and ID scanners.

The print engine is completely rebuild and now supports GDI+ printing. This all results in a

fantastic printing quality and a faster startup time with an increase of more then 50%!
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We are also introducing a new addition to the CardExchange™ Producer

family...CardExchange™ Producer GO Edition. Now offered as our new entry level edition,

the GO Edition comes with an internal database which enables better protection and

management of your stored data. We have redesigned the entire main interface and

updated all the icons to enhance ease-of-use and improved intuitiveness.

But that is not all...

Get access to our huge collection of "How-To" videos on our website offered in English and

Spanish. Join our CardExchange™ Producer community by visiting our online end-users

forum where you can find quickly answers to your questions, post questions, etc. Compare

the functionality of your edition with the functionality of other available editions, etc. Find

all you need to know in the Using Service Center section of this help file and be amazed

what is been offered!

Receive FREE lifetime version upgrades (not available for CardExchange™ Producer Small

Business Server editions) by simply registering your CardExchange™ Producer license. For

more information, please see the Getting Started section of this help file.

It's not just about software; it's about the experience!™

http://www.cardexchangesolutions.com/our-downloads/videos-downloads.html
http://forum.cardexchangesolutions.com/recent
http://forum.cardexchangesolutions.com/recent
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1.1 Version 8 Users

If you are running version 8, please click on the button below and you will be directed to

the latest online help file. A lot of things have change with CardExchange™ Producer since

version 8 and functionality described in this help file can differ from the version 8 one.

CLICK HERE TO VIEW THE VERSION 8 HELP FILE

http://help.cardexchangesolutions.com/en/v8/ApplicationHelp.htm
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2 Overview

CardExchange™ Producer is offered is as a Single License and as a Multi License Small

Business Server Solution.

Our Standard Single License Solutions are available in four different editions:

Go PREMIUM PROFESSIONAL ULTIMATE

Starting with the Go edition offering an internal database which enables better protection

and management of your stored data. The Professional edition offers real database power

with connections to multiple database servers, native connections, etc., ending with the top

of the line, our Ultimate Edition offering inline MIFARE® Classic and MIFARE® DESFire EV1

encoding. All CardExchange™ Producer standard single license editions offer inline

Magnetic Encoding functionality. Compare all our editions on our website by CLICKING

HERE!

Our Small Business Server, Multi License, Editions are also offered in four different flavors:

PROFESSIONAL ULTIMATE DISPATCHER PRINT SERVER

Starting from the Professional edition, our Small Business Server offers you the powerful

option to manage your licenses from a central location of your network. No more local

licenses that need to be activated, no more need of using license dongles on local

computers, just one location that holds your licenses. But it also offers the power of Central

Data Management. All your card-templates, database connections, etc., managed by one

administrator, user, computer, etc. The days of multiplying all your configurations are over!

But that is not all!

In combination with the Dispatcher and Print Server Editions, you will be able to create

complete service bureau print farm solutions including load balancing printing. Send all

your print jobs to the Dispatcher and/or directly to the Print Servers... It is all in your hands

with the CardExchange™ Producer Small Business, Multi License, Solutions.

https://cardexchangesolutions.com/id-card-software/cardexchange-id-card-software/cardexchange-compare-editions
https://cardexchangesolutions.com/id-card-software/cardexchange-id-card-software/cardexchange-compare-editions
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For more information about our CardExchange™ Producer Small Business Editions, please

visit our website by CLICKING HERE! 

Or take a look at all available and offered functionality by CLICKING HERE!

https://cardexchangesolutions.com/id-card-software/cardexchange-multi-user-id-card-software
https://cardexchangesolutions.com/id-card-software/cardexchange-multi-user-id-card-software/cardexchange-sbs-compare-editions
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3 FAQ

This page contains a selection of our most common and frequently asked questions...

· How can I activate a CardExchange™ Producer license?

· What should I do if activation fails?

· How can I move my CardExchange™ Producer installation to another computer?

· How can I create a new card with the user-guided wizard?

· How can I create a new card without the user-guided wizard?

· How can I connect to an Excel database?

· How can I show to Photos on my card layout?

· How can I store ID photos in the database?

· How can I use signature pads?

· Which Photo Cameras are supported by CardExchange™ Producer?

· Which Signature Pads are supported by CardExchange™ Producer?

· Can I use finger-print devices with CardExchange™ Producer?

· How can I show a variable image on the card layout?

· How can I print multiple records on a single card?

· How can I print multiple layouts with a single database connection?

· How can I configure magnetic encoding?

· How can I link to multiple databases?

· How can I integrate non-standard functionality (plug-ins)?

· How can I protect CardExchange™ Producer with user names and passwords?

· How can I find answers to specific questions about CardExchange™ Producer

(forum)?

· Using GDI+ printing technology when printing results are poor.

· How to use Biometric with CardExchange™ Producer.

· How to use ID scanners with CardExchange™ Producer.

http://www.cardexchangesolutions.com/license-activation.html
http://www.youtube.com/watch?v=BxxYUxbGuFo&feature=youtu.be
http://www.cardexchangesolutions.com/pepro.html
http://www.cardexchangesolutions.com/cardexchangeultimate/ultimate-signature.html
http://forum.cardexchangesolutions.com/
http://forum.cardexchangesolutions.com/
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4 Getting Started

To get started with CardExchange™ Producer, it is important to get familiarized with the

interface. It is important to know that CardExchange™ Producer basically is a combination

of two disciplines:

· The Main Interface offering the multiple card-template interface and data-editing,

etc.

· and the Configuration Interface, the Card Designer.

Most of the time you will be working from the main interface

In a very convenient way it offers you the possibility to select your card-templates at the

left side followed by selecting the record that needs to be printed, take a picture or scan a

signature on the right side, followed by the print command.

The configuration of this all is done directly via the Configuration Interface, the Card

Designer
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In the same setup as the main interface, from the left side you see all the available card-

layout(s) and card-pages with all the available tools organized in different sections via the

ribbon bar.

As we recognize that most people are used to working with Microsoft Office products, our

CardExchange™ Producer products are also designed accordingly. Not to make our lives

easier, but yours! Everybody that can work with Microsoft PowerPoint or Word, will have no

problems finding their way in CardExchange™ Producer! 

4.1 About this Help File

In this help file we will explain all available functionality of our CardExchange™ Producer

Single License and CardExchange™ Producer Small Business Multi License Editions.

The help assumes that CardExchange™ Producer is installed on your system. If

CardExchange™ Producer is not installed on your system, please do so first.

Please be aware that there are two different installation procedures for Single License

Editions and Small Business Multi License Editions.
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These Quick Install Manuals are available on our website as online help and as PDF Manual:

· CLICK HERE to view the CardExchange™ Producer Install Manual

· CLICK HERE to view the CardExchange™ Producer Small Business Server Install

Manual

Our Help files are additional to our online end-user forums. Our forums are always leading

if it comes to explained functionality of CardExchange™ Producer. We prefer you use this

forum as much as possible as it not only can help you, but also other CardExchange™

Producer users all over the world.

Visit and register on our forum today by CLICKING HERE!

4.2 Our Trial Edition

Our CardExchange™ Producer Demo Edition offers you unlimited access to all available

functionality within our editions for an unlimited period of time. When you have installed

CardExchange™ Producer for the first time, just select "Evaluate CardExchange™ Producer"

and select the edition that you want to try out.

http://help.cardexchangesolutions.com/en/quickinstall/index.html
http://help.cardexchangesolutions.com/en/sbsinstall/index.html
http://forum.cardexchangesolutions.com


Getting Started 17

© 2016 CardExchange Solutions, Inc.

We offer the possibility to try out our Go, Premium, Professional, and Ultimate editions. You

can find more information about the offered functionality per edition by CLICKING HERE!

https://cardexchangesolutions.com/id-card-software/cardexchange-multi-user-id-card-software/cardexchange-sbs-compare-editions
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When you have made your selection from the drop down menu, simply click on Finish to

start your trial and use all functionality offered. The only limitation of the Trial is that it

prints DEMO on the card. The nice part is, when you have configured, designed, connect to

databases, etc., and you like our CardExchange™ Producer application, you simply purchase

a license, activate it, and you keep on working. Nothing needs to be redone!

Activating your Trial or your new installation is explained in our Activation and Registration

section of this Help file.

4.3 Activation and Registration

IMPORTANT! This activation and registration process does not apply to our Small Business Multi License

Edition Product! Please view our Small Business Server Edition Install Manual for instructions.

When you have used our Demo Edition and you want to use it, or you directly purchased

our CardExchange™ Producer application via one of our resellers, you will have to activate

the application. To activate CardExchange™ Producer you need to have a Serial Number

and Activation Code.

The serial number is a five (5) digit number and looks like 23144. The activation code is a

24 digit number and looks like 017DF-116DA-1ABA4-DDF80-CF05F-32D99-371F.

Activating your license is very easy to do. Just start your new installed CardExchange™

Producer application or start your Trial Edition.
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Select the "Activate CardExchange™ Producer" option and click on the Next button.
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Enter your serial number and activation code.

The Machine ID is unique for each computer that CardExchange™ Producer is installed on and is used for activating
the license and identify your computer by our licensing system. The Machine ID is generated based on your internal
computer hardware. If activation fails because you have, for example, no internet connection on your computer, your
license can also be activated directly via our website but to activate your license via our website, you need to have
this unique Machine ID. For more information about activating your license, please view our Video Section on our
website where you can find helpful videos about installing and activating CardExchange™ Producer.

When you have entered your license information, you click on Activate to start the

Activation process.

At the moment the activation process starts, you can start registering your license.

Registering your license offers a lot of benefits. It offers access to our End-User Help Forum,

it informs you about new releases and updates, etc. But that is not all... when you register

your CardExchange™ Producer license, you will receive FREE lifetime version upgrades!

http://www.cardexchangesolutions.com/our-downloads/videos-downloads.html
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In the registration page you can enter all your company and contact information. The fax

number is optional, all other fields are required. Select the printer brand you are using, the

type of company, and in which language you prefer to communicate. Last but not least,

provide an Alias for our End-User Forum. Standard your alias is the same name as the name

of the contact person, but you can change this to something else if you do not want to have

your name shown in the forum with your post.

IMPORTANT! Your provided information will never be commercially sold and will only be used by

CardExchange Solutions and your reseller to provide you with important information about your software

and hardware!

When you have provided all information, click Next to proceed to the next page of the

registration.
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In this page of the registration process you can first indicate if you want to use 30 days of

all functionality available in CardExchange™ Producer, the Ultimate edition. This can be

handy if you have, for example, received a Designer in the box. Selecting this 30 days trial

will offer you an insight to available functionality to determine which edition fits your

situation best before buying. All trial functionality will be clearly indicated as TRIAL.

If you would like to be contacted, just select how and when, and your reseller will contact

you on the preferred date selected.

Last but not least, subscribing to our newsletter offers you information specific for your

software and hardware that you are using.

Click Next to proceed to the Final page of the registration process.



Getting Started 23

© 2016 CardExchange Solutions, Inc.

During the registration process, your CardExchange™ Producer license has been activated.

Click on Finish to finalize the activation and registration and start CardExchange™ Producer.

For more information about updating your registration, please visit our "Update Your

Registration Info" section of this Help file. Want to upgrade your license to a higher edition,

please visit our "Upgrade Your License" section of this Help file.
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4.4 Data Folder

During the installation of CardExchange™ Producer you are asked to select a location for

your Data folder. By default this folder is installed in your Public Documents folder under

CardExchange.

The Data folder of CardExchange™ Producer is very powerful and unique at the same time.

Everything that you design like templates, database connections, encoding files, etc., all

these files are stored in the Data folder of CardExchange™ Producer.
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When you open the Data folder you see the sub folders for Backgrounds, Clipart, Database,

Database Connections, Photos, and Templates. Even if you store your designs somewhere

else, CardExchange™ Producer always makes a local copy of of the original in this Data

folder.

The Date folder also contains all the configuration from all the different templates. We

therefore strongly advice to make regular backups from this Data folder especially when

you have made changes in your configuration.

When your computer crashes and you need to reinstall CardExchange™ Producer, after the

installation and re-activation, you copy the backup of the Data folder back, start

CardExchange™ Producer and all your configurations are restored and you can start

working directly again.

The Data folder can be located on any location, also on a network server. The Data folder

can however not be shared between different CardExchange™ Producer editions inside

your company. Each CardExchange™ Producer license needs to have it's own unique Data

folder. If you want shared Data folders, you will have to use our Small Business Server

edition.
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5 Using the Main Interface

The CardExchange™ Producer Main Interface is known as the most easiest to use interface

in this market. After the system is configured, you only have to make a card-template

selection from Loaded cards menu on the left, select a record or records that needs to be

printed from the data-grid, take a picture or capture a signature via the buttons on the

right, and produce the card(s) by simply clicking on the Print button.

In this section of the Help file we explain the use of the menu and the ribbon bar.

5.1 Menu Overview
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Open the menu by clicking on the Application button on the left upper corner. In this menu

you can select to log off if you are using User Authorizations.

You can also click on About CardExchange to show you information like your serial number

and installed version. Last but not least, the Exit button that closes CardExchange™

Producer.

5.2 Ribbon Overview

CardExchange™ Producer offers a lot of functionality for printing, producing, and creating

cards. The Main Interface of CardExchange™ Producer is especially designed to create a

very user-friendly production environment. All the functionality is organized within each

separate tab of the Main Interface ribbon.

TAB DESCRIPTION

Print All functionality related to printing

Data All functionality related to data editing

Photos All functionality related to using photos

Signatures All functionality related to using signatures

Biometric All functionality related to using Biometric features

ID scan All functionality related to using ID scanner features

Configuration All available configuration functionality

View All available settings regarding the current view

Service center All functionality related to service and support of CardExchange™ Producer

5.2.1 Print

IMPORTANT! If you are using our Small Business Multi License Edition Product, please view the "Printing

Cards" at the Small Business Server section of this Help file.
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The Print tab is organized in different groups with specific functionality.

Group Function(s) Description

Options Printer Options Configure your printer(s), contactless encoding

Standard printer Print card Opens the print dialog

Printer

properties

Opens the printer properties dialog of the selected printer

Export preview Exports a preview of the card as a file

Print report Opens the Print report dialog

Windows

printers

Select printers Select printer(s) that can be directly accessed via Print to

and the Explorer Menu

Print to Print directly to the selected Printer from the drop down

menu

Automatic

printing

Edit trigger Edit and activate the printing trigger

Start printing Start automatic printing if configured

Show print log Show the print log

For more detailed information about printing, please visit the "Printing Cards" section of

this Help file...
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5.2.1.1 Printer Options

When the printer options window is opened, it will present all the installed Windows

Printers on the system CardExchange™ Producer is running on. Just select the printer you

want to use from the list view and click on OK to confirm.

If you want to use the selected printer for all loaded card-templates, make sure you check

"Apply these settings to all loaded cards" otherwise each card-template will have it's own

specific printer connected.
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5.2.1.1.1  Contactless

In the Contactless tab you are able to test your hardware configuration for encoding

contactless cards.

The Reader Info Section

· Reader type - Select the reader being used inside your printer or external

· Serial port - Select the serial port the reader communicates with (not applicable for PC/

SC)

· Baud rate - Select the baud rate (speed) of the used reader

· PC/SC version - When PC/SC readers are used, select the version 1 or 2

· Reader pin code - If reader requires a pin for access, you have to enter it here

· Test reader with card movements - Set to True or False

In the Reader Info Section you can also find two buttons. The button Refresh refreshes the
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list of readers available in the Reader type drop down menu. When a new PC/SC reader is

added to the system, this button needs to be pressed to make it available. The second

button is the Test button. Depending on card movements setting, clicking this button will

move the card to the encoding position of the printer that is selected in the Printer Options

section and will test the reader.

In the reader test window it will indicate if CardExchange™ Producer is able to

communicate with the reader, and if a card is presented, can read the CSN (Chip Serial

Number). These test are clearly marked with Red and Green lights.

When using older printers that works with so called escape commands to move the card in

the encoding position, there is no information shared about the exact position of the card

in the printer. For these printers we need to set the Time delays in the Time delays section.

There are basically two settings that can be entered; Time delay before encoding and Time

delay after printing. The average time delay after printing is round 30 seconds (30.000 ms).

On the the moment that the card is electronically processed, it will be set to print position.

On that moment CardExchange™ Producer will prepare the next card for encoding, when

printing multiple cards of course. After 30 seconds, independently of the state the printer is

in, CardExchange™ Producer will instruct the reader to access the card. With these older

printers you will have to play a little with these time delays to get the best results. Don't

forget to make sure to check the Configuration settings in the Advanced options for using

Factory or non-factory build in readers.

Factory build in readers normally work via SDK's (Software Development Kits) that give

CardExchange™ Producer full control of the printer and time delays are normally never

needed and can stay in the default settings of 2000 ms.
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1 sec = 1.000 ms

Of course, all these setting made can apply for all cards or the selected card only.

For more information about Contactless encoding, please see our Using Contactless

Encoding section of this Help file.

5.2.1.1.2  Magnetic

In the Magnetic tab you can set the start and stop commands for the printers to encode the

magnetic stripe. Most common start and stop commands can be found on our 

CardExchange™ Producer End-Users Forum. Of course, these settings can apply to all cards

or the selected card only.

http://forum.cardexchangesolutions.com/component/kunena/18-general/36-start-and-stop-sentinels-for-magnetic-encoding
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IMPORTANT! These Start and Stop commands only apply when using the old version 6 Designer! Magnetic

encoding via CardExchange™ Producer 7 and higher is explained in the "Using Magnetic Encoding" section

of this Help File!  This Magnetic tab is hidden by default, to show it you need to enable the show advanced

mappings option under Advanced Options.

5.2.1.2 Select Windows Printers

Besides the fact that each card-template can have it's own unique printer connected, via the

Windows Printers functionality, you can make specific Windows printers available to

overrule the default card-template printer which you configure in the Printer Options

section.

When the Windows Printer Manager window is opened, you can make the printer available

by checking the check box in the list view. You can also move printers up and down and

rename them so they have more user friendly names.

The selected printers will become available in Windows Printers tab under the explorer

menu.
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5.2.2 Data

The Data tab is organized in different groups with specific functionality.

Group Function(s) Description

Options Edit Options Opens the Edit options window

Find Text box Enter a value to search for in this text box

Find Opens the Find dialog

Find next Finds the next result matching with the value in the Find

name dialog

Change sort order Change the sort order

Refresh data Refreshes the data in the data grid (name list)

Select all Selects all the available records in the data grid (name list)

Edit Database record Opens the Database record window in the main interface

Manual entries Opens the Manual data entries window in the main

interface

Filters Edit level one filter Opens the Edit level one filter dialog

Edit level two filter Opens the Edit level two filter dialog

Enable level three

filter

Enables the level three filter for live search on the database

Filters Shows all the created level two filters in a drop down

menu

For more detailed information about using data, please visit the "Using Data" section of

this Help file...
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5.2.2.1 Edit Options

The Edit Options window offers you two different sections to automate your processes. You

can set specific actions after inserting a record into the database or after entering data

manually.

In both situations, after clicking Apply in the Data Edit window or Manual Data Entry

window, CardExchange™ Producer can automatically acquire a photo, import a photo, print

the card, etc.

Simply select the functionality via the check box and click on OK to apply. If you want to

use these settings for all loaded card-templates, make sure you check "Apply these settings

to all loaded cards"
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5.2.3 Photos

The Photos tab is organized in different groups with specific functionality.

Group Function(s) Description

Options Photo options Opens the Photo options window

Use image editor Select to automatically open the image editor after

acquiring a photo

Ask for confirmation Select to ask for confirmation before storing the photo

Use FaceFind Select to enable automatic face recognition (Professional

and higher)

Actions Take photo Opens the photo capture window

Import photo Opens the file dialog to select a photo image

Edit photo Opens the Image editor showing the selected photo

Export photo Export the selected photo to a file

Remove photo Remove photo from file or database

Copy photo Copy the selected photo to clipboard

Paste photo Paste photo from clipboard

Crop to Face Use auto face recognition on the photo (Professional and

higher)
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5.2.3.1 Photo Sources

CardExchange™ Producer supports all different types of cameras, supported via Twain,

DirectShow, but also Canon Cameras via the Canon SDK's. In the Photo Source window you

can select the device that you want to use for capturing photos with CardExchange™

Producer.
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5.2.3.2 Photo Options

By default, CardExchange™ Producer does not print records if an image/photo is not

available when batch printing. If you have a Premium of higher edition of CardExchange™

Producer you can change this behavior as well other actions.

You can set print actions when image is available or not available like acquire image, skip

printing, print without an image, etc.

It is also possible to set other actions like Ask for confirmation, show image editor, etc. One

important and useful one is the Import instead of acquire. This changes the behavior of the

Take photo button in the ribbon, but more important, the Take photo button in the 

Functions Menu. So if you are not taking photos with a camera but always import them,

select this option and have easier access to your photo files.

If you want to use these settings for all loaded card-templates, make sure you check "Apply

these settings to all loaded cards"
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5.2.3.3 Face Find

If you are using a CardExchange™ Producer Professional or Ultimate edition, you will have

access to the automatic face recognition functionality, Face Find. This functionality allows

you to automatically crop the face to the correct size based on elements analyzed from the

face on the photo. In this Application tab set all the parameters for this functionality like

the size, the horizontal- and vertical offset, etc.

5.2.4 Signatures

IMPORTANT! Signatures are supported starting from Premium and higher editions!

The Signature tab is organized in different groups with specific functionality.
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Group Function(s) Description

Options Signature optionsOpens the Signature options window

Use image editor Select to automatically open the image editor after acquiring a

signature

Ask for

confirmation

Check to ask for confirmation before storing the signature

Actions Capture signature Opens the signature capture window

Import signature Opens the file dialog to select a signature image

Edit signature Opens the Image editor showing the selected signature

Export signature Export the selected signature to a file

Remove signatureRemove signature from file or database

Copy signature Copy the selected signature to clipboard

Paste signature Paste signature from clipboard

5.2.4.1 Signature Device

When the Signature options window opens, the first selected tab available is the Device
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tab. CardExchange™ Producer supports a large range of Signature Pads from Topaz,

Wacom, and Signotec. Also standard Wintab is supported. You can find a complete

overview of all supported Signature Pads on our website by CLICKING HERE!

In the Device window you simply select the brand you are using, line colors if applicable,

and the line width.

If you want to use these settings for all loaded card-templates, make sure you check "Apply

these settings to all loaded cards"

5.2.4.2 Signature Options

By default, CardExchange™ Producer does not print records if a signature is not available

when batch printing. If you have a Premium of higher edition of CardExchange™ Producer

you can change this behavior as well other actions.

You can set print actions when image is available or not available like acquire image, skip

printing, print without an image, etc.

It is also possible to set other actions like Ask for confirmation, show image editor, etc. One

https://cardexchangesolutions.com/id-card-software-support/cardexchange-devices/cardexchange-signature
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important and useful one is the Import instead of acquire. This changes the behavior of the

Capture Signature button in the ribbon, but more important, the Capture Signature button

in the Functions Menu. So if you are not capturing signatures with a signature pad but

always import them, select this option and have easier access to your signature files.

If you want to use these settings for all loaded card-templates, make sure you check "Apply

these settings to all loaded cards"

5.2.5 Biometric

IMPORTANT! Biometric is supported in our Ultimate edition!

The Biometric tab is organized in different groups with specific functionality.

Group Function(s) Description

Options Biometric options Opens the Biometric options window

Ask for confirmation Check to ask for confirmation before storing the biometric

data

Actions Enroll biometric Opens the biometric enrollment window

Verify biometric Opens the verify biometric window

Remove biometric Removes the biometric data from the database
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5.2.5.1 Biometric Devices

When the Biometric option window opens, the first selected tab available is the Device tab.

CardExchange™ Producer supports a large range of Biometric devices from Topaz and

Digital Persona. You can find a complete overview of all supported Biometric devices on

our website by CLICKING HERE!

In the Device window you simply select the brand you are using. If you want to use these

settings for all loaded card-templates, make sure you check "Apply these settings to all

loaded cards"

https://cardexchangesolutions.com/id-card-software-support/cardexchange-devices/cardexchange-biometric
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5.2.5.2 Biometric Options

By default, CardExchange™ Producer does not print records if an biometric image is added

to the page design and is not available when batch printing. If you have a Ultimate edition

of CardExchange™ Producer you can change this behavior as well other actions.

You can set print actions when image is available or not available like acquire image, skip

printing, print without an image, etc.

If you want to use these settings for all loaded card-templates, make sure you check "Apply

these settings to all loaded cards"

5.2.6 ID scan
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IMPORTANT! ID scanning is supported in our Ultimate edition!

The ID scan tab is organized in different groups with specific functionality.

Group Function(s) Description

Options ID-scan options Opens the ID scan options window

Ask for confirmation Check to ask for confirmation before storing the ID scanner

data

Actions Scan document Opens the ID scanner window

Remove document Removes the document from the database

5.2.6.1 ID Scanner Devices

When the IDscan option window opens, the first selected tab available is the Device tab.

CardExchange™ Producer at this moment only supports ScanShell devices. More devices

are planned to be supported. You can always find a complete overview of all supported ID

scan devices on our website by CLICKING HERE!

To use the ScanShell scanner you will have to install the driver and the runtime. You can

https://cardexchangesolutions.com/id-card-software-support/cardexchange-devices/cardexchange-cardscanners
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download this from our download section on our website by CLICKING HERE. The driver

can be found in the CardExchange™ Producer Driver section.

In the Device window you simply select the brand you are using. If you want to use these

settings for all loaded card-templates, make sure you check "Apply these settings to all

loaded cards"

5.2.6.2 ID Scanner Options

There is only one option that applies to using ID scanners and that is to ask for

confirmation before storing the data into the database. This can also be selected directly

from the ID scan tab in the main window of CardExchange™ Producer.

https://cardexchangesolutions.com/id-card-software-support/support-downloads
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5.2.7 Configuration

The Configuration tab is organized in different groups with specific functionality.

Group Function(s) Description

Options Advanced Options Opens the Advanced options window

Loaded

cards

Card manager Opens the Card Manager Window 

Cards Select available cards from the drop down menu

New card Select to create a new card-template

Export templates Exports a complete template including database

connections, etc.

Import templates Imports templates including database connections, etc.

Duplicate template Duplicates an existing template

Selected

Card

Card designer Opens the Designer in configuration mode to edit the

template

Database setup Opens the existing Database connection to make

changes 

Authorizatio

ns

Account setup Opens the wizard to create groups and users

Enable logins featureEnables functionality to use log in's
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5.2.7.1 Advanced Options

In the Advanced options window you can set some specific settings for the CardExchange™

Producer application:

Contactless encoding

PC/SC-protocol: Select the PC/SC protocol 1 or 2

Card disconnect

dispositions: 

Select Leave card, Reset card, Unpower card, Eject card

Database connections

Quote table and column

names: 

Select if quotes needs to be used (default). Not used with

Cache DB

Designer
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User version 7 designer: If unchecked, the old version 6 designer will be used for

creating and editing cards

Show Migrate button or

menu: 

Shows the Migrate version 6 layout button in the Configuration

tab

Show advanced mappings: Shows the Edit card-definition and Edit mappings button in

the Configuration tab for using old version 6 templates

Evolis printers

Contactless position: Tune the offset for the card under the contactless reader

Move command: Set the specific move command to be used. Differs for printers

with contact

Imaging

Transport format: This is the format that is used internally. Default is Jpeg because

this is small and fast. You can also select bitmap (slower

performance), and Handle (unsecured)

OLE-header length: This is the amount of bytes to remove from the OLE header for

MS Access databases. Default 78 is when using an English MS

Access version

Maximum image size: Set the maximum image size for images on the card design

Nisca printers

Right side reader: Check this option if the contactless reader is located on

the right side instead of at the top location

Service center

Show error messages: Check this option to show error messages when content is

not loaded in the service center window

Zebra printers

Contactless position: Tune the offset for the card under the contactless reader

Factory built-in contactless

encoder: 

Select if the printer has a factory built-in encoder so

CardExchange™ Producer will use the internal SDK in

stead of escape commands

Multi USB Printer: Check this option if you have multiple ZXP printers being

used on the same PC, if any of the printers are busy

CardExchange™ Producer will wait and then retry to

communicate with the printer

Number of retries: When using multiple printers as above you can specify the

number of retry attempts

If you want to use these settings for all loaded card-templates, make sure you check "Apply
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these settings to all loaded cards"

5.2.7.2 Migrate Layout

When you have selected to show the Migrate button or menu, you know see an extra button

in the ribbon:

Group Function(s) Description

Migration Migrate version 6

layout

Migrates the selected version 6 layout to the current

version, this will create a copy of the card template with

the same name appended by the word "Migrated".

5.2.7.3 Advanced Mappings

When you have selected to Use Advanced Mappings in the Advanced Options window, in

the Select Card Group you know see two extra buttons appearing:

Group Function(s) Description

Selected

Card

Card-definition

wizard

Opens the Card-definition wizard to make advanced

changes

Mappings window Opens the Card-definition wizard on the mappings

section 

Users with version 6 card-templates will work with the Card-definition wizard.

Most features are now included in the Card designer, so if you are using the latest version

then you are unlikely to need either of these options.

The exceptions that need to be configured here are:

· External Plugins

· .net functions
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· Storage items where either the card preview or an environment variable need to be

stored back to the database.

5.2.8 View

Under the view tab it is possible to set the language for CardExchange™ Producer, you can

also restore views and hide different panes.

Group Function(s) Description

Zoom Zoom in Zoom in the card preview

Zoom out Zoom out the card preview

100% Set the card preview to 100%

Options Language Set the language of the CardExchange™ Producer

Restore view Restore the default view

Show Cards pane Show or hide the cards pane

Filters pane Show or hide the Filters pane

Printers pane Show or hide the Printers pane

Records pane Show or hide the records pane

Actions pane Show or hide the Actions pane

Print-log pane Show or hide the Print-log pane

Database record Show or hide the Database record section to edit database

records

Manual entries Show or hide the manual entries window section to edit

manual entries

5.2.9 Service Center

The Service Center tab is organized in different groups with specific functionality.

Group Function(s) Description
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Refresh Refresh Refreshes the available news items

Help Help Opens this online help file

Forum Opens our FREE End-User Support Forum

Video Tutorials Opens our website at the How-To Video section

Licensing Activation Window Opens the Activation Wizard window

Register CardExchange™

Producer

Opens the Registration Wizard Window

About Compare editions Opens the website at the compare editions section

About CardExchange™

Producer

Opens the About dialog containing license and

machineID info

[Vendor] Vendor Opens the vendor's website

Vendor store Opens the vendor's web store (if applicable)

For more detailed information about the Service Center, please visit the "Using Service

Center" section of this Help file...

5.3 Exporer Menu

The CardExchange™ Producer Explorer Menu offers three tab selections:

· Cards - This tab shows all the available card-templates
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· Filters - This tab shows all available Level Two filters

· Printers - This tab shows all selected printers

5.3.1 Cards

When the Cards tab is selected, all the available and selected card-

templates are shown. By clicking on the button, the template with all

the settings and configurations will be loaded in the Main interface.

The available card-templates can be divided by groups which can be

selected from the drop down menu directly under the tab.

Card-templates, the availability, the position in the menu, etc., is

defined via the Card manager.

For more information, please see our "Using the Card Manager"

section of this Help file



CardExchange® Producer Help54

© 2016 CardExchange Solutions, Inc.

5.3.2 Filters

CardExchange™ Producer offers almost unlimited functionality to

find information in the connected database and make it available for

your card production.

Our lever two filters are known as one of the most powerful filter

options in this industry because of the customization they offer and

the fact that filters can be defined for specific use by operators to

have maximum error prevention.

All these defined Level Two filters are available in the Filter section of

this Explorer menu and can simply be selected by the user by clicking

on the button.

The filters can also be divided by groups which, if applicable, can be

selected from the drop down menu directly under the Filter tab.

For more information about using and configuring Level Two filters,

please visit our "Level Two Filters" section of this Help file.

Overall information of using filters with CardExchange™ Producer can

be found in our "Using Filters" section of this Help file.
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5.3.3 Printers

Each card-template in CardExchange™ Producer can have it's own

printer assigned. That means that every time you click the print

button, that selected printer takes care of the job.

In some situations it can be very handy to overrule this standard

printer by selecting another printer without changing the whole card-

template configuration.

In the section "Select printers" we have explained how to set these

printers and make them available. All selected printers are presented

in this Printer tab of the Explorer Menu.

Simply click on the corresponding button to send the job to that

printer.
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5.4 Actions Pane

In the Actions Pane, located at the right side of the main interface, six

different buttons can be shown. Starting with the Go edition, the Actions

Pane will show the Take photo and the Print card buttons. 

When clicking on the Take photo button, the camera that is selected will

be previewed in the photo window. Configuration of the Photo

functionality is explained in the "Using Photos" section of this Help file.

If you have an Premium Edition or higher, also the Capture signature

button is shown. When clicking it will start the signature pad connected.

In the "Use Signatures" section of this Help file you can find out how to

configure this functionality.

In the Ultimate Edition, CardExchange™ Producer supports Biometric

readers, ID Card Scanners and External Plug-Ins. 

Clicking on Enroll biometric will open the window to capture a persons

scanned fingerprint, the "Using Biometrics" section of this manual

explains how to set this up.

And in the same way clicking on Scan document will open the window

to capture details from a scanned document or ID. This is explained in

the "Using ID scanners" section of this manual.

External Plug-Ins contain custom functionality or embedded SDK's. For

example an embedded Fingerprint Scanner. When clicking on the

External Plug-In button, the fingerprint scanner will be started. More

information about External Plug-Ins can be found in the "Using External

Plug-In's" section of this Help file.
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5.5 Records Pane

In the Records Pane in the main interface of CardExchange™ Producer you see all the

records presented that are available in your database. When you make a database

connection, in the name list page you select the columns that are shown in the Records

Pane. You can find everything about making database connections in the "Using Databases"

section of this Help file.

Record Sorting
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The Records Pane is a so called data grid showing all your available database records

divided by columns. Sorting the records is just as simple as clicking on the column. 

Record Look Up

It is very simple to search for records inside the Records Pane. Enter the text that you want

to search for in the text box directly above the columns. The text you enter always applies

to the first column,if you want to look up records from the Lastname column, you have to

drag the column to the front. 

Loaded Record Information

In the footer of the Records Pane the total amount of loaded records is shown.

5.6 Data Edit Window

The Database Edit window offers the possibility to manage your connected database data.

The window can be shown/hidden via the View tab in the main window by clicking on the 

Database record button.
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Starting from the Premium edition, this window can be customized and configured with

available columns but also drop down menu's.

On the left side it offers buttons for adding a New record, Insert the record, Update a

record, Delete a record, and Cancel your entries.

More about the configuration of this window can be found in the "Using Data" section of

this Help file. More information about database configuration, please see the "Using

Databases" section of this Help file.

IMPORTANT! CardExchange™ Producer does not support deleting for MS Excel files. MS Excel can only be

inserted and updated.

5.7 Manual Entry Window

The Manual Entry window offers the possibility to enter information into the created

manual entries. The window can be shown/hidden via the View tab in the main window by

clicking on the Manual entries button.

Simply enter the information and click on Apply to make the entered information available.
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On the left side it offers buttons to Clear the entries, Apply the entries, and Cancel your

entries.

For more information about manual entries, please see our "Using Manual Entries" section

of this Help file.
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6 Using the Designer

CardExchange™ Producer Designer follows the latest Windows technology and is

completely developed under the Windows Presentation Foundation (WPF) platform. For

printing graphically, XPS printing technology is used.

The interface look and feel follows the latest Windows and Office look and feel. For the

setup of the functionality we have chosen to follow flow of Microsoft PowerPoint which will

make it very easy to find your way inside of CardExchange™ Producer Designer.

The CardExchange™ Producer Designer is also sold as a separate edition of the

CardExchange™ Producer family and is fully integrated in all higher editions.

CardExchange™ Producer Designer is not only a separate sold edition which can be used to

print cards, it is also used for all the configuration of higher editions of CardExchange™

Producer. When running a Go or higher edition, the Designer will open mentioning the

edition used, showing in Configuration Mode.

All configuration is done in the Designer, even database connections are made here. Via

easy drag and drop functionality (click functionality and drag it to the card design, the need

for creating variables is limited to only very specific functionality like scripting.

Talking about scripting, this Designer contains full Python scripting language. General

information about Python can be found by CLICKING HERE. For more detailed information

http://docs.python.org/2.7/


CardExchange® Producer Help62

© 2016 CardExchange Solutions, Inc.

about Python please CLICK HERE.

6.1 Explorer Menu

Just like in the Main Interface,  CardExchange™ Producer

Designer also contains an Explorer menu. Also here the Explorer

Menu is based on the Explorer Menu as it is available in

Microsoft® PowerPoint.

This Explorer Menu contains three tabs which are described in

sub sections of this Help file.

The Explorer Menu gives an overview of all your created layouts,

pages, connected data, etc.

As we informed you in the Using the Designer section of this

Help file, the Designer can be used as a separate edition or as

the configuration tool for your GO and higher editions. You

always open the actual Template selected in the Main Interface

or the standalone edition template.

http://ironpython.net/documentation/
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6.1.1 Pages

When selecting the Page tab (default) all available and created

Layouts and the available pages per layout are shown.

Simply click on the page or the layout header to select. Specific

settings for the available Layouts can found in the Page Setup

section of this Help file.

How to Add Layouts and Pages can be found in these specific

sections.

6.1.2 Outline

When the Outline tab is selected you find a quick overview of all

the available objects on the pages, in the Layouts, in the

Template.

It is presented as a tree view and by hovering over each

available object, a preview of the object is shown like in the

screen shot, hovering over the Photo object shows the preview

of the Photo.
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6.1.3 Data

The Data tab is offering, depending on the edition used, eight

sub tabs:

· Database columns

· Manual entries

· Variables

· Storage items

· MIFARE® Classic read items
 

· MIFARE® Classic Write items

· MIFARE® DESFire read items

· MIFARE® DESFire write items

Not all tabs are available in every edition. In the Designer edition

you have no option to connect to databases and therefore the

Database columns tab will not be available for example.
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6.1.3.1 Database Columns

When using GO or higher editions and you are connected to a

database or MS Excel file, this tab contains all the available

columns of the connected database/file.

Simply select the item and drag and drop it on your card design.

Specific Properties can be set in the Properties window.

How to configure databases is explained in the "Using

Databases" section of this Help file.

In the Designer edition this option is not available.
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6.1.3.2 Manual Entries

All defined Manual entries are available in the Manual entries tab.

You can drag and drop these fields onto your Page layout.

Please visit the Manual Entries section of this Help file for more

information about creating and configuring Manual Entries.
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6.1.3.3 Variables

The variables in the CardExchange™ Producer Designer can be

used as input for Python scripts and their value can be mapped to

for example a database column or a manual entry. Mappings are

made via the Content tab in the Properties window.

Please visit the Variables section of this Help file for more

information about using Variables.

Variables are available in the Ultimate edition.
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6.1.3.4 Storage Items

If you want to store data into the connected databases, you need

to define storage items. Storage items contain the information of

the column name in which you want to save your information like

photos or print dates. These Storage Items mappings are made

via the Content tab in the Properties window.

Please visit the Storage Items section of this Help file for more

information about using Storage Items.

Storage Items are available in the Premium and higher editions.

6.1.3.5 MIFARE Classic read items

Enter topic text here.

6.1.3.6 MIFARE Classic write items

Enter topic text here.

6.1.3.7 MIFARE DESFire read items

Enter topic text here.

6.1.3.8 MIFARE DESFire write items

Enter topic text here.

6.2 Ribbon Overview
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Following the structure of Microsoft® Office, the Home tab reflects all the most common

functionality needed most.

Clipboard functionality for easy Copy, Cut, and Pasting. In the Font group you can easily set

the font type, size, color, and outline the text.

CardExchange™ Producer offers almost unlimited possibilities to outline your text and

objects. Also borders can be easily set and colors can chosen.

The main objects for inserting are also available from the Home tab in the Insert group.

Last but not least, the Properties window is called from the Home tab too.

It is also possible to minimize the ribbon if you need more space on your design because

you are using a smaller screen.

Right mouse click on one of the available tabs to open the context menu and select 

Minimize the Ribbon.

Now you only see the headers of the tabs and more space is offered. Clicking on the tab

will have the Ribbon information expand. After selecting the functionality it will close

again.

To restore the Ribbon, simple right mouse click on one of the tabs and deselect Minimize

the Ribbon from the context menu. 
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6.2.1 Insert

Just like in the Home tab, objects can be selected here. In the Home tab, the Layout button

is not available. When running a Professional or higher edition, adding a extra Layout needs

to be selected here.

Via the Insert tab you can insert the following objects:

· Text

· Images

· 1D Barcodes

· 2D Barcodes

· Rectangles

· Ellipses

· Lines

IMPORTANT! The Layout button is not available in the Designer, GO, and Premium Edition. Multiple Layouts

are supported from Professional and higher.

6.2.2 Page Layout

The Page Layout tab reflects the first tab (Page) of the Page Setup window. If you want to

add a Background color or Background Image, you can add this via the Background button.

More information about the Page Setup can be found in the "Page Setup" section from this

Help file. More information about how to use Backgrounds, please refer to our "Using

Backgrounds" section of our Help file.
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6.2.3 Data

When the Data tab is selected, you find two different groups:

Group Function(s) Description

Connection Edit Opens the Database wizard to edit the existing database

connection

New Opens the Database wizard to create a new database

connection

Select Opens the file dialog window to select an existing database

connection

Remove Disconnects and removes the existing database connection

Record

Navigation

First Navigates to the first available record in the database

Previous Navigates to the previous database record in the database

Next Navigates to the next record in the database

Last Navigates to the last record in the database

For more information about creating and editing database connections, please see our

"Using Databases" section of this Help file.

IMPORTANT! This Data tab is not available in the Designer edition as this edition does not support database

connections.

6.2.4 Mifare

When the MIFARE® tab is selected, you will find three different groups:

Read MIFARE® Classic

Function Option Description

Edit Opens the selected MIFARE®wizard to edit the

settings
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New New MIFARE® Classic 1K

read definition

Opens the MIFARE®definition wizard to create a

new MIFARE® read definition

New MIFARE® Classic 1K

write definition

Opens the MIFARE®definition wizard to create a

new MIFARE® write definition

New HID Proximity read

definition

Opens the MIFARE®definition wizard to create a

new xxx read definition

Select

Remove

For more information about creating and editing MIFARE® definitions, please see our

"Using Contactless Encoding" section of this Help file.

IMPORTANT! This MIFARE® tab is only available in the Ultimate edition.

6.2.5 View

When the View tab is selected, you find two different groups:

Group Function(s) Description

Zoom Zoom in Zoom in on the current page

Zoom out Zoom out on the current page

100% Zoom to 100%

Fit template Zooms the page that it fits the window

Fit width Zooms the page that the width of the page fits the width of

the window

Fit height Zooms the page that height of the page fits the height of

the window

Options Language Change the display language of the Designer (Designer

edition only)

Inches Change the display units to inches

Centimeters Change the display units to centimeters

Pixel Change the display units to pixels

IMPORTANT! Setting the language is only available in the Designer edition.
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6.2.6 Service Center

The Service Center tab is organized in different groups with specific functionality.

Group Function(s) Description

Refresh Refresh Refreshes the available news items

Help Help Opens this online help file

Forum Opens our FREE End-User Support Forum

Video Tutorials Opens our website at the How-To Video section

Licensing Activation Window Opens the Activation Wizard window

Register License Opens the Registration Wizard Window

About Compare editions Opens the website at the compare editions section

About CardExchange Opens the About dialog containing license and

machineID info

[Vendor] Vendor Opens the vendor's website (Default is CardExchange™

Solutions)

Vendor store Opens the vendor's web store (if applicable)

For more detailed information about the Service Center, please visit the "Using Service

Center" section of this Help file...

6.3 Page Setup
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To start the Page Setup window, click on the Page Setup button in the Main Menu.
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6.3.1 Page

For each selected page in your layout, specific settings can be made. For example, if you

are having a double sided print with two pages, the front page can be set to Landscape

and the backside can be set to Portrait.

 

Margins

· Enter the page margins

Orientation

· Change the orientation for landscape or portrait

Print options

· Set the print options for the layout;

o Select printable for graphical printing the page

o Select or deselect Backside to print or not print the backside
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o Select magnetic stripe if magnetic encoding is used

6.3.2 Template

Every Card (Template) designed with CardExchange™ Producer can contain multiple

layouts and multiple pages. Each Layout and Page can have it specific settings but the

template itself holds some specific information like the connected printer being used to

print the different pages.

In this section you can define all the specific template settings like selecting the printer

being used, card size, etc.;

 

Card size

· Printer - Select the printer to be used

· Card size - Select the specific card size

· Width, Height - Enter custom card sizes
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Rows and columns

· In this section you can define how many columns and rows need to be printed on

one page. If you set the Number of rows to 3, 3 records will be printed on, for

example, the front page of the card. This technology can be used to print multiple

records for, for example, the use of breakable cards. See more information about

how to use Rows and Columns.

Print options

· Print backside first - Select this option if the backside of the card needs to be

printed first

· Print last card first - Select this option if you want to print the last card from the

batch first

· Print using the GDI+ print engine - Select this option for non-compatible XPS

printers to ensure highest print quality. For more information CLICK HERE.

· Enabled pre-rendering of objects into the background image - For more

information CLICK HERE.

· Send to printer as bitmap - Select this option if you want to have CardExchange™

Producer create a bitmap image first and send it to the printer in stead of sending

all objects separately



CardExchange® Producer Help78

© 2016 CardExchange Solutions, Inc.

6.3.2.1 Using GDI+ Printing

CardExchange™ Producer is developed using the latest Microsoft technology and uses their

XPS printing engine for printing. XPS is the technology that is going to replace the printer

driver technology as it has been used since the beginning of Windows.

Unfortunately not all ID card printer manufacturers supply drivers that support XPS

technology. Therefore CardExchange™ Producer offers also a GDI+ print engine. At this

moment we know that Evolis and Datacard are supporting XPS printing.

When ID card printers do not support XPS printing, this can result in poor quality of images

and problems with resin printing. When this occurs you can set the system to print via GDI+

printing.

As CardExchange™ Producer uses advanced graphical objects that sometimes are not

supported by GDI+, you can use this technology in combination with Pre-rendering of

objects. 
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6.3.2.2 Pre-rendering of Objects

This option enables pre-rendering of objects into the background image of the layout

page. When selected, all objects that have been flagged for pre-rendering, together with

the background image or brush of the layout page, will be rendered to a bitmap image

and sent as such to the printer.

By default, only image objects are flagged for pre-rendering, but on the Visibility tab of the

Properties window, pre-rendering can be enabled or disabled for any individual object.

Pre-rendering is needed when printing via the GDI+ if your design uses graphics that are

not supported by the GDI+.

Pre-rendered objects will always show behind any other objects in the printed result, even if

that is not the case on the preview.
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6.3.3 Expressions

The CardExchange™ Producer Designer integrates a powerful script language that offers

users a high level of flexibility when it comes to personalizing their card layouts. Instead of

assigning fixed values to layout or layout-page properties, it is possible to control their

values through expressions that yield different results in different circumstances. For

example, CardExchange™ Producer can inspect a field in the database and then decide to

set a different background color, or even  show a completely different card layout.

The Expressions tab of the page-setup window allows for specifying expressions for the

layout condition, a number of layout-page properties and any number macro commands.

The layout condition is available for the Professional and Ultimate editions. The layout-

page properties and the macro commands are only available in the Ultimate edition.

Expressions are written in IronPython (see http://ironpython.net), which is the .NET

implementation of Python, (see http://www.python.org). Since the documentation of Python

is publicly available on these websites, this help file will limit itself to explaining how

http://ironpython.net
http://www.python.org
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Python can be used within CardExchange™ Producer and giving some practical examples.

Layout condition

When a card template consists of multiple layouts, the layout-condition property can be

used to determine whether a layout applies or not. Imagine, for example, that the template

has two layouts and that we type

layout == 'A'

for the layout condition of the first layout. When pressing the Enter or Tab key or clicking

OK, CardExchange™ Producer will detect that a new variable called 'layout' was introduced

and prompt for a default value. You could set the default value to 'A', as shown in the

screen shot below. 

Now close the page-setup window, select the second layout and open the page-setup

window again. Type in the Expressions tab the layout condition

layout == 'B'

CardExchange™ Producer will not prompt for a default value anymore, because the

variable 'layout' is already part of the variables collection. Now when you look under the

data tab of the explorer menu, you will see a sub tab for variables which contains a variable

called layout. You can select this and from the properties window and map it to the field in

the database that contains the layout condition.

The first layout will be shown for records that have the value 'A' in that field, while the

second layout will only show if that field contains 'B'.

Layout conditions can be controlled by expressions that are much more complex than this.

The expressions can contain functions and they can use multiple variables. It is possible to

define the layout conditions in such a way, that for some records multiple layouts apply and

for others no layout at all. CardExchange™ Producer will print multiple cards for the same

record if multiple layouts apply. If no layouts apply, CardExchange™ Producer will skip the

record when executing a print batch.

Background

Three layout-page properties can be controlled by expressions: the background color, the

margins and the page orientation. Background colors are specified using HTML color

names ('AliceBlue',  'AntiqueWhite', 'Aqua', etcetera) or using HTML color tags, for example,
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'#FFCD853F', specifying the alpha, red, green and blue channels respectively. The simplest

way of getting a flexible background color is by just typing a variable name in the

expressions box, like

backgroundcolor

CardExchange™ Producer will prompt again for a default value, where you can type, for

example, 'AliceBlue'. In the mappings window, the variable name will appear among the

visible items and can be mapped to a database column that contains the desired color

name for each record.

If the color is determined by a flag that does not reflect the color name directly, it is

necessary to define a function in the Functions tab, like for example

def getcolor(flag):

if flag == 'A':

return 'Red'

elif flag == 'B':

return 'Green'

else:

return 'Blue'

This function can be used in the expression for the background color by typing

getcolor(flag)

where the variable 'flag' should be mapped to a database column that can contain the

values 'A' or 'B'. As a result, CardExchange will show a red or green background if that

column contains the value 'A' or 'B' respectively. he background will be blue for all other

values.

Padding

The padding is the space between the edge of the card and the printed area, more

commonly designated as margin when talking about pages. It is not commonly controlled

by expressions. The result of the expressions should be either an integer value that specifies

the width of the margin in pixels, or a string containing two or four numbers, optionally

separated by a comma. The string '10 20' or '10,20' would set a margin of 10 pixels on the

left and right sides and a margin of 20 pixels to the top and bottom sides. The string '1 2 3

4' or '1,2,3,4' would set a left margin of 1, a top margin of 2, a right margin of 3 and a
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bottom margin of 4.

Page orientation

For the page orientation, it is still more unlikely that you want to control it with an

expression. The value that the expression should return are 'Landscape', 'Portrait',

'ReverseLandscape' or 'ReversePortrait', where the last two refer to an orientation that has

been rotated 180 degrees.

Macro commands

Macro commands are text strings that are sent to the printer as printable characters, but

that are interpreted by the printer as special commands. The most common application of

macro commands is using them for magnetic encoding. The printer recognizes text strings

as macro commands by inspecting the first and sometimes the last characters. For example,

on certain printer brands, the string '~1%XXXXX?' is interpreted as a command to encode

the characters 'XXXXX' on track 1 of the magnetic stripe.

Although you could define macro commands for magnetic encoding in the Expressions tab

of the page-setup window, you normally will not do that, because it is much more user

friendly to enable the magnetic-stripe object in the Page-layout ribbon and configure it in

the properties window. However, some printers support other types of macro commands,

for example for defining holographic overlays, in which case you can manually add those

commands in the page-setup window.
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6.3.4 Variables

When expressions are used to determine property values, CardExchange™ Producer detects

whether any variables were used in the expression. If so, it prompts for default values and

adds the variables to the template's variable collection. Under the data tab in the explorer

menu, the template's variables will appear under the variables sub tab and their values can

be mapped to external data, like database columns or manual entries by selecting them

and changing the drop down in the properties window.

The Variables tab in the page-setup window, lists the complete variable collection and

allows for following actions:

§ Changing a variable name by clicking on it in the list and typing a new name. If you

rename a variable, be sure that you also adapt any expressions that are using that

variable.

§ Changing the default value of a variable by typing in the value box.
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§ Removing a variable by clicking on the button with the red cross. You should only do

this if you are sure that the variable is not being used by any expressions.

§ Adding a new variable by clicking on the Add-variable button.

If you want the default value of a variable to represent an image, you can click in the image

button to show some additional controls that helps you defining the image.

The select-image button allows you to select an image file from the computer. The point-

to-file check box allows you to set the default value to the file path instead of the image

data.

When you hover over the image, you see two additional buttons that are for editing and

removing the image respectively. Please, note that edited images cannot be of the point-

to-file type. When you edit a point-to-file image, the point-to-file box will be unchecked

automatically. On the other hand, if you check the box for an edited image, the image will

revert to the original one.
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6.3.5 Functions

The Functions tab in the expressions window shows a single text box where you can type

any global definitions you want to use in your Python scripts. When typing here, you need

to follow the Python syntax (see http://www.python.org). Normally, you will use this space

to define custom functions to be used in expressions. An example shown before was the

function we defined to determine the background color

def getcolor(flag):

  if flag == 'A':

    return 'Red'

elif flag == 'B':

  return 'Green'

else:

  return 'Blue'

It is also possible to define global variables, that is, variables that can be used in

http://www.python.org
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expressions or functions, but that will not be listed under the visible items. For example, we

could change the above function definition to

colorA = 'Red'

colorB = 'Green'

colorC = 'Blue'

def getcolor(flag):

if flag == 'A':

return colorA

elif flag == 'B':

return colorB

else:

return colorC

To get a taste of the level of complexity you can achieve with custom functions, see the

below definition of a function that converts a string to name casing. It uses the regular-

expressions module of Python (see http://www.python.org for more information).

import re

def namecase(s):

return re.sub('\w+', capitalizematch, s)

def capitalizematch(m):

return capitalize(m.group(0))

def capitalize(s):

if len(s) > 1:

return s[:1].upper() + s[1:].lower()

elif len(s) == 1:

return s.upper()

else:

return s

With the name-case function, you can convert a string like 'jOHn SMith' into 'John Smith'.

http://www.python.org
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6.4 Magnetic Encoding

Magnetic encoding with CardExchange™ Producer is very easy to configure. Just check the 

Magnetic stripe check box in the Page layout tab or select Page Setup from the Menu.

Select the Page and check the Magnetic stripe check box.
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In the Page design you now see a red magnetic stripe rectangle appearing as indicated

with the red rectangle. Now make sure that you have the Properties window open and

make sure the Content tab is selected and that the magnetic area on your page design is

selected.
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In the Properties window you now see three sections:

· Magnetic encoding

· Track 1, Track 2, and Track 3 

· Start and stop sentinels

Magnetic encoding

In this group, indicated with the red rectangle, you select which track you want to write to.

Just select the check box for each track to make it available. In the text box next to the
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Track you can directly enter information (fixed value) or drag a database column into it. For

each selected track the track object, indicated in the orange rectangle, will become

available.

Track 1, Track 2, and Track 3

In this group, indicated with the orange rectangle you can set or change the information

that is being coded to the magnetic stripe. Click on the  to expand the Track info.

Just like with normal objects, with the Magnetic Encoding you can also use the Standard
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Object Types to connect.

Start and stop sentinels

All ID Card Printers are using start and stop sentinels for moving the card into encoding

position. Although encoding of magnetic cards is based on an ISO standard, the commands

used are mostly different per manufacturers brand.

To make sure you are using the correct start and stop commands, the most common

commands are available via CardExchange™ Producer directly. Just select the printer you

are using from the printer drop down menu and click on Apply defaults.
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If you are using specific start and stop sentinels, you can directly enter them into the text

boxes.

6.5 Rows and Columns

CardExchange™ Producer offers the possibility to print multiple records on a your card. This

can be very handy when printing, for example, breakable cards for key chains.

Select the Layout, open the Page Setup window, and select the Template tab. Here you can

find the Rows and Columns section. Enter the amount of columns and rows you want to use.

For example, using 3 columns and 1 row will have the following print result:
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Of course, because CardExchange™ Producer supports Windows printers, you can also use

this to create face books for your A4 or Letter printers.
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6.6 Templates

As you have read in the Designer Interface section of this Help

file, all your configuration is done in the Designer. Therefore

the CardExchange™ Producer Designer works based on

templates.

To understand how CardExchange™ Producer works, it is

important to take special note of this section of the Help file.

Basically every time you create a new card with

CardExchange™ Producer you are creating a new Template.

In the Main Interface of CardExchange™ Producer you always

switch between the different available Templates (see the

"Loaded Cards" section).

With the Designer you always create a new or open the

selected Template. But it is always ONE Template!

Each Template has always one ID Card Printer connected, one

Database connection, one MIFARE® Classic or DESFire

connection, one External Plug In, etc.

Each Template can have have Multiple Layouts. In the screen

shot you see "Student" and "Staff". These are the layouts inside

the template. Each layout can have it's own unique conditions

like Magnetic Encoding settings. By selecting the layout, you

can simply call the Page Setup window from the Main Menu to

set the specific conditions.

This offers very powerful functionality. Using Multiple Layouts

inside one Template makes if for example, possible to

automatic switch between the different available Layouts

within the Template. More information how to create this type

of functionality can be found in the Expressions section of this

Help file.

More information about Layouts can be found in the "Adding

Layout(s)" section of this Help file.

Each Layout can have Multiple Pages. You can have a Page for the Front Side, a Page for the

Back Side, but also a Page for a UV panel on the Front and/or a UV panel on the Back. Each

Page holds all the objects like text, image, barcode, etc., objects.



CardExchange® Producer Help96

© 2016 CardExchange Solutions, Inc.

6.7 Menu Overview

In the Main menu of the Designer you can find all common functionality needed to load,

save, print, etc., your card. It is very important to be aware that are basically two versions of

this menu. The version for the Designer as shown below:

And the version for the Go and higher editions as shown below:

In the Designer menu you can create a new template, open an existing template, and
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save an existing template under a different name.

When you are using a Go or higher edition, this functionality is not available because the
creation of new templates is managed via the Card Manager. More information about the
Card Manager can be found in our "Using the Card Manager" section of this Help file.

Available functionality

· New *

Create a new template (Only available in the Designer edition.
In all other editions adding goes via the Step-by-Step wizard).
For more information about Adding cards, please see our "Add a
Card" section of this Help file.

· Open * Open an existing template (Designer Edition only)

· Save Save the template and/or the modifications you made

· Save as * Save the template as (Designer Edition only)

· Print This menu has three sub items:

· Print (Select the printer, the amount of copies, etc.)

· Quick Print (Send the template directly to the default
printer without making any changes)

· Print preview (Preview and make changes to pages
before printing)

For more information about printing, please see the "Printing
Cards" section of this Help file.

· Page setup
Opens the Page Setup window. More information about Page
Setup can be found in the "Page Setup" section of this Help file

· Export This menu has five sub items and allows you to export the card
layout as an image. You can export different formats like BMP,
JPG, PNG, etc.

· About
CardExchange™
Producer

This opens the about window with version information of
CardExchange™ Producer

· Exit This will quit the Designer or close the Configuration mode 

6.8 Properties



CardExchange® Producer Help98

© 2016 CardExchange Solutions, Inc.

All objects used with the CardExchange™ Producer Designer have more properties than

shown in the Add Object window. All these properties are available in the Properties

Windows. Click on the Properties button in the Home tab to open. In the Properties

Window you can find specific properties for:

· Content

· Position

· Text

· Border

· Colors

· Visibility

· Database Columns

· Manual Entries

· Mifare

· Expressions

· Variables

· Functions
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6.8.1 Content

In the content tab you can enter information when you are using a Fixed Value object. This

information will then be presented on the Page design in the Text object. Of course when

connected to a database, this Content tab will show the data from the connected column.

The box around the text area will be GREEN when it contains information coming from a

connected database, ORANGE when it contains Manual Entry information, and RED when it

contains information from Scripts. When using fixed text, it will have no color and look like

the screen shot.

You can change the information by selecting a different Standard Object Type. But can also

be set for using photos, signatures, etc. More information can be found in the "Using
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Images" section of this Help file.

In stead of selecting a Standard Object, the information can also simply be changed by

selecting a database column from the Data Menu in the Explorer Menu and drag and drop

this field directly into the Content text area.

Formatting Options

The Content tab also offers the possibility to do some advanced formatting. In the

Formatting Options group you can set the Letter case for the content. You have four options

for the Letter case:

· Maintain Original - No changes to the original

· Lowercase - Makes the content Lowercase

· Uppercase - Makes the content Uppercase

· Namecase - Makes all the first letters Uppercase

You can add a prefix and a suffix to your content and make it always visible. By default it is
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unchecked which means that if there is no content available, for example from the

database, the prefix or suffix information will not shown.

You can also set the Format of the content. This can be handy if you want to make sure that

it is always a integer, date, text, etc., content. You can select the following Formats:

· Date/Time

· Decimal

· Floating Point

· Integer

· None

· String

You can also format the content based on kinda script. For example in the screen shot we

entered 'd4'. That means that the content will be representing four digits. So if the value

from the database is 1, setting it to d4 will show 0001.

Now bringing it all together, the screen shot with the specific settings will represent the

follow information on the card to be printed:
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6.8.2 Position

In the Position tab you can set the specific position, sizes, and margins. Of course this

reflects the position on the Page as you dragged and dropped it so you may not need to

change them. However in some situations you will have to set the positions, sizes, and

margins based on specs provided by the customer. Instead of trying to accomplish this with

a very stable hand, you can here directly enter the values.

Also the Horizontal and Vertical alignment can be set. Set the preferred stretch setting and,

if applicable, enter the rotation angle in degrees.
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6.8.3 Text

In the Text tab you can set the Font Type and the Font Size in the Font Group. Besides the

alignment options, you can set the Font Stretch. The Font Stretch is not the same as the text

stretch because it determines the intense of the font when stretching while the standard

stretch just make sure the text fits in the text box. With the Font Stretch you can choose

from:

· Normal (Default)

· Ultra Condensed

· Extra Condensed

· Condensed

· Semi Condensed
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· Semi Expand

· Expand

· Extra Expand

· Ultra Expand

In the Text Layout you can set the Maximum number of lines for the text object. That means

if you set, for example, the value to 2, it does not matter how large the text object on the

page is, it will only use maximum two lines for the text. If you do not use stretch

functionality, it will not fit the box if it over exceeds 2 lines.

Bringing it to the Stretch option. Stretching and Stretch Direction combines the perfect

functionality to get good results in your text object on the Page. In the Stretch Drop Down

Menu you can select:

· None (default)

· Fill

· Uniform

· Uniform Fill

In the Stretch Direction you can select:

· Up Only

· Down Only

· Both

Now, for example, when selecting the option Fill in the Stretch Drop Down Menu, in

combination with the Down Only option from the Stretch Direction Menu, the Font will be

re-sized horizontally only.

Text Object without Stretch

Text Object with Stretch set to Fill, Stretch Direction to Down Only

Instead of using Stretch functionality, you can also trim the text. There are basically three

options for text trimming:
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Text Object without Text Trimming

Text Object with Character Ellipsis Text Trimming

Text Object without Text Trimming

The last option in this Text property is setting the Line Height. By default this is not disabled

and it uses the standard line heights for the Font Type. In some situations it can be that the

standard will eat up to much space you have available on Page Design. When you select

the check box, the text box right next to it becomes available and you can enter a value for

the line height. The value used is depending on the settings you made in the Options

section in the View tab, centimeters, inches, or pixels. See example below:

Text Object without using Line Height

Text Object using 0.10" Line Height
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6.8.4 Border

In this section of the Properties Window you can set the properties for the borders of the

objects. In the first group you can define all the values for the Border thickness. For

example, when adding a rectangle object to your Page Design, you can select the border

thickness from the Home menu in the Border section:

You can also enter this directly in the Border Thickness section of the Border tab. This is

handy if you need to set specific values provided by your customer.
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For example, we add a photo object on the Page Design and set the values for entering to

pixels in the Options section of the View tab. This object looks like below:

Now we set the Border Thickness to 5 pixels for the Right and Bottom:
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Now the photo object will look as below:
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Now you get totally fancy by combining this with the Corner Radius. For example, we set

the Corner Radius for the Top-Left and the Bottom-Right to 25 pixels and see the result

below:

This can be done with all existing objects available with CardExchange™ Producer. It even

can become more advanced if we are combining the objects borders with colors and

backgrounds. More about this in the Colors section of this Help file.

Last but not least, when using Text Objects you can use padding. Padding is the space

inside the object and is therefore not the same as Margin as that is the space outside of the

object.

Text Object without Padding

Text Object with Left and Top Padding
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6.8.5 Colors

Depending on the object used on the Page design, different color options are available

divided in three different groups:

· Foreground brush - sets the foreground color of the object

· Background - sets the background color for the object
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· Border brush - sets the border color for the object

Each group offers four different style options:

·  Transparent

·  Solid color

·  Gradient

·  Image

Colors can be selected directly from the drop down menu as indicated with the red arrow:

Picked from the color selection area as indicated with the blue rectangle:

Created by moving the color sliders to the preferred position as indicated with the orange

rectangle:
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Or directly entered into the text boxes right from the color sliders as indicated with the

purple rectangle:

There are so many possibilities to combine that it is impossible to explain them all. We

have created a couple of examples which are explained in the sub sections of this Color

subject.

6.8.5.1 Text Object Example

For this example we added a text object to the Page design and set the colors as shown

below:
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The foreground color is set to blue and for the background color we used orange with a

gradient style which creates the result below:
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6.8.5.2 Image Object Example

For this Image Object example we added a Image of a photo to the Page design and

created a border via the Border tab. We have set the system to use pixels and we have the

set the properties as following:

Now the Image object on the Page design looks like below:
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What we will do now is replace the Solid Color Border with an Image that we will load.

In the Border brush group we select the Image style as indicated with the orange arrow

and we select an image by clicking on the Select image... button as indicated with the red

arrow. When the image is loaded, the Page design will show the following result:
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6.8.6 Visibility

The Visibility tab contains three separate group sections:

· Visibility

· Opacity mask

· Background removal

Visibility

In the visibility group you can set the opacity of the image on the Page design. This can be

used to create ghosting images. For example, as shown in the screenshot, see the

differences in the images shown below:
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No Opacity Opacity 50%

Besides setting the opacity for the image, you can also select the visibility of the image as

well the printability. Each drop down menu offers three selections:

· Visible

· Hidden

· Collapsed

Opacity Mask

With the Opacity mask you can do some great and advanced stuff. For example, we have

created an opacity mask using the gradient tool and the background color orange.

Now take a look at the photo images below. On the left you have the original and on the

right the photo with the opacity mask.
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No Opacity Using Opacity Mask

But you can also load images or use solid colors.

Background Removal

CardExchange™ Producer offers advanced background removal. Use the sliders to define

the correct removal. You can also enter the values directly into the text boxes right from

each color slider. For example, we removed the background based on the slider

configuration below.

Now take a look at the photo images below. On the left you have the original and on the

right the photo with the background removed.

No Removal Background Removed
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It is important to realize that the result of the background removal depends on the quality

of the image and the used background. Always try to use real blue or green backgrounds

when taking photos as this offers the best removal result.

6.8.7 Database Columns
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When you are connected to a Database, all the available database columns become

available in the Database columns tab of the Properties window. See our Database section

of this Help file for more information about connecting to and using Databases.

Via the Record navigation section in the Data tab, you can easily navigate between the

different available records and the selected record will be shown in the Database columns

tab.

Just like with the Manual entries, these database columns can be directly drag and dropped

to the Page design via the Data tab of the Explorer menu as explained in the Add Database

section of this Help file.
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6.8.8 Manual Entries

The Manually Entry Window gives you the possibility to enter data that should appear on

the card without the intervention of a database. To be able to manually enter data, you first

have to define Manual Entries. To add a manual entry, select the Manual entries tab of the

Properties window.
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And click the Add manual entry button indicated in red.

When the Entry is added, you start with entering a name for the label, indicated with label1.

For example, DOB (Date of Birth). Next you enter a value or a informing text in the value1

field. This can be, for example, Enter the Date of Birth or you can also put a value like 100

if you are using the entry to always store the same value.

The label of the manual entry reflects the label of the Manually Entry Window indicated

with the red rectangle and the value reflects the text box indicated with the black

rectangle.

You can add unlimited Manual entries to your Page design.

Now when you are done adding your Manual entries, they will become available for adding

them to you Page design in the Data tab of the Explorer menu.
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When you select the Data tab of the Explorer menu, you will see the Manual entries tab as

indicated. When you select this tab, the added Manual entries become available as shown

in the blue rectangle. Now you can simply drag and drop them to your Page design.

This can also be done from the Manual entries tab in the Properties window.
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6.8.8.1 Options

When you added a Manual Entry to you Page design, specific properties become available

in the Content tab of the Properties window.
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In the Content tab you now see a group named Manual Entry Options. Here you can set

the options Prompt value before printing which will prompt the dialog below:

Besides prompting for a value, you can also indicate that a value needs to be entered by

selecting Value cannot be empty and you can show the previous value by selecting Show
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previous value.

6.8.9 Mifare

If you have MIFARE® Classic read items or MIFARE® DESFire read items defined they will

show under the MIFARE® tab in the properties window.

Here you can manually execute the read definitions to obtain sample values from a

MIFARE® card.
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6.8.10 Expressions

IMPORTANT! Expressions are supported in our Ultimate edition only!

The Expression tab of the Properties window makes it possible to control any property of

a Page object by means of a Python script, a Database column or a Manual Entry.

To control an object property with a script, select the object and enter the Python script in

the text box next to the property name. For example, select a text object on the card layout

and enter the following script for the Background property of that text object (in this case



Using the Designer 131

© 2016 CardExchange Solutions, Inc.

the script is just a single variable name):

vColor

After pressing Enter, the designer will prompt for a default value for the script variable

vColor. Here you can type, for example:

Red

After closing the pop-up window, the background of the text object will be red. The text

box where the script was entered will show a red glow to indicate that this value is now

controlled by a script. Changing the value of the script variable in the Variables tab of the

Properties window, will make the background color of the text object change accordingly.

For any script defined in the Expressions tab, it is important that the result value can be

converted to the correct data type. CardExchange™ Producer recognizes many text

representations, like ‘Red’ in the above example. Please, note that CardExchange™ Producer

recognizes the standard color names as well as the HTML representation of a 32-bits ARGB

color, for example:

#FFFF0000

Scripts can only contain a single line of code. For that reason, it will generally be necessary

to define functions in order to program more complex functionality. For the Background

property, one can, for example, define the following function in the Functions tab (For more

information about Functions, please see the Functions section in this Help file).

def IsValid(s):

  if s == 'OK':

    return 'Transparent'

  else:

    return 'Red'

With this function, the script for the Background property can look like

IsValid(vStatus)

If the variable vStatus has the value ‘OK’, the background of the text object will be

transparent, and red otherwise.

It is also possible to control the value of a property directly by a database column or
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manual entry, without the intervention of a script. This can be achieved by dragging and

dropping a database column or manual entry from the Data tab of the main window and

drop it on the text box in the Expressions tab. Database-column mappings are

characterized by a green glow and Manual Entries by a yellow glow.

6.8.11 Variables

IMPORTANT! Variables are supported in our Ultimate edition only!

Whenever a script is typed in the CardExchange™ Producer designer, the variables used in

that script are automatically added to the template. With the Variables tab it is possible to

see all variables that have currently been defined and manage their properties. The

following actions are possible:

· Rename a variable by clicking on its name and typing a new name.

· Change variable’s value by typing in the text box next to its name.
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· Set the variable’s value to an image by clicking on its image button and selecting

an image.

· Remove a variable by clicking on its remove button.

· Add a new variable by clicking on the Add-variable button.

· Connect a variable to a database column by dragging the column from the Data

tab and dropping it in the text box

· Connect a variable to a manual entry by dragging the column from the Data tab

and dropping it in the text box

· Create a text object on the card layout content is mapped to the variable by

dragging the variable name from the Variables tab and dropping it on the card

layout.

Please, note that any variable that has not been connected to variable data in the designer

will be available in the Advanced Mappings window in the configuration section of the

main interface. This provides a way to use the advanced data mappings instead of the

integrated mapping functionality in the designer.

Please visit the Advanced Mappings section of this Help file for more information.
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6.8.12 Functions

IMPORTANT! Functions are supported in our Ultimate edition only!

In the Functions tab, it is possible to define global variables, functions and references

that can be used in Python scripts. By using well-defined functions, the scripts in the

Content and Expressions tabs can be kept consistent. It would not be possible to use much

of the power of Python in scripts, if you could not define functions.

A function definition should strictly follow the Python syntax as described in the Python

documentation. An example of a function is:

def IsValid(s):

  if s == 'OK':

    return 'Transparent'
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  else:

    return 'Red'

This function returns either ‘Transparent’ or ‘Red’ depending on the value of the input

parameter s.

Global variables can be defined in the Function tab with a simple assignment statement.

Once defined, they can be used in functions and scripts. For example, instead of the above

function, we could make the following definition, with the global variable warningColor:

warningColor = 'Red'

def IsValid(s):

  if s == 'OK':

    return 'Transparent'

  else:

    return warningColor

Finally, the Functions tab can be used to reference Python modules, in order to use them

in functions and scripts. The following example imports the .NET Framework System

module and uses it to re-format a date string:

import System

def FormatDate(s):

  d = System.DateTime.Parse(s)

  return d.ToString('dd-MM-yyyy')

CardExchange™ Producer uses IronPython for executing scripts. IronPython is the .NET

Framework implementation of the well-known Python scripting language. For extensive

documentation on IronPython, please visit www.ironpython.org.

6.9 Layouts

As explained in the Templates section of this Help file, Layouts can contain one ore more

Pages. If you are running a Go, or Premium edition, only one layout is allowed. When

running a Professional or Ultimate editions, you can use multiple layouts within your

template.

Layouts are very powerful as they offer you the possibility to change based on information

http://www.ironpython.org
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out of the connected database. Also each layout can have it's own setting like for example,

no magnetic encoding or magnetic encoding.

6.9.1 Adding Layout(s)

Adding a Layout is simple clicking on the Layout button and a new layout will be added.

When adding a layout, it always adds a layout based on the previous layout. So for
example in the screen shot Layout2 contains only one page because Layout1 contains
only one page. If Layout1 would had two pages, Layout2 would also have two pages.

Each page can be setup via the Page Setup window as described in that section of this
Help file.



Using the Designer 137

© 2016 CardExchange Solutions, Inc.

6.9.2 Edit Layout(s)

For your own convenience it is possible and advisable to rename the Layout(s). When you
right click on the Layout name a context menu will be show and you select Rename. You
can also double click on the Layout name and change it. 
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6.9.3 Delete Layout(s)

You can easily delete a Layout from your template by selecting the Layout and press
Delete on your keyboard. By selecting the Layout and right click on the mouse, in the
presented context menu you choose Delete.

You can always undo your deleting by pressing Ctrl+Z or the Undo button in the Quick
Access Toolbar.

6.10 Page(s)

Every Layout can basically have unlimited Pages. A Layout can have for example a Front-
side Page, a Back-side Page, a Front-side UV Page, etc.

Each Page can be set to Portrait or Landscape and of course can have it's own unique
objects.

In this section of the Help file we will explain how to Add pages to your layout and how to
Delete them.
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6.10.1 Adding Page(s)

When you have selected your layout, you can add a page by clicking on the Layout Page
button in the Home tab.

You can also add a Page via the Layout page button in the Insert tab.

Click on Layout page to add the page as shown in the screen shot.

Each page can be setup via the Page Setup window as described in that section of this
Help file.
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6.10.2 Delete Page(s)

You can delete a page by selecting it and click on Delete on your keyboard or via the right
mouse click content menu, selecting Delete layout page.

6.11 Objects

CardExchange™ Producer offers a lot of objects to design your card. From standard text
objects to image objects for photos and signatures to 1D and 2D barcodes, lines, etc.

Each object comes with a collection of Properties that can used to customize your objects
to your wished. The properties of the objects are explained in the Properties section of
this Help file.

In this section we will go over each available object and how to use it.
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6.11.1 Text

Select the Text object from the Insert tab or from the Insert section of the Home tab.
Click with the mouse on a location of the page and select one the available Standard
Object Types from the drop down menu. Select the font type, size, outlining, etc.

For more information about the different Standard Objects, please see the "Using Standard
Objects" section of this Help file.
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6.11.2 Image(s)

Select the Image object from the Insert tab or from the Insert group at the Home tab and
place this on the page by clicking on a location on the page.

When the Insert new object window opens, it is default set to Fixed Image. You can also
select Photo, Signature, Variable Image, and Script. You can find more information about
these configurations in the specific sections of this Help file.

When using the Fixed image, you can select an Image by clicking on the Select image...
button. When the image is presented, you can check the 'Point to image file' check box.
By default it is unchecked which means that the image is embedded into the page. If the
check box is checked, a reference to the file is made. The advantage of this is that it
keeps your templates small because it does not contain images, disadvantage is that if
the folder that contains the folder is moved or removed, your image will not be shown
anymore.

Of course it is also possible to align the image to your wished. You can align the image
horizontal, vertical, and stretch. 

When you hover over the presented image, you will see two buttons appearing. The 

button will delete the previewed image, the  button will open the ImageExchange®
Editor to make change to the image.
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More information about using the ImageExchange® Editor can be found in the "Using
Image Editor" section of this Help file.

IMPORTANT! Every object in CardExchange™ Producer has many Properties which are not shown in the
Insert new object form. Please see the Properties section of this Help file for more information about
specific use of functionality.

6.11.2.1 Photo(s)

IMPORTANT! This Photo option is available from Entry editions and higher!
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Using photos is specifically related to the use of database and is therefore not available in
the Designer edition. Starting from Entry, you can select and dedicate an image to a
specific photo field in the database or a reference to a photo in a folder based on a 'Point
to image file' reference.

The process for adding the image is exactly the same as explained in the "Using Images"
section of this Help file.

Select Photo from the object drop down box and the Select database column drop down
box will become available. If you select the ID field of the connected database, the
system will automatically make it a 'Point to image file' connection. It can also that your
database contains the complete reference to image file locations if that is the case,
please leave the Image folder location empty and set the file extension to 'Extension
included in source value'.

The image folder location can be entered directly as it can also be selected by clicking on

the  button. Select the file extension of the image, we currently support BMP, JPG,
PNG, GIF, and TIFF.

You can also set the format of the value coming from the database you know for sure
there is no mismatch.

If the database contains the image data and you have selected the image column, the
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'Point-to-file options' section will be disabled.

More information about Photos can be found in the "Using Photos" section of this Help file.

Check for more options like colors, borders, visibility, etc., the Properties section of this
Help file.

6.11.2.2 Signature(s)

IMPORTANT! This Signature option is available from Premium editions and higher!

Starting from Premium, you can select and dedicate an image to a specific signature field
in the database or a reference to a signature in a folder based on a 'Point to image file'
reference.

The process for adding the signature is exactly the same as explained in the "Using
Images" section of this Help file.

Select Signature from the object drop down box and the Select database column drop
down box will become available. If you select the ID field of the connected database, the
system will automatically make it a 'Point to image file' connection. It can also that your
database contains the complete reference to image file locations if that is the case,
please leave the Image folder location empty and set the file extension to 'Extension
included in source value'.
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The image folder location can be entered directly as it can also be selected by clicking on

the  button. Select the file extension of the image, we currently support BMP, JPG,
PNG, GIF, and TIFF.

You can also set the format of the value coming from the database you know for sure
there is no mismatch.

If the database contains the image data and you have selected the image column, the
'Point-to-file options' section will be disabled.

More information about Signatures can be found in the "Using Signatures" section of this
Help file.

Check for more options like colors, borders, visibility, etc., the Properties section of this
Help file.

6.11.2.3 Variable Image(s)

IMPORTANT! This Variable Image option is available from Premium editions and higher!

Our Premium edition offers a unique feature that allows you to switch images based on a
value of the database.
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The process for adding the Variable Image is exactly the same as explained in the "Using
Images" section of this Help file.

Select Variable image from the object drop down box and the Select database column
drop down box will become available. If you select the ID field of the connected database,
the system will automatically make it a 'Point to image file' connection. It can also that
your database contains the complete reference to image file locations if that is the case,
please leave the Image folder location empty and set the file extension to 'Extension
included in source value'.

The image folder location can be entered directly as it can also be selected by clicking on

the  button. Select the file extension of the image, we currently support BMP, JPG,
PNG, GIF, and TIFF.

You can also set the format of the value coming from the database you know for sure
there is no mismatch.

If the database contains the image data and you have selected the image column, the
'Point-to-file options' section will be disabled.

Check for more options like colors, borders, visibility, etc., the Properties section of this
Help file.

6.11.2.4 Backgrounds

There are basically two ways to use backgrounds on your page. You can simply add an
Image object to your Page, select the Image to use, and select Fit to page.
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A better way to go is using the Background functionality offered in the Page Layout tab.

When you click on the Background button, four options are offered.

Use no color or image...
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Choose from a one solid color...

Use a Gradient color...

Or use a background image.

The advantage of using a background via the Page Layout tab is that it will always make
sure that it completely covers the whole card. As you know, the card sizes vary when
using a Direct-to-Card printer or a re-transfer printer. With a re-transfer printer the print
size of the page layout is larger and using this Background functionality makes sure that
your image is always fitting the page and you will have no white lines with printing.
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6.11.3 1D Barcode

To add a 1D barcode object to you page, just select the Linear barcode button from the
Insert tab and click on a location on the page to place it. Now select the Symbology that
you want to use from the drop down menu. All most common 1D Barcodes are supported.

Standard the Fixed value is selected, for using other values please see the "Using
Standard Object Types" section of this help file.

Of course a lot of extra options are available for the 1D Barcodes but they need to be
access via the Properties window of the Designer. When the properties window is opened,
select the Content tab.
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You can add a checksum, set the options for specific barcodes like Codabar, Code-128,
etc.

6.11.4 2D Barcode

IMPORTANT! This 2D Barcode option is available from Premium editions and higher!
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To add a 2D barcode object to you page, just select the 2D barcode button from the
Insert tab and click on a location on the page to place it. Now select the Symbology that
you want to use from the drop down menu. All most common 2D Barcodes are supported.

Standard the Fixed value is selected, for using other values please see the "Using
Standard Object Types" section of this help file.

Of course a lot of extra options are available for the 2D Barcodes but they need to be
access via the Properties window of the Designer. When the properties window is opened,
select the Content tab.



Using the Designer 153

© 2016 CardExchange Solutions, Inc.

Just like with the 1D barcodes, a lot of specific 2D barcode options can be set.
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6.11.5 Drawing Objects

Select the Line, Rectangle, or Ellipse button to add it to the page. 

Check for more options like colors, borders, visibility, etc., the Properties section of this
Help file.
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6.11.6 Formating Objects

In the Home tab you can select the font, font size and font color that you want to use for
your object. For more information about formatting of objects, please see our "Properties"
section of this Help file. 
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6.11.7 Arranging of Objects

CardExchange™ Producer offers a lot of functionality to arrange your objects on the page.
All the arranging functionality is available via the Arrange group in the Home tab or via the
Context menu.
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6.12 Standard Object Types

With exception for the Image object, CardExchange™ Producer offers Standard Object
Types. Standard Object Types is functionality that can be connected to the object. In
this section we will inform you how to use these Standard Objects Types.

Standards Objects Types can be selected when adding a new object to your Page
designer or via the Content tab in the Properties window.
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6.12.1 Concatenation

Concatenation is very powerful functionality offered in CardExchange™ Producer. It offers
you unlimited ways to present or store data.

In this example we are adding a new Text object to our Page design and we have it set to
the default Standard Object Type, Fixed Value, and we enter a name into the text
area, in this case "Fixed" Now we click on the Concatenate button under the formatting
options.



Using the Designer 159

© 2016 CardExchange Solutions, Inc.

Now we get a new option to select a Standard Object Type, in this case, also a Fixed
Value is used but this can be any Standard Object Type available.

Now you see that the Standard Object Type is changed from Fixed Value to
Concatenate as indicated with the red arrow.

The Concatenations are divided by expandable tabs. When you click on the left down

arrow  it will open the selected one and close the previous opened:
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You also see a red vertical line on the left. This indicates the group of Concatenations.
There are no limitations to the amount of Concatenations you can make. You can always
change your Concatenations in the Properties window at the Content section.
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6.12.2 Fixed Value

Select Fixed Value from the Standard Object Type drop down menu, indicated with the
red rectangle and enter the text into the text area. 
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6.12.3 Global Counter

Select Global Counter from the Standard Object Type drop down menu, indicated with
the red rectangle and set the Global Counter options in the group indicated with the
orange rectangle. When using the Global Counter, you see that the text area is
indicated with a green rectangle. This means that the value shown is generated based
on the settings for the Global Counter and cannot be changed in the text area.
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6.12.4 Print Date

Select Print Date from the Standard Object Type drop down menu, indicated with the
red rectangle and it will directly present the date. You can also show the date and time
or time only by setting the date format options. When using the Print Date you see that
the text area is indicated with a green rectangle. This means that the value shown
cannot be changed in the text area.

The date reflect the date and time as available on your computer.
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6.12.5 Script

Select Script from the Standard Object Type drop down menu, indicated with the red
rectangle and enter the script in the text field under the drop down menu.

You will see that the text area is now indicated with a red/orange color which means that
the value shown is calculated based on the script.

IMPORTANT! Scripting is only available in the Ultimate edition.
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6.12.6 Database Columns

When you are running a Entry or higher edition of CardExchange™ Producer and you are
connected to an database, in the Standard Object Type drop down menu all the
database columns are available for selecting. The Standard Object Type Database
columns also indicates the name of the connected database in the header. In this example
it mentions 'Database columns (Students)'. Because CardExchange™ Producer offers
multiple database connections in the Professional edition and higher, multiple databases
and columns can be selected here.

When selecting a database column from the list, you will see that the text area is
indicated with a green rectangle. This means that the data shown is coming from the
connected database and cannot be edited in the text area.

See our Database section in this Help file for more information about using databases.
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7 Adding Card Templates

There are two ways in CardExchange™ Producer to add a new card-template. You can do it

basically from scratch using the Designer or you can use the CardExchange™ Producer User

Guided Wizard. But whatever you choose, you start by clicking some buttons.

When you are using a Go or higher edition, you can create a new card-template in two

ways:

When you select the Configuration tab, in the Loaded Cards group you can directly select

New card or you can click on the Card manager.

And click on Add. For each process it starts in the CardExchange™ Producer User Guided

Wizard. When clicking on add, this wizard will start.
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If you use or not familiar with the wizard, the new card-template needs to have a name, so

provide that in this window, but it can also be assigned to a category. Categories are

presented in a drop down menu directly under the Loaded Cards tab in the Explorer menu.

Categories are very powerful especially if you are using a lot of different card-templates. A

couple of standard categories are available, but if you want to use another category, just

simply type the name of the category in the drop down menu field and it will be available

for future card-templates.

By default this wizard starts up when you start CardExchange™ Producer. Uncheck the

"Launch this wizard automatically at startup" option if you do not want this.

When you have entered all the information in this first page of the wizard, proceed with

Next to go to page 2.
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In this page of the wizard we determine what we are doing... using the wizard to create a

new card-template or do it from scratch. When the first option is selected "I want help to

make my card by using this wizard" (default), you will be taken through the wizard ending

up with a card-template shown. How to add a card-template using the wizard is explained

in the section "Using the Wizard" of this Help file.

When you selected to skip the wizard option and want to do it from scratch,
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Just click on the Finish button. The whole process is explained in the "Using the Designer"

section of this Help file.
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7.1 The Wizard

Using the wizard is in most of the cases the best way to go. From this point, in seven clear

explained steps you will be heading towards a complete designed card-template including

or not including database connections, Barcodes, backgrounds, logo's, etc. Let's proceed

and click on Next!

Step 1
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In this page you need to select if you want to create a single or a double sided card-

template. Also the orientation needs to be set. Choose Landscape or Portrait. When done,

click Next to proceed.

Step 2

In this page you need to select if you want to connect to a database or not. In this Help file

we are using the connection to the database option.
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CardExchange™ Producer offers unlimited ways to use databases, multiple databases, etc.

In the wizard we are offering a selection of basic database templates you can choose from

for MS Excel files as well for MS Access. For using MS Access database you need at least a

Premium edition. If you want to use one of the provided database templates, simply select

one of them. Of course it is also possible to add your own database connection and make

all fields available in the wizard. The whole adding of a new database connection is

explained in the "Add Database" section of this Help file. When you are done, hit Next to

proceed.

Step 3
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A card always looks better when using a background color or a background image. In this

page of the wizard you can choose to have one of them or or both. Select the color needed

from the drop down menu or click on Browse and select the background image you want

to use. 

Who doesn't want one... a logo. Here you can also select the logo that you want to add to

your design. Just click on the Browse button, select the logo you want, and click on Next to

proceed.

Step 4
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It is usual that you would want to show a name on the card design, here you can choose to

have a combined name field where you just need to select the First name and Last name

fields from the database.

Photos and signatures are important objects for your design. In this page of the wizard you

can also select to add a photo or signature to your design. For using signatures, a Premium

or higher edition is needed. When you select Add a photo, you can select the referring

database column from the drop down menu. If you are using a connection to an MS Excel

file, using a photo will always be a "Point-to-image-file" connection as MS Excel cannot

contain binary photo information. If that is the case, we strongly advice to use a field from

the database that is really unique like the ID field. Keep in mind, names are not unique!

Proceed with Next when you have made your selection.

Step 5
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On this page all the available columns are made available for you to select. To add the

field to your design, just click on the check box before the column name. 

When all the needed columns are selected, proceed by clicking Next.

Step 6
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1D Barcodes are available starting from the Go edition and 2D Barcodes are available

starting from the Premium edition. We offer a large variety of Barcodes including all the

standard symbologies.

The Barcode symblogy can be selected from the drop down menus as well as the database

column that contains the information. Last step to take, click Next to proceed.

Step 7
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CardExchange™ Producer has now all the information to generate the card-template and

as soon as you click on Finish, the template will be generated. If you have the check box

selected, the Designer will open offering you the possibility to make adjustments to the

created design, if not, the card will be directly show in the Main Interface and the database,

if applicable, will be loaded and shown. And that's all she wrote.
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More information about editing the design can be found in the "Using the Designer"

section of this Help file.
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7.2 The Designer

When you directly want to enter the Designer and create your template from scratch you

have to select to skip the wizard and click on Finish.
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The CardExchange™ Producer Designer will open with a blank template. Take notice of the

caption which is mentioning 'CardExchange™ Producer Ultimate (Configuration Mode).

Starting from Go editions, the caption always reflects the edition you are using and

mentioning the configuration mode status indicates that it is not working as a stand alone

Designer license.

7.3 Edit Card Definitions

In older versions of CardExchange™ Producer configuration was done through the Card-

Definition Wizard. Although this wizard seemed logical, a lot of our customers found it very

hard to work with. Most of the functionality that is and was available via this wizard should

now be configured in the Card Designer but not all options are available . For more

advanced features like external plug ins, this wizard is still needed. But you also still need it

when you still use old version 6 layouts and have not converted them.

At this moment, when you are not using External Plug In's, you should not need this wizard

anymore. When you are using Plug Ins you still need to use the old Card-Definition wizard

and Advanced Mappings Window. Along the way, more and more functionality will be
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embedded into the Designer so at the end, this Card-Definition wizard will become

obsolete.

The Card-Definition wizard contains two pages. The first page contains all the information

about the layout, database connections, contactless encoding, and plug in's. Both pages are

explained in the sections Card Definition Wizard and Advanced Mappings.

By default the Edit card definition button is hidden to avoid confusion, you can enable it by

checking the box for "Show advanced mappings" under the advanced options in the

Configuration tab.
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7.3.1 Card Definition Wizard

Depending on the edition you are using, the definition setup is divided in 4 sections:

· Layout and magnetic encoding

· Database connections

· Contactless encoding

· External Plug Ins

Besides of the different sections, the definition wizard also offers functionality to create a

visible note per card definition that will be shown on the main window of CardExchange™

Producer. Simply type the information that you want to show to the user, click on Settings

to make some changes to the fonts and colors, and the note will be available for the user.
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7.3.1.1 Layout and Magnetic Encoding

In this section of the wizard you are defining the card templates. You can create new ones,

edit existing ones, or select card template files. All the basic settings that have to do with

producing a card are available in this section. Because CardExchange™ Producer is a card

production application, a card layout always needs to be created. Other selections are:

Functionality Description

Do you want to enable

printing?

Select this option if you want to produce cards. Deselect if you

want to use CardExchange™ Producer to encode cards only...

Do you want to enable

magnetic encoding?

Select this option if you want to encode magnetic cards. For

more information about magnetic encoding see 'Using

magnetic encoding' section...

Print front Default this option is set to the settings of the card layout. If

the card layout is created as double sided, this option will be

checked. Deselect this option if you have a double sided card

layout and you don't want to print the frontside...

Print back Default this option is set to the settings of the card layout. If

the card layout is created as double sided, this option will be

checked. Deselect this option if you have a double sided card

layout and you don't want to print the backside...

Rotate front When selecting this option, CardExchange™ Producer will

rotate the complete front of the card 180 degrees and send it to

the printer driver.

Rotate back When selecting this option, CardExchange™ Producer will

rotate the complete back of the card 180 degrees and send it to

the printer driver.

Print backside first In case of the use of printers with laminators, and when using

double sided card layouts, you want to print the backside first

because the front of the card needs to be laminated. Setting

this option makes sure that the backside will be printed first

and the front side last, which means that the lamination will

be placed on the front...

Send to printer as bitmap Most printers printing based on layer information. Occasionally

printers cannot work with that, like the Zebra P600 series, the

print a correct card with these printers the complete layout

needs to be processed and send to the printer driver as a
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Bitmap for the best result. Selecting this option sends the card

layout as an image to the printer driver...

7.3.1.2 Database Connections

In this section of the wizard you are defining your database definitions. You can create new

ones, edit existing ones, or select database definition files.

Functionality Description

Do you want to connect to a

database?

Select this option if you want to connect to a database and

want to create a database definition... Click on Create to create

a new definition or click on Edit to edit a existing one.

7.3.1.3 Contactless Encoding

In this section of the wizard you are defining your contactless encoding definitions. You can

create new ones, edit existing ones, or select definition files:

Functionality Description

Do you want to enable

contactless encoding?

Select this option if you want to use CardExchange™ Producer

to encode contactless cards. Only available as Premium with

the contactless module...

Do you want to put the card

on the smart-card reader

manually?

Select this option if you have a external encoder.

CardExchange™ Producer will ask, after graphical

personalization of the card, to put the card on the external

reader before executing the next print job...

Do you want to read data

from MIFARE® Classic?

Select this option if you want to read information from a

MIFARE® Classic card

Do you want to write data to

MIFARE® Classic?

Select this option if you want to write information to a

MIFARE® Classic card.

Do you want to read and/or

write from MIFARE®

DESFire?

Select this option if you want to use CardExchange™ Producer

to read and/or write from a MIFARE® DESFire card.
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7.3.1.4 External Plug In

CardExchange™ Producer offers unlimited possibilities to embed any non-existing, business

logic, or third party Software Development Kits. In this section of the wizard you define

your external plug in settings.

Functionality Description

Do you want to use external

functions or plug-ins?

Select this option if you have received a external plug that

needs to be configured for use inside of CardExchange™

Producer.

7.3.2 Advanced Mappings

At the left-hand side you see a navigator object with up to six tabs, depending on whether

you are using the magnetic or contactless encoding options. The tab Visible items shows all



CardExchange® Producer Help186

© 2016 CardExchange Solutions, Inc.

ordinary card objects that you have given a name to in CardExchange™ Producer Designer.

Visible items can be text fields, images or Barcodes. The card design of this example has

named card items like Name, ID_Number, Barcode, etc. 

Simply select the Tab of the Explorer on the left side to make the mappings available.

From the drop down menu, as indicated, you can select all types of Standard Object Types

to map to the items in the Explorer on the left side. Most of the functionality is already

available in the new Designer and these objects are linked to that separate section of the

Help file.

Depending on the edition running, it offers Standard Object Types for:

· .NET Function

· Biometric image

· Biometric template

· Card preview

· Chip serial number

· Concatenation field
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· Database Column

· DESFire read item

· DESFire serial number

· Enter manually

· Environment variable

· External Plug In Result

· Global counter

· MIFARE Item

· Photo

· Print date

· Signature

· Variable image
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8 Managing Card Templates

In CardExchange™ Producer we offer the possibility to manage unlimited card-templates. A

card-template is a collection of card-layout(s), card-page(s), and/or database connections,

and/or contactless encoding, etc. All available card-templates are managed from the Card

Manager. How to work with the Card Manager is explained in the Using the Card Manager

section.

8.1 The Card Template Manager

In CardExchange™ Producer all card-templates are managed via the Card Manager. 

The Card Manager is called from the Configuration tab of the CardExchange™ Producer

Main window.
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In this Card Manager window, all loaded card-templates are presented in a selectable list

on the left side. You can check and uncheck card-templates by clicking on the check boxes

for the card-template names. Unchecking a card-template means that it will not be visible

in the Explorer Menu under the Cards tab.

With the buttons on the right side of the Card Manager window you can perform the

following actions:

Button Description

Move up Moves the selected card up in the Loaded Cards tab

Move down Moves the selected card down in the Loaded Cards tab

Add Add a new card-template and opens the card-template wizard

Edit Opens the card-template in the Designer for editing

Rename Rename the selected card as it appears in the Loaded Cards tab

Remove Remove the card-template

By clicking OK, the window will be closed and all changes will be saved. Hitting Cancel will

cancel all changes made except the ones done via the Edit functionality.

For more information about how to add new card-templates, please see our "Add a Card"

section of this Help file.
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8.2 Migrating Version 6 Layout(s)

Although CardExchange™ Producer still supports version 6 templates we can imagine that

you would like to use your old card-templates with the new Designer and take benefit of all

the new functionality offered now. Because we can imagine that you do not want do redo

all your existing version 6 card-templates, CardExchange™ Producer offers functionality to

migrate the old templates to the new version.

When selecting the Configuration tab, you can find the Migrate version 6 layout button. If

this button is not shown, please see the "Advanced Options" section in this Help file and

check the Show Migrate button or menu option in the Advanced Options window.

When the button is available, simply click on the Migrate version 6 layout button and the

selected card-template (*.ced) will be migrated to the new version 7/8/9 format (*.cedx).

When the card template is migrated, the new template will be loaded and clearly marked

as (migrated). You do not loose your original template!

8.3 Export Templates
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CardExchange™ Producer, starting from version 9.1 has the option to export card

templates. This includes the card design (.cedx), database definition (.dtd) and any Mifare

Defintion files (.mfr, .mfd etc..).

This can be beneficial from a support perspective but also from a configuration point of

view as designs can be setup prior to an installation.

Clicking on Export template will prompt you to select the desired templates that you wish

to export, when you click ok you can specify the location to export them to as well as the

name for the exported (.ctp) file.
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8.4 Import Templates

CardExchange™ Producer, starting from version 9.1 also has the option to import card

templates. This includes the card design (.cedx), database definition (.dtd) and any Mifare

Defintion files (.mfr, .mfd etc..).

This can be beneficial from a configuration point of view as designs can be setup prior to

an installation and imported later.
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When you click on Import template you just need to browse to an already exported

template and click on open. 

As exports can contain multiple templates you can then select which templates you wish to

import, by default all templates are selected.

When clicking on OK the template is imported and will appear in the Cards tab of the

explorer view in the main window.



CardExchange® Producer Help194

© 2016 CardExchange Solutions, Inc.

8.5 Duplicate Templates

CardExchange™ Producer also offers the possibility to duplicate an existing card template.

This can be useful if you want to have a second card design that has just a few changes

from an existing card design.

First select the card template that you wish to duplicate, then click on the Duplicate

template button.

You will then be prompted to enter a new name for the template, this name has to be

unique.

Once you click on OK, you will see the duplicated template in the cards tab of the explorer

window.

IMPORTANT! Duplicated templates share the same database definitions, Mifare definitions and plugin

settings as the original template. Any settings changed will apply to both templates.
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9 Printing Cards

The Print tab is organized in different groups with specific functionality.

Group Function(s) Description

Options Printer OptionsConfigure your printer(s), Contactless encoding, Magnetic

encoding

Standard

printer

Print card Opens the print dialog

Printer

properties

Opens the printer properties dialog of the selected printer

Export previewExports a preview of the card as a file

Print report Opens the Print report dialog

Windows

printers

Select printers Select printer(s) that can be directly accessed via Print to and

the Explorer Menu

Print to Print directly to the selected Printer from the drop down

menu

Automatic

printing

Edit trigger Edit and activate the printing trigger

Start printing Start automatic printing if configured

Show print log Show the print log

9.1 Select Standard Printers
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When the printer options window is opened, it will present all the installed Windows

Printers on the system CardExchange™ Producer is running on. Just select the printer you

want to use from the list view and click on OK to confirm.

If you want to use the selected printer for all loaded card-templates, make sure you check

"Apply these settings to all loaded cards" otherwise each card-template will have it's own

specific printer connected.
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9.1.1 Contactless

In the Contactless tab you are able to test your hardware configuration for encoding

contactless cards.

The Reader Info Section

· Reader type - Select the reader being used inside your printer or externally

· Serial port - Select the serial port the reader communicates with (not applicable for PC/

SC)

· Baud rate - Select the baud rate (speed) of the used reader

· PC/SC version - When PC/SC readers are used, select the version 1 or 2

· Reader pin code - If reader requires a pin for access, you have to enter it here

· Test reader with card movements - Set to True or False

In the Reader Info Section you can also find two buttons. The button Refresh refreshes the
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list of readers available in the Reader type drop down menu. When a new PC/SC reader is

added to the system, this button needs to be pressed to make it available. The second

button is the Test button. Depending on card movements setting, clicking this button will

move the card to the encoding position of the printer that is selected in the Printer Options

section and will test the reader.

In the reader test window it will indicate if CardExchange™ Producer is able to

communicate with the reader, if a card is presented, and can read the CSN (Chip Serial

Number). These test are clearly marked with Red and Green lights.

When using older printers that works with so called escape commands to move the card in

the encoding position, there is no information shared about the exact position of the card

in the printer. For these printers we need to set the Time delays in the Time delays section.

There are basically two settings that can be entered; Time delay before encoding and Time

delay after printing. The average time delay after printing is round 30 seconds (30.000 ms).

On the the moment that the card is electronically processed, it will be set to print position.

On that moment CardExchange™ Producer will prepare the next card for encoding, when

printing multiple cards of course. After 30 seconds, independently of the state the printer is

in, CardExchange™ Producer will instruct the reader to access the card. With these older

printers you will have to play a little with these time delays to get the best results. Don't

forget to make sure to check the Configuration settings in the Advanced options for using

Factory or non-factory build in readers.

Factory built in readers normally work via SDK's (Software Development Kits) that give

CardExchange™ Producer full control of the printer and time delays are normally never

needed and can stay in the default settings of 2000 ms.
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1 sec = 1.000 ms

Of course, all these setting made can apply for all cards or the selected card only.

For more information about Contactless encoding, please see our Using Contactless

Encoding section of this Help file.

9.1.2 Magnetic Encoding

In the Magnetic tab you can set the start and stop commands for the printers to encode the

magnetic stripe. Most common start and stop commands can be found on our 

CardExchange™ Producer End-Users Forum. Of course, these settings can apply to all cards

or the selected card only.

http://forum.cardexchangesolutions.com/component/kunena/18-general/36-start-and-stop-sentinels-for-magnetic-encoding
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IMPORTANT! These Start and Stop commands only apply when using the old version 6 Designer! Magnetic

encoding via CardExchange™ Producer 7, 8 and 9 is explained in the "Using Magnetic Encoding" section of

this Help File!

9.2 Print Using Standard Printer

There are three ways to print a card to the standard printer.

· Click the Print button in the Standard printer section of the Print tab,

· Select the Print option in the Actions Pane or

· Press Ctrl+P on your keyboard

If you use the print option in the Actions Pane, CardExchange™ Producer will start printing

directly, using the default settings. Otherwise, CardExchange™ Producer displays the

window shown below.
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In the Selected printer group you can find the information of the printer you are printing

too like the Name of the printer, the Status of the printer, Type, etc.

Just like in normal Microsoft Office Applications, in the Print range group you can set to

print the Selected record, All records, or a selection of Records. The Number of selected

records is indicated in this named field.

Next to the name, the button Properties... gives access to the printer-properties window,

allowing to adjust any settings before starting to print. Generally, it is not necessary to

change the printer properties once they have been defined for the first time.

In the Copies group you can enter or select the amount of copies that needs to be printed.

By default CardExchange™ Producer prints one copy.

If the card uses a global counter, in the Global counter group you can see the number

indicating the global counter number that will be used for the first card to be printed. For

each consecutive card the global counter will be incremented by one. The global counter

can be edited to change this number to another value. It is up to the user to decide whether

changing the default value is necessary.

9.3 Viewing the Print Report

You will find the Print report option under the Standard printer section of the Print tab. If

you click this option, a simple report will be displayed showing how many prints have been

made of the loaded cards since the system administrator loaded them into CardExchange™

Producer.
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The Print button allows you to send the summary to a printer. Use the Page setup button

to specify the layout options you want to use. Use the Print preview button to view the

result before printing it.

You can also save the summary in a file. To do this click Save. Then choose the folder into

which you want to save the overview and specify the file name. The summary can only be

saved as a text document.

9.4 Select Windows Printers
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Besides the fact that each card-template can have it's own unique printer connected, via the

Windows Printers functionality, you can make specific Windows printers available to

overrule the default card-template printer which you configure in the Printer Options

section.

When the Windows Printer Manager window is opened, you can make the printer available

by checking the check box in the list view. You can also move printers up and down and

rename them so they get more understandable names.

The selected printers will become available in Windows Printers tab under the explorer

menu.

9.5 Print Using Windows Printer
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There are two ways to print a card to a Windows printer instead of the standard printer.

· Click on the Name of the printer in the Windows printers tab in Explorer Menu or

· Select the Printer Name from the drop down menu in the Windows printers section

of the Print Tab.

In both cases, the Print command window appears.

In the Selected printer group you can find the information of the printer you are printing

too like the Name of the printer, the Status of the printer, Type, etc.

Just like in normal Microsoft Office Applications, in the Print range group you can set to

print the Selected record, All records, or a selection of Records. The Number of selected

records is indicated in this named field.

Next to the name, the button Properties... gives access to the printer-properties window,

allowing to adjust any settings before starting to print. Generally, it is not necessary to

change the printer properties once they have been defined for the first time.

In the Copies group you can enter or select the amount of copies that needs to be printed.

By default CardExchange™ Producer prints one copy.

If the card uses a global counter, in the Global counter group you can see the number

indicating the global counter number that will be used for the first card to be printed. For
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each consecutive card the global counter will be incremented by one. The global counter

can be edited to change this number to another value. It is up to the user to decide whether

changing the default value is necessary.

9.6 Automated Printing

With Automated Printing you are able to fully automate the print process for each

connected card layout through your own application. That means that when Automated

Printing is configured and you add a new record through your own application, for example

an Access control application, CardExchange™ Producer monitors the database from this

application and when the new record appears in the database, CardExchange will

automatically print the connected card.

The Automated Printing functionality is based on creating triggers on the database. These

Triggers are created by means of the powerful Storage Items in our Database Connection

Wizard. By setting a trigger condition, like checking if the assigned database field is empty,

CardExchange™ Producer monitors what happens in your database. Together with this

functionality we introduce a new filter level, which will be set independently of any other

filter created. These triggers can be set for every connected card template in

CardExchange™ Producer and for each trigger you are able to set trigger intervals.

Automated Printing allows you to have CardExchange™ Producer working in the

background, but CardExchange™ Producer monitors and reports all jobs that it prints. This

window contains information about records that are printed, card-layouts, printer errors,

etc.

IMPORTANT! Automated Printing is available for Professional and higher editions!

9.6.1 Configure

Automated Printing is based on creating a trigger on a field in the connected database.

This means that for using this functionality, Storage Items needs to be created. Based on

the Storage Item, CardExchange™ Producer will monitor any changes of the field. Storage

Items are created when the database connection is made. Connecting to a database and

creating storage items is mentioned in section 'Databases' of this Help file.

Considering the fact that the Storage Item is created we need to address and set the trigger

for monitoring the database for changes.
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Select Edit trigger from the Automated printing section of the Print tab. This will open

the Edit Trigger window.

When the Edit Trigger window is opened you need to Activate the trigger to set all the

properties. By checking the check box 'Activate trigger' you will have access to three

important properties. First you need to select the field where CardExchange™ Producer

needs to trigger on. This can be selected from the drop down menu 'Associated storage

item', here will be all the created storage item presented.

The next step is to set the trigger condition. This condition is executed on the database

field. In this case the record will be printed when the triggered database field (PrintDate)

IS NULL (default).

The last step is to set the trigger interval. In this example, CardExchange™ Producer will

look every 10 seconds if there are records in the database where the PrintDate field is

NULL. When it finds a field that follows the trigger condition it will print that record.

It is also possible to define the Error behavior in case of something happens during the

printing process. You have four different options:
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· Do not process the storage item - When an error appears, the storage item is not

processed

· Process the storage item as usual - When an error appears, the storage item will be

processed

· Store this value - When an error appears, the value entered in the text box will be

stored

· Store the error message - When an error appears, the error message will be stored

Automated printing can be configured for every connected card layout in CardExchange™

Producer.

9.6.2 Start and Stop

When all the triggers are set and activated we need to start Automated Printing. Select

from the Automated printing section in the Print tab Start printing.

The Print log screen will be displayed and it will show all activity of the print server.

CardExchange™ Producer is locked during the process of Automatic printing.

To stop the process just click on the Stop button in the Print log window and no triggers

will be processed.
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10 Using Data

Viewing and Managing data from a connected database is very important to have a
smooth production environment. CardExchange™ Producer offers many ways to look up
data, enrich data, view data, etc.

In this section of the Help file we will go over all the functionality available like using
Filters, Update your Database, etc.

10.1 Edit Data

The Edit database record window gives you direct access to the personal data stored in
the database. Provided that the CardExchange™ Producer administrator has given you
permission to do so, you also can edit these data and add or remove records.
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You can open the Edit database record window by selecting Database data in the Edit
section of the Data tab. A so called dockable window will appear in the lower part of the
main window. By clicking on the bar with the text Edit database record, you can dock the
window to the upper part or to the sides. You can even turn it into an independent
window by dragging it to a position away from the edges of the main window. Clicking on
the pin will cause the window to minimize. Clicking on the cross will close the window.

On the left part of the docked window, there are five buttons for performing database
operations. On the right part, all names and values of the database records that apply to
the selected person are displayed. If you select another record, the Edit database record
will load automatically the data associated with the selected record.

With the buttons, you can perform three types of database operations: Insert records,
Update records, and Delete records. The following sections will describe these actions
one by one.
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10.1.1 Insert Database Records

A database record can be inserted in four steps:

· Open the Edit database record window.
· Click on the New button in the Edit database record window. Note that all fields

will be cleared in order to enable you to enter new data. The cursor will be
positioned automatically on the first field that can be edited. The buttons Insert
and Cancel will be enabled.

· Enter the data you need into the empty fields.
· Click on the Insert button to load the data into the database, or on the Cancel

button if you do not want that.

While inserting a new record, all functions of the main window are disabled. These will be
enabled as soon as the Insert or Cancel button is clicked on. You can only insert a new
database records if the administrator has given you permission to do so and if no more
than one name has been selected in the name list.

10.1.2 Update Database Records

A database record can be updated in four steps:

· Open the Edit database record window.
· In the Data Record View, select the record you want to change.
· Click on the field you want to change and change it. Instead of using the mouse,

you can also press F2 to position the cursor on the first field that can be edited
and use the Tab key to move to the desired field. The buttons Update and
Cancel will be enabled as soon as you start typing.

· Click on the Update button to load the data into the database, or on the Cancel
button if you do not want that.

While updating a new record, all functions of the main window are disabled. These will be
enabled as soon as the Update or Cancel button is clicked on. You can only update a
database records if the administrator has given you permission to do so and if no more
than one name has been selected in the name list.
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10.1.3 Delete Database Records

A database record can be deleted in four steps:

· Open the Edit database record window.
· In the Data Record View, select the record you want to remove from the

database.
· Click on the Delete button in the Edit database record window.
· Say Yes to the question if you really want to delete the record. Say No if you do

not want that.

You can only delete database records if the administrator has given you permission to do
so and if no more than one record has been selected in the Data Record View. So you
cannot delete more than one record at the same time.

Important! Deleting records from connected MS Excel files is not supported.
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10.1.4 Using Manual Entries

The Enter data manually window gives you the possibility to enter data that should
appear on the card without the intervention of a database. In order to enable this
window, Manual Entries have to be defined. How to create Manual Entries can learned in
the Manual Entries section of this Help file. Only these created Manual Entries will appear
in the Enter data manually window.

You can open the Enter data manually window by selecting the option Enter data
manually in the Edit menu as shown in the screenshot. A so called dockable window
will appear in the lower part of the main window. By clicking on the bar with the text 
Enter data manually, you can dock the window to the upper part or to the sides.

You can even turn it into an independent window by dragging it to a position away from
the edges of the main window. Clicking on the pin will cause the window to minimize.
Clicking on the cross will close the window.

In the example shown above, the administrator has defined four Manual Entries. For each
Manual Entries a text box appears where the operator can type data. The left part of the
window shows a Clear button that can be used to clear all text boxes before typing new
data. While typing data, the Apply and Cancel buttons are enabled. The Apply button
should be pressed in order to confirm the data entered and display it on the print preview.
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By pressing the Cancel button, the manual data entry is canceled and the former values
are restored.

10.2 Filters

If you have a very large database, initial loading or refreshing the list of names can take
some time. If the only reason to refresh the data is to retrieve the details of one person,
you will probably consider it a nuisance to have to wait until the entire list of names has
been loaded. Therefore, CardExchange™ Producer offers you the possibility of filtering out
the data you do not need at the database level. To do this, you have to access the Data
tab.

CardExchange™ Producer has three distinct filter levels. The first level is a filter that is
defined by the administrator and that is always applied. Using this filter, the administrator
can avoid that the user has access to certain records in the database. For example, if
there is an employee table, this filter can be used to show only employees that are still in
service and hide any historical information. It is very likely that the user is not even aware
of the fact that a level-one filter is applied. However, it is useful to know that this filter
type exists. It helps to understand, for example, why a certain record is visible in another
application but not in CardExchange™ Producer.

The second filter level consists of a series of named filters that the operator can
activate or deactivate freely in order to limit the number of names shown in the Data
Record View. The filters at this level are defined and named by the administrator. The
filter names are shown as buttons in the Filters Tab of the Explorer Menu. By clicking on a
filter button or menu option, the filter in question is activated while all other filters are
deactivated. By clicking the button or menu option with the text (no filter) all filters are
deactivated. The status bar shows which level-two filter is active. In the above screen
shot, one level-two filter called "No photo" has been defined en is shown in the tool bar.

Level-two filters are meant to divide the records in the Data Record View into logical
groups. With a single mouse click, the operator can limit the records shown in the Data
Record View to a specified logical group.

For example, one could define a level-two filter for each school class (if the card has been
coupled to a students database). Other possibilities are creating a level-two filter for each
employee for whom there is no photo in the database, or all employees for whom more
than one card has been printed. It is not possible to activate two level-two filters at the
same time, but you can use levels one and two simultaneously. After all, a user can never
deactivate the first level, not even by selecting the button (no filter).

Finally, there is also a third filter level. This level can be switch on or off by the
administrator. When activated, the user himself can determine in what manner he wants
to filter his data. Every time he requests information from the database (for example, by
selecting Refresh data under the Data ribbon tab section Find), a window prompts for the
desired filter conditions.
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IMPORTANT! For using filters a Premium or higher edition is needed!

10.2.1 Level One Filters

The level-one filter is normally defined by the administrator and is that filter that always
applies. Using this filter, the administrator can avoid that the user has access to certain
records in the database. For example, if there is an employee table, this filter can be used
to show only employees that are still in service and hide any historical information. It is
very likely that the operator is not even aware of the fact that a level-one filter is
applied. However, it is useful to know that this filter type exists. It helps to understand,
for example, why a certain employee is visible in another application but not in
CardExchange™ Producer.

The Level One filter can be edited by choosing the option Edit level-one filter in the
Filters section. If no filter has been defined before, the following window appears:

Now, you can add a filter condition with the menu option Add conditions in the Edit
menu (you can also press the Insert key). A screen will be shown in which you can
choose the database column and functions and operators to use in your filter. In the
example below the column PrintCount is used for filtering, without applying any database
function. The result is compared to the entered value using the is-equal-to operator.
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Note! The functions and operators you can choose are database dependent.

Once you clicked OK to close the filter-definition window, the new condition will appear as
follows. You can use the text box to enter the value to which you want to compare. In
the example below the filter only passes records for which the field PrintCount is equal to
zero.

In the same manner, you can enter a second condition. In fact, there is no limit on the
number of conditions. Each condition will have its own field in which values can be
entered. When using multiple conditions, the following rules apply:

· If you leave a field empty, the condition will not be applied,
· If you enter values for more than one condition, only records are selected that

meet both conditions,
· If you type null or NULL and the operator is = or LIKE, only records are selected

for which the database column contains a null value,
· If you type null or NULL and the operator is <>, != or NOT LIKE, only records are

selected for which the database column contains a value,
· If you type null or NULL with another operator, no records are selected.

When you click on the OK button, the Level One filter will be applied immediately. The
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next time you choose Edit level-one filter, the conditions will displayed exactly as
defined before. With the Edit menu, you can change or delete them, or add more
conditions.

It is also possible to Change or Delete your conditions.

Just select Change Condition or Delete Condition from the Edit menu. You can also
Delete All at once.

Please visit the "Tips and Tricks" section of this Help file for more information about
configuring filters.

10.2.1.1 The SQL View

In a limited number of situations, the standard Level One filter described in the previous
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section does not offer the flexibility needed to define the desired restrictions. In that
case, you have the possibility to choose the option Show SQL in the View menu of the
Edit level-one filter window.

In this window, you can define your Level One filter using the SQL of the connected
database. By default, you will see the SQL equivalent of the conditions defined in the
standard view of the Level One filter, but you can change it the way you want.

The SQL you enter will be stored in the internal database, but will be lost if you switch
back to the standard view. In that case, you will see the conditions as you defined them
before activating the Show SQL option.

10.2.2 Level Two Filters

Level Two filters are a series of named filters that the operator can activate or
deactivate freely in order to limit the number of records shown in the Data Record View.
They are normally defined and named by the administrator. The filter names are shown as 
buttons in the Filters Tab of the Explorer Menu. By clicking on a filter button with the text
(no filter) all filters are deactivated. The status bar shows which Level Two filter is active.

Adding Level Two filters starts by clicking on the Edit level two filters button in the
Filters section of the Data tab.
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The Window that opens manages the different created Level Two filters. This manager
offers you to add or edit new and existing filters, rename or remove them, or change the
position in the Filters Tab of the Explorer Menu by moving them up or down. Administrators
can protect normal operators to view all data by not presenting the No filter button to the
user. By deselecting the 'Show no-filter button' the user will only have access to data
that is offered when executing the defined Level Two filters.

Adding new filters works exactly the same as described in the section Level One Filters. In
fact, for adding a Level Two filter, you can follow the same procedure and there is no
need to repeat the actions here. After adding a condition via the Edit menu, your window
will look similar to the one shown below.
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One major difference with the Level One filters is that with the Level Two filters you can
define that a condition needs to be asked when the filter is activated. In the screenshot
you see that "[Photo]=NULL". When we check "Ask for condition when activated", a
window will pop-up asking you to enter the condition for the filter. This can be handy if
you create a filter that looks up a employee or student numbers. After clicking OK, you
will be prompted to enter a name for the filter.

When entering a name for the filter, just like with the card templates, also the filters can
be divided into groups. As in the screenshot above, everything before the backslash '\' is
considered to be the Group Name and is selectable in the drop down menu directly under
the Filters Tab of the Explorer Menu. Everything behind the "\" is considered as the name
of the filter appearing as the button. Of course you can also directly enter only the name
for this defined filter.

Click on OK to save the filter, the filter will be shown in the Filters Tab of the Explorer
Menu. The defined Level Two Filters are also available via the drop down menu in the
Filters in the Filters section of the Data tab.
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Furthermore, the filter will be applied, showing you how the defined conditions actually
affect the data in the Data Record View.

10.2.2.1 Edit Level Two Filters

Existing Level Two filters can be Edited, Renamed and Removed by choosing Edit
level-two filters from the Datatab, the following window appears:
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In the list box, you see all Level Two filters that have been defined. With each Level
Two filter you can perform one of the following actions:

· Hide the filter (without removing it) by deselecting the check box that appears
before the filter name.

· Change its position in the Filters Tab of the Explorer Menu by using the Move up
and Move down buttons.

· Add a new Level Two filter by clicking on the Add button
· Edit the conditions that make up the filter by clicking the Edit button.
· Change its name by clicking the Rename button and entering another name.
· Remove the filter by clicking the Remove button and confirming that action by

clicking Yes.
· Show or don't show the No filter button

10.2.3 Level Three Filters

Generally, activating the Level Three filter can only be done by the administrator and is
done via selecting the Enable level three filter button in the Filters section. If
authorized, you can activate the Level Three filter by checking the Enable level-three
filter option in the Data tab. CardExchange™ Producer will display the following warning
message to make clear that the Data Record View will no longer be automatically filled. 

So do not be surprised if you no longer see any records. When activated, the operator
himself can determine in what manner he wants to filter his data.
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Every time the operator requests information from the database, for example, by
selecting Refresh data in the Find section or pressing F5 on the keyboard, a window
prompts for the desired filter conditions.

In this standard window you have two options you can search on. In the Filter variable
group you can select:

· Search on last name
· Search on personal number

In the Find what text box you enter the information you are looking for and if you want
to find exact matches only, you have to select the 'Search for exact matches only'
check box.

Now if you click on OK, CardExchange™ Producer will execute the SQL directly to the
connected database and will present the result in the Data Record View.

The advantage of this filter is that when connecting to databases with hundred of
thousands of records, you only load the information needed for your production without
constantly loading the Data Record View with information that is not needed.

An example using this filter could be when taking pictures of students. The student enters
the room, the operator enters the student number into the Find what field, hits OK to
search, when the record is found, takes a photo of the student, and saves the record.

Disable the filter by clicking on the 'Disable level three filter' button and click on Refresh
data or press F5 to reload the database data into the Data Record View.
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10.2.3.1 The Advanced Filter

In case the standard Level Three filter does not offer the functionality you need to
select the desired records, you can switch to the Advanced Level Three filter.

This is achieved by Switching on the Level Three filter, calling the standard filter by
choosing Refresh data or using the F5 button on your keyboard, and clicking the
Advanced Filter button and the following window will be shown:

Now, you can decide yourself which database columns you want to use for filtering. You
can add filter conditions with the menu option Add conditions in the Edit menu. A
screen will be shown in which you can choose the database column and functions and
operators to use in your filter.

In the example below the column Lastname is converted to lower case characters using
the function LOWER. The result is compared to the entered value using the Like
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operator. The functions and operators you can choose are database dependent. For
example, the function LOWER exists in SQL SERVER, but not in MS Access. In the latter
case, you can use the LCase function to convert the characters to lower case.

Once you have defined some conditions, the advanced database filter window will look
something like screen shot shown below.

In the text boxes you can type the values that complete the conditions. These have to
meet the following rules:

· If you leave a field empty, the condition will not be applied,
· If you enter values for more than one condition, only records are selected that

meet both conditions,
· If you type null or NULL and the operator is = or LIKE, only records are selected

for which the database column contains a null value,
· If you type null or NULL and the operator is <>, != or NOT LIKE, only records are

selected for which the database column contains a value,
· If you type null or NULL with another operator, no records are selected.

When you click on the OK button, all the records that meet the conditions are retrieved
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from the database.
With the Edit menu, you can change and delete existing conditions. All definitions are
stored in the internal database of CardExchange™ Producer and will be reloaded in the
next session.

CardExchange™ Producer remembers that you want to use the advanced filter for the
current database connection. The next time you refresh the data with F5, the advanced
filter window will open immediately and there is no need to pass through the standard filter
window.

With the button Standard filter, you can always return to the previous situation.

10.2.3.2 The SQL Filter

In a limited number of situations, even the advanced filter does not offer the flexibility
needed to make the precise selection. In that case, you have the possibility to choose
the option Show SQL in the View menu of the Advanced database filter window. The
following screen will be shown:

In this window, you can define your filter conditions using the SQL of the connected
database. By default, you will see the SQL equivalent of the conditions defined in the 
standard view of the advanced filter, but you can change it the way you want. The
SQL you enter will be stored in the internal database, but will be lost if you switch back to
the standard view. In that case, you will see the conditions as you defined them before
activating the Show SQL option.

10.2.4 Tips and Tricks

Upper and lower case

When filtering on a string variable, like the last name of the persons in the database, you
often do not want to care about whether you enter upper or lowercase characters. You
can accomplish that by applying at both the left and the right hand side of the condition a
function that converts the characters to lowercase (LOWER for Oracle and SQL Server
and LCase for Microsoft Access).
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The Like operator

It is also possible that you do not want to enter the complete name or that you do not
know how to spell a certain part of the name. By using the Like operator instead of the
equal sign, you can realize that, since Like allows for the use of wildcards. The most
important wildcards are the percent sign (%), that represents zero or more characters,
and the underscore (_), that represents a single character. Furthermore, you can give
alternative characters by putting them between square brackets ([]). Some examples of
the use of wildcards are:

· LOWER(“LASTNAME”) LIKE ‘s%’ selects all names that start with an s
· LOWER(“LASTNAME”) LIKE ‘cart%er’ selects both Carter and Cartner
· LOWER(“FIRSTNAME”) LIKE ‘Eri_’ selects all four character names that start wit

Eri
· LOWER(“FIRSTNAME”) LIKE ‘Eri[ck]’ selects all persons called Eric or Erik

Numeric values

When you want to filter on numeric values, you have to take care that you use the
correct decimal separator (comma or point). In the advanced database filter, you have to
follow the configuration of you operating system. However, in the SQL view, you always
have to use a point.

Dates

Microsoft Access, SQL Server and Oracle store dates as date-time values. If you want to
compare these values, not only the date part, but also the time part has to match. If you
only want to check for equal date parts, you can achieve this by using the following
conditions:

· Microsoft Access: Int([BirthDate]) = DateValue(’10-apr-1968’)
· SQL Server: [BirthDate] >= ’10-apr-1968’ AND [BirthDate] < ’11-apr-1968’
· Oracle: TO_DATE(“BIRTHDATE”) = TO_DATE(’10-apr-1968’)

In all cases, BirthDate is a date-time field and only those records will be selected for
which the date part is 10 April 1968.

Microsoft Access stores the date-time value as a floating point number. The part before
the decimal point represents the date part, whereas the decimals represent the time part.
The function Int removes the time part, setting it to 0:00:00 AM. The function DateValue
always results in a date-time value whose time part is 0:00:00 AM, so that the condition
above effectively compares only the date part of BirthDate.

In Oracle, the same effect can be achieved by using the TO_DATE function on both sides.
In SQL Server, a similar function does not exist, but this can be circumvented by defining
two conditions. In this way, all records are selected, for which BirthDate is between 10
April 1968 0:00:00 AM and 11 April 1968 0:00:00 AM.
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10.3 Record Lookup

The simplest way of adding the correct record details to the card is to use the Data
Record View that is displayed at the left-hand side of the main window. You can use the
scroll bar to scroll through the list to find the correct record and then select it by clicking.
The Data Record View may be sorted in various ways and is not necessarily alphabetical.
You must take this into account when searching for a record.

In the Data Record View in the main interface of CardExchange™ Producer you see all the
records presented that are available in your database. When you make a database
connection, in the name list page you select the columns that are shown in the Data
Record View. You can find everything about making database connections in the "Using
Databases" section of this Help file.

Record Sorting
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The Data Record View is a so called data grid showing all your available database records
divided by columns. Sorting the records is just as simple as clicking on the column. 

Record Look Up

It is very simple to search for records inside the Data Record Overview. Enter the text
that you want to search for in the text box directly above the columns. The text you
enter always applies to the first column in the Data Record View. If you want to look up
records from the Lastname column, you have to drag the column to the front. 

Loaded Record Information

In the footer of the Data Record View the total amount of loaded records is shown.

You will notice that this method becomes less attractive if the list is very long and that
you need a more directed manner of finding the correct data. The following alternative
find methods are available:

· Finding names using the Find section in the Data tab,
· Finding names using the Keyboard
· Finding names using the Database Filters

The first two methods will be explained in the following sections. For an explanation of the
database filters, please refer to the section Filters of this Help file.
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10.3.1 Using Find

In the Find section of the Data tab you can find the functionality Find. If you select this
option, you enter a dialog window in which you can enter a combination of letters or digits
to search on (only alphanumeric characters).

If you then click OK, the first element from the list of names that contains the requested
combination is selected.

If the first match is not the one you are looking for, you can search on the same
combination by selecting the Find next in the Find section of the Data tab. You can
repeat this until you have found the correct person.

The advantage of searching in this way is that the text you enter does not need to be at
the start of an element in the Data Record View. The search does not make a distinction
between upper- and lowercase characters.

With this Find function, all elements in the Data Record View remain visible. Any
restrictions to the number of records that are displayed, which would normally apply as a
result of what you have entered in the text field, are overruled.

10.3.2 Using Keyboard

The find functions that have been discussed in the section Using Find are also available
from the keyboard. You can display the window Find by simultaneously pressing the 
control key and the letter f. You can repeat the search as often as is required to find the
correct person by pressing the F3 function key.

10.3.3 Changing Sort Order

To facilitate the selection of records, especially when making multiple selections in order
to start a print batch, the order in which the names in the Data Record View appear can
be changed. Choose Change sort order in the Find section of the Data tab to call the
following window.
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The text box at the top of the window shows the database columns on which the records
will be sorted. In this particular case, the list is sorted on the field FirstName and then on
the field Lastname. Up to three database columns can be selected to determine the sort
order. To change the sort order, press the Clear button to remove any previous settings
and then click the fields on which you want to sort, starting with the leading one.

10.3.4 Refresh Data

It is possible that you cannot find the intended record because it has only just been
entered into the database. The details of the record in question have already been
entered into the database, but CardExchange™ Producer has not yet, as it were, seen it.
You can solve this problem by selecting the Refresh data option in the Find section (or
by pressing the F5 function key). CardExchange™ Producer will retrieve the list of records
from the database again.

Doing this ensures that the most recent data for the record concerned is displayed.
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11 Using Photos

In this section of the help file you can find all the information of how to use photos with
CardExchange™ Producer.

11.1 Take Photos

When you have selected the correct card template and the correct record, you can add a
photo of the person to the database, or, if you want, replace the existing photo. This
function is accessible in the following ways.

· Click Take photo button as indicated with the red arrow,
· Press the F6 key.

After you have taken the photo, you will enter the Image Editor window of
CardExchange™ Producer, the ImageExchange®.
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Please see the Using Image Tools section of this Help file for more information about using
this ImageExchange® Image Editor.

If you click on the OK button, the photo will be automatically cropped and the Image
Editor will be closed. If a photo was already available in the database, CardExchange™
Producer asks whether you want to update it. If you click Cancel, the original photo will
be restored on the print preview. You can disable this option in the Photo tab by
unchecking the Use Image Tools check box.

11.2 Edit Photos

Photos that were taken earlier can be edited using Image Editor. This function is
accessible in the following ways.
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· Click Edit photo button as indicated with the red arrow,

After you have taken the photo, you will enter the Image Editor window of
CardExchange™ Producer, the ImageExchange®.

Please see the Using Image Tools section of this Help file for more information about using
this ImageExchange® Image Editor.

If you click on the OK button, the photo will be automatically cropped and the Image
Editor will be closed. If a photo was already available in the database, CardExchange™
Producer asks whether you want to update it. If you click Cancel, the original photo will
be restored on the print preview. You can disable this option in the Photo tab by
unchecking the Use Image Tools check box.
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11.3 Copy and Past

The Actions - Copy photo option allows you to copy the photo displayed on the Page
preview to the photo clipboard of CardExchange™ Producer. You can then choose another
record (or even another card that is linked to another database) and, by using the Paste
photo option, link the photo on the clipboard to the selected record.

This function can be handy if the same record must be entered under a different name or
personnel number in the database. You do not need to take a new photo. As long as you
do not copy another photo and do not shut down CardExchange™ Producer, the copied
photo will remain on the clipboard.

11.4 Import Photos

It is possible that you do not want to take a photo of someone because you already have
his/her photo. If this photo is in one of the usual formats (bitmap, jpeg, png, etc.), you
can use the Import photo function indicated with the red arrow to import it and display
it on the card that you have opened in CardExchange™ Producer. You can then save the
photo in the database.

If you click Import photo, you enter a dialog window that allows you to select the photo
file.
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If you have found and selected the file, click Open and the photo will be displayed in the
Image Editor window. Here you can crop the photo to the right size and perform any other
editing operations.

11.5 Export Photos

The opposite to import photo is also possible. You can export an existing photo from the
database to a file. To do this, click the Export photo button indicated with the red arrow
in the Actions section. Once more a dialog window will be displayed in which you can
specify the name and location of the file that must contain the photo.
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You can choose between two supported file formats: Bitmap, jpg, emf, gif, png, and
tiff.

Click on Save and the photo is exported to the selected location.

11.6 Remove Photos

Photos can be removed from the database by clicking the Remove photo button from
the Actions section indicated with the red arrow. The user will be asked to confirm the
remove operation with the following question.
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When you click Yes, the photo will be removed from the database.

11.7 Using Image Tools

CardExchange™ Producer offers for all editions an Image Editor tool, ImageExchange®.
The ImageExchange® tool offers some interesting functionality to help you upscale your
photos or images.

When you take a photo or capture a signature and the Use Image Tools option is
checked, this ImageExchange® tool will open. It also opens if you click on the Edit photo
button.
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ImageExchange® has functionality available via the File menu and the ribbon.

The File Menu

When you take a photo, capture a signature, etc., the image will be automatically be
show in the ImageExchange® tool. It is also possible to Load another image via the Load
function in the File menu.

When the image is edited and you click on OK, the image will be saved automatically. If
you want to store the image to another location just click on Save and select the
destination in the File Explorer and click on Save.

Exit just closes the ImageExchange® tool without saving and works as the Cancel
button.

Overview of the Ribbon
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When the image is loaded, you can apply some standard functionality to it. If the image
needs to be rotated, just click on the Left or Right buttons in the Rotation section.

You can also crop the loaded image when you have adjusted the size.

When you move the rectangle to required size, as indicated with the red arrows, and you
click on Crop, the image will be cropped according to the settings made.

When you click on the Black and white button, the whole image is converted to Black
and White and of course you can undo all your settings by clicking on the Undo button or
click on Reset to go back to the original loaded image.

Brightness and Contrast
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Move the sliders, indicated with the red arrows, to change the Brightness and/or
Contrast of the loaded image.

Click on OK to store the image or click on Cancel.
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12 Using Signatures

IMPORTANT! Signatures are supported starting from Premium and higher editions!

In this section of the help file you can find all the information of how to use signatures
with CardExchange™ Producer.

12.1 Capture Signatures

When you have selected the correct card template and the correct record, you can add a
signature of the person to the database, or, if you want, replace the existing signature.
This function is accessible in the following ways.

· Click Capture signature button as indicated with the red arrow,

After you have captured the signature , you will enter the Image Editor window of
CardExchange™ Producer, the ImageExchange®.
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Please see the Using Image Tools section of this Help file for more information about using
this ImageExchange® Image Editor.

If you click on the OK button, the signature will be automatically cropped and the Image
Editor will be closed. If a signature was already available in the database, CardExchange™
Producer asks whether you want to update it. If you click Cancel, the original signature
will be restored on the print preview. You can disable this option in the Signature tab by
unchecking the Use Image Tools check box.

12.2 Edit Signatures

Signatures that were captures earlier can be edited using Image Editor. This function is
accessible in the following ways.
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· Click Edit signatures button as indicated with the red arrow,

After you have captured the signatures, you will enter the Image Editor window of
CardExchange™ Producer, the ImageExchange®.

Please see the Using Image Tools section of this Help file for more information about using
this ImageExchange® Image Editor.

If you click on the OK button, the signature will be automatically cropped and the Image
Editor will be closed. If a signature was already available in the database, CardExchange™
Producer asks whether you want to update it. If you click Cancel, the original signature
will be restored on the print preview. You can disable this option in the Signature tab by
unchecking the Use Image Tools check box.
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12.3 Copy and Past

The Actions - Copy signature option allows you to copy the signature displayed on the
Page preview to the signature clipboard of CardExchange™ Producer. You can then
choose another record (or even another card that is linked to another database) and, by
using the Paste signature option, link the signature on the clipboard to the selected
record.

This function can be handy if the same record must be entered under a different name or
personnel number in the database. You do not need to capture a new signature. As long
as you do not copy another signature and do not shut down CardExchange™ Producer,
the copied signature will remain on the clipboard.

12.4 Import Signatures

It is possible that you do not want to capture a signature of someone because you
already have his/her signature. If this signature is in one of the usual formats (bitmap,
jpeg, png, etc.), you can use the Import signature function indicated with the red
arrow to import it and display it on the card that you have opened in CardExchange™
Producer. You can then save the signature in the database.

If you click Import signature, you enter a dialog window that allows you to select the
signature file.
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If you have found and selected the file, click Open and the signature will be displayed in
the Image Editor window. Here you can crop the signature to the right size and perform
any other editing operations.

12.5 Export Signatures

The opposite to import signature is also possible. You can export an existing signature
from the database to a file. To do this, click the Export signature button indicated with
the red arrow in the Actions section. Once more a dialog window will be displayed in
which you can specify the name and location of the file that must contain the signature.
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You can choose between two supported file formats: Bitmap, jpg, emf, gif, png, and
tiff.

Click on Save and the signature is exported to the selected location.

12.6 Remove Signatures

Signatures can be removed from the database by clicking the Remove signature button
from the Actions section indicated with the red arrow. The user will be asked to confirm
the remove operation with the following question.
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When you click Yes, the signature will be removed from the database.
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13 Using Biometric

With CardExchange™ Producer Ultimate edition you have access to using biometric
devices. You can do complete enrollments of biometric and we offer verify functionality to
make sure all your stored data is correct. In this section of the help file you can see how
this works.
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13.1 Biometric Setup

When a biometric device is connected to CardExchange™ Producer you have the
possibility to print the biometric image on the card or store it into the connected
database. You can also store the biometric template into the database. In this section we
will explain how to do this.

13.1.1 Printing the Image

When you want to print the scanned biometric image on your ID card you will have to add
an object to your Page design. Click on Card Setup in the Configuration tab in the Main
window to start the Designer.
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When the Designer is opened, select the Image object from the Home menu and drag and
drop and image box on the design page. When the Insert new object window appears,
select Biometric image from the drop down menu, as indicated with the red arrow, and
select the database column from the Database column selection drop down menu.

Click Close to add the object to the design, Save the template, and close the Designer.

13.1.2 Storing Biometric Data

Biometric data can also be stored into the database. You can store the image data and
the template. The template is based on ISO standard and can be used to create verify
processes, also supported by CardExchange™ Producer. You can find more information
about this in the Verify Biometric section of this Help file.

To store information in the database we need to create storage items. How to use
database and creating of storage items is explained in the Database section of this help
file.
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When you have opened the Designer and started the Database Connection wizard, you
navigate to the last page of the Database Connection wizard, the Storage Items.

First we add a storage item named "Biometric". Select the Biometric tab and select "Store
the cardholder's biometric image".
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If you also want to store the template, add a storage item named Biometric Template.
Select the Biometric tab and select "Store the cardholder's biometric template". The
template is an XML file so make sure that the database column type is big enough to store
a large text file.

When you are done you click on Finish to save all settings and close the Database
Connection wizard.
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13.2 Biometric Enrollment

To get your biometric information into the database or on your card design, you will have
to do the enrollment. The enrollment of biometric is on this moment fixed on four (4)
readings. If these readings match, you will be able to store the information.

To enroll a fingerprint select the record that you want to do the enrollment for and click
on the Enrollment biometric button in the Biometric tab of the main window, indicated
with the red arrow.

When you clicked on the button, the enrollment window appears requesting you, in this
example, to place your finger on the reader.
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When you have finished the full enrollment you can click on Save to store all the
information into the connected database and/or show as an image on the card.

13.3 Verify Biometric

CardExchange™ Producer does not only offer functionality to enroll your biometric but also
offers functionality to verify your enrollment.

To verify your enrollment click on the Verify biometric button and the window below will
appear:
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To verify the enrollment, in this example, the finger needs to be placed on the reader. The
moment that the finger is placed, the scan will verify this with the template information in
the database. When the enrollment is succeeded and verified, the photo of the person will
be shown, if applicable, in the window as shown below:

If the there is no match the window below will be shown:
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Please be aware that this functionality only works with the template of the scan, not with
the image only. You need to store the biometric template into the connected database.

13.4 Remove Biometric

Biometric data can be removed from the database by clicking the Remove biometric
button from the Actions section indicated with the red arrow. The user will be asked to
confirm the remove operation with the following question.

When you click Yes, the biometric data will be removed from the database.
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14 Using ID scanners

If you have an CardExchange™ Producer Ultimate edition you can use ID scanners. How to
use these scanners is explained in this section of this help file.
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14.1 ID Scanner Setup

When a ID scanner device is connected to CardExchange™ Producer you have the
possibility to print the scanned document information on the card or store it into the
connected database. In this section we will explain how to do this.

14.1.1 Printing Images

When you want to print the scanned document information your ID card you will need to
have the information stored into your database. 

Showing and printing data from the scanned document works the same as showing photos
or text from a database as explained in the Adding Card Templates section of this help file.

Click Close to add the object to the design, Save the template, and close the Designer.
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14.1.2 Storing ID Scanner Data

ID scanner data can also be stored into the database. You can store the image data like
photos and signatures but also the OCR data or address information, etc..

To store information in the database we need to create storage items. How to use
database and creating of storage items is explained in the Database section of this help
file.

When you have opened the Designer and started the Database Connection wizard, you
navigate to the last page of the Database Connection wizard, the Storage Items.
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First we add a storage item named "Photo". Select the ID Scan tab and select "Store the
cardholder's scanned photo".
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If you also want to store the OCR, add a storage item named ID OCR. Select the ID Scan
tab and select "Store the cardholder's scanned OCR". Via the drop down menu you can
select the data you want to store.

When you are done you click on Finish to save all settings and close the Database
Connection wizard.

14.2 Scan Document



CardExchange® Producer Help262

© 2016 CardExchange Solutions, Inc.

When everything is configured you can start scanning your documents. Click on the Scan
document button in the ID scan tab as indicated with the red arrow which will start the
scanner.

When the scanner interface is opened you need to select in the "Select State" group box
the region as ID documents differ per country. In the Document options group you select
what type of document you are scanning; Driver license or Passport.

In the menu at the top you can click on Scan to scan the document. When the document
is scanned you can rotate the image, and save and exit. The information will be stored
into the database and the information will be shown on the card, if configured.

14.3 Remove Document

Your scanned document data can be removed from the database by clicking the Remove
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document button from the Actions section indicated with the red arrow. The user will be
asked to confirm the remove operation with the following question.

When you click Yes, the document data will be removed from the database.
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15 Using Databases

Starting at the Premium edition, CardExchange™ Producer offers database connections.
Database connections and the stability of these connections has always been one the key
factors for developing connections.

Besides the variety of offered connections, all the major database connections are
created based on direct (native) connections. Therefore for all the major database
systems, we have their native connectors embedded. That will ensure 100% stable and
secure connections.

CardExchange™ Producer does not only offer these type of connections, it also offers
multiple database connections with true Push-Pull technology. Sometimes there is some
confusion about push and pull, but CardExchange™ Producer does not use internal
database structures to transport data from one database to the other database. That
ensures that with CardExchange™ Producer you never have to worry about the privacy of
the information because it this information stays were it should be... in your database!

The different type of database connections offered, are available per edition as shown
below:

Edition Supported Database Connections

Designer No Database Support
Go Internal MS Access Database
Premium MS Excel (all formats), CSV, and TXT files, MS Access (all formats),

Paradox
Professional MS Excel (all formats), CSV, and TXT files, MS Access (all formats),

Paradox, MS SQL, MySQL, Oracle, DB2, PostgreSQL, Ingris, ODBC, Multiple
Databases

Ultimate MS Excel (all formats), CSV, and TXT files, MS Access (all formats),
Paradox, MS SQL, MySQL, Oracle, DB2, PostgreSQL, Ingris, ODBC, Multiple
Databases

With CardExchange™ Producer your data is secured processed with 128 bit encrypted
connections.

15.1 Add Database

Adding a database connection starts in the Configuration Mode of your Edition. Select the
Data tab and in the Connection group you select New from the group to start the
Database Connection Wizard.
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In the sections "Using MS Excel", "Using MS SQL Server", and "Using Multiple Databases"
we will demonstrate how to configure a new database connection for the mentioned
database structures.

One of the most powerful functionality of the database connections are the Storage
Items. Storage Items allow you to store any type of data back into the connected
database. This can be Photos, Signatures, Print Dates, Print Counts, Environment
Variables, etc. Storage Items are supported for Premium Editions and Higher. In the
mentioned sections, we will use the Entry edition for demonstrating connecting to an MS
Excel file. This wizard is shorter then the wizard in the higher editions. 

15.1.1 Using MS Excel

Although it is not an database, MS Excel is one of the most used files to connect to ID
Badging software, and that also goes for CardExchange™ Producer. We will demonstrate
how to create a connection to an MS Excel file using the Entry edition of CardExchange™
Producer. With the Entry edition you create a database connection in four easy steps and
make the information available for presenting and printing.

Click New to start the Database Connection Wizard.
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When the wizard opens you click Add to start making the connection.

Step 1
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Enter a name for the database connection, select the correct database type, and select
the database file by typing the whole pad with extension into the Database text box or

click on the  button to browse to the file location. Click Next to proceed. It is
important to know that on the moment you click the Next button, the wizard will check
the connection with the file or database. If all is correct, the wizard will enter the second
page of the wizard. If a problem appears, and database error will be shown.

Step 2
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Select the check box 'Read data-items from this database', select the corresponding
sheet in the 'View name' drop menu, and select the 'Primary Key' from the drop down
menu. The Primary Key is the unique identifier of the record in your database. Click Next
to proceed.

Step 3
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In the Main Interface of CardExchange™ Producer you find the Data Record View showing
all the records available in the database in a so called data grid. In this page of the wizard
we connect the columns of the database to the data fields. The first field always needs to
be connected. All other fields are optional. If you connect the database column, left from
the drop down menu you see the check box selected. If the check box is checked, the
column will be shown in the Data Record View. Click Next to proceed with the last and
final step of this Database Connection Wizard.

Step 4
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In this page of the wizard you can set the rights to edit the connected database, or in
this case, the connected MS Excel file. Click on the check box 'Allow editing of the
database records' to enable this functionality. Separate from this selection you can set
that the user is allowed to add new records to the database and update existing records.
Deleting is deselected because deleting records in an MS Excel file is not supported. In the
Primary-key properties section you can select to enter the primary keys manually. If you
are not using numbers as primary keys, this check box needs to be selected but for each
new record, a unique primary key needs to be entered by the user. We advice to use
numbers and leave the check box as is by default, primary keys are generated by the
database. Normally real databases support this functionality itself, but because MS Excel
is not a database, we have embedded a unique number generator so your primary keys are
taken care of by CardExchange™ Producer. Now click on Finish
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and save your database connection to a location on your computer. We advice to store
your data in the Data Folder of CardExchange™ Producer.

Now in four simple steps you have created the connection to your MS Excel file and now
the columns are available in the Designer for adding to your design.
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15.1.2 Using MS SQL Server

For using MS SQL Server connections a Professional or higher edition is needed. In this
example we will demonstrate how to make a connection to the MS SQL Server database.
For most of the database servers available, the setup for connecting works the same.

Click New to start the Database Connection Wizard.

When the wizard opens you click Add to start making the connection.

Step 1
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Enter a name for the database connection, select the correct database type, enter the
name or IP address of the SQL Server. We advice to use the server name as
CardExchange™ Producer supports Load Balancing via TNS. If used in your organization,
you will always have access to your data if one of the servers goes down and the other
takes over. Using IP is more static and you need to know for sure that IP addresses are
not changing. Entering a port number with MS SQL Server is not needed. 
When you are using Oracle, a port number needs to be entered. Enter the name of the
database running on the MS SQL Server.

If MS SQL Server is set to use Windows Authorizations, you can leave the Login option
unchecked. If not, check this option and provide a user name and password so
CardExchange™ Producer can log in to the database server. All user name and password
information is encrypted with AES 128 bit technology.

IMPORTANT! If you are connecting to an Oracle Database Server make sure you have installed the
Oracle.NET provider as described in the Quick Install Manual!

Step 2
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Select the check box 'Read data-items from this database', select the corresponding
sheet in the 'View name' drop menu, and select the 'Primary Key' from the drop down
menu. The Primary Key is the unique identifier of the record in your database. Click Next
to proceed.

Step 3
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In the Main Interface of CardExchange™ Producer you find the Data Record View showing
all the records available in the database in a so called data grid. In this page of the wizard
we connect the columns of the database to the data fields. The first field always needs to
be connected. All other fields are optional. If you connect the database column, left from
the drop down menu you see the check box selected. If the check box is checked, the
column will be shown in the Data Record View. Click Next to proceed with the last and
final step of this Database Connection Wizard.

If you are connecting to a database with a huge amount of records and you want to
prevent loading all these records directly after the connection is made, check the 'Switch
on level-three filter' check box. This will prevent CardExchange™ Producer from loading all
the records and allows you to first create all needed filters for your configuration. For
more information about the Level Three Filters or any other filters, please see our "Using
Filters" section of this Help file.

Step 4
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In this page of the wizard you can set the rights to edit the connected database, or in
this case, the connected MS SQL Server. Please be aware that this setting does not
overrides the editing rights set by the DBA for record access.
Click on the check box 'Allow editing of the database records' to enable this
functionality. Separate from this selection you can set that the user is allowed to add new
records to the database, update existing records, and Delete records. In the Primary-key
properties section you can select to enter the primary keys manually. With real databases
like MS SQL Server, Primary Key fields are always available and we advice not to enter
keys manually. One not for Oracle users, when connecting to an Oracle Database Server,
Primary Keys are generated based on created sequences. When Oracle is connected,
select the correct Sequence from the drop down menu. If no Sequences are available,
please contact your DBA (Database Administrator). Click Next to Proceed.

Step 5
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Starting from CardExchange™ Producer Premium edition, we offer advanced data column
handling. With this functionality you can set per available column if it needs to be visible
or not visible in the Data Edit Window or visible and not editable. In the Editor selection
you can also define drop down menus. For more information about how to create drop
down menu's, please see the "Using Drop Down Menu's" section of this Help file.

When you are using a Professional or higher edition you also will have access to
functionality to set specific requirements per column like Column is required for printing,
Halt batch when the column does not contain any data, etc. Wanna know how to use the
requirements, please the "Using Data Requirements" section of this Help file. Click Next to
Proceed.

Step 6
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Starting from the Premium edition, CardExchange™ Producer offers Storage Items. Storage
Items offers you the possibility to store any type of information that is important for your
print process or production into your database. Print dates, Print counts, user information,
photo's, signatures, etc. Everything you need to know about configuring Storage Items
can be found in our "Using Storage Items" section of this Help file. Now Click Finish...
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and save your database connection to a location on your computer. We advice to store
your data in the Data Folder of CardExchange™ Producer.

In six steps you have created the connection to your MS SQL Server and made the
columns available for adding them to your design.
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15.1.3 Using Multiple Databases

For using Multiple Database connections a Professional or higher edition is needed. In this
example we will extend the example we created with the SQL Server with a connection to
an MS Excel file that is going to be used to report the amount of prints made for a record
too. First we need to create an MS Excel file that is going to contain this information. As
an example, below you can find a screen shot from an MS Excel created for this example.
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The first row is used for the columns and the following columns are created:

Column
Name

Description

ID Will be the unique field (Primary Key) for this connection
ID_Student This will contain the unique ID (Primary Key) field from the Student Table
Printed Name This field will contain the name of the student printed
Operator This field will contain the name of the operator logged into CardExchange™

Producer
Data Printed This field will contain the date the record is printed
Time Printed This field will contain the time the record is printed
Print Count This field will contain the amount of times the record is printed

The standard sheet name is renamed to "Print Records" and the other two sheets are
removed. Of course this is not needed, but makes it more clear what you are doing.

When done, save the created MS Excel file to a location, preferably in the Data folder of
CardExchange™ Producer. Now we proceed with 

Click Edit to start the Database Connection Wizard and open the connection made for MS
SQL Server.
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Step 1
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Now click on Add to create an extra connection. Enter the Name field information select
the correct database type, etc. It is basically the same setup as with the Using MS Excel
example. Select the MS Excel sheet you have created for Print Reports and click Next to
proceed.

Step 2
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In this page you now see two database that can be selected. What is important to know
is that you always read from ONE database only. All other connected databases are for
writing only. So in this situation, make sure the 'Read data-items from this database' is
unchecked and leave the Students database checked. This also shows why it is important
when using multiple database connections, the naming chosen for the connections is
important to be clear. Click Next to proceed.

Step 3
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The page where the name information is set does not change and stays the same as in
the Using MS SQL Server example. Click next to proceed.

Step 4
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Also this does not change and stays the same as in the Using MS SQL Server example.
Click next to proceed.

Step 5
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Also this page does not change. Although you can see that the new created database is
available, we are only writing back to it so we cannot define any settings for the specific
columns. Click Next to Proceed.

Step 6
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In the Storage Items section you now see the new database connection and you can
start adding the items to the connected database. All the information about configuring
the Storage Items can be found in our "Using Storage Items" section of this Help file. Now
Click Finish...
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and save your database connection to a location on your computer. We advice to store
your data in the Data Folder of CardExchange™ Producer.

In six steps you have created the extra connection and when configured correctly, every
time you print, a record will be added to the MS Excel file connected.
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15.1.4 Data-source Plug-in's

To use data-source plug-in's you must have CardExchange™ Producer Ultimate and you

need an additional license for each specific plug-in, once you have this license you can

activate it by following the steps under Upgrade Your License.

Below are the current available Data-source Plug-in's.

LDAPExchange

LDAPExchange allows for using LDAP (Active Directory) as a live data source for

CardExchange™ Producer.

Via LDAPExchange it is possible to view and edit LDAP entries in CardExchange™ Producer,

you can also update these entries at print time with data from other sources.

Note: It is not possible to add or delete entries from LDAP via CardExchange™ Producer, also photos/

images are not supported and would need to be loaded from a folder location.

Net2Exchange
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Net2Exchange is a special database connector that allows for using an existing Paxton

Access Net2 installation as a live data source for CardExchange™ Producer. 

Via Net2Exchange, it is possible to view and edit Net2 user data in CardExchange™

Producer, view and manage each user’s cards and create a new card record in Net2

whenever a card is printed with CardExchange™ Producer.

Note: It is not possible to add or delete entries from Net2 via CardExchange™ Producer.

15.1.4.1 LDAPExchange

LDAPExchange requires one DLL file: LDAPExchange.dll. This file, a product of 

CardExchange™ Solutions, is the data-source plug-in that needs to be called from

CardExchange™ Producer. This DLL file is included in the installer of CardExchange™

Producer and is found in the CardExchange™ Producer installation folder, which is C:

\Program Files (x86)\CardExchange Solutions\CardExchange Producer by default.

1. Start Notepad with administrator rights and open the file LDAPExchange.ini which is

located in the CardExchange installation folder.

2. Specify the desired root node and the attributes (fields) that you want to load from

the LDAP. 

The filter is set to users by default, but can be changed to other object types if

desired. Leave the root-table name as is. 

Leave the path-column name as is unless the name “path” also appears in your

attribute list, in which case you should choose a unique name.

The path column will contain the full distinguished name of the LDAP entries and

can serve as primary key.

3. Start CardExchange and create a new card or modify an existing one.

4. In the database setup, choose Data-source plug-in as database type, enter none for

the server and the port (these fields are not used) and select the LDAPExchange.dll

in the installation folder as database.

5. Check the Login option and supply the correct login details (This may not be

needed for a domain user)

6. On the second page, select the People table and choose a primary key. If none of

the attributes specified in LDAPExchange.ini can serve as primary key, you can use

the path column. This is a long text column and hence not very efficient as primary

key, but it works if needed.

7. On the fourth page, if you allow editing at all, disable the options to add and delete

records, as this is not supported by LDAPExchange.



CardExchange® Producer Help292

© 2016 CardExchange Solutions, Inc.

8. On the storage items page, you can create storage items, but again, it will only be

possible to update existing records of the LDAP and not inserting new records.

Currently support for reading/writing photo fields is not supported, this would have to be

done by loading them from a file.

15.1.4.2 Net2Exchange

Net2Exchange requires two DLLs: Net2Exchange.dll and Paxton.Net2.OEMClientLibrary.dll.

The first, a product of CardExchange™ Solutions, is the data-source plug-in that needs to

be called from CardExchange™ Producer. The second is the Paxton Access Net2 SDK, which

forms the interface between Net2 and Net2Exchange. Both DLLs are included in the

installer of CardExchange™ Producer and are found in the CardExchange™ Producer

installation folder, which is C:\Program Files (x86)\CardExchange Solutions\CardExchange

Producer by default.

If CardExchange runs on a different computer than the one where Net2 is installed, it is

necessary to install the Net2 runtime, which is distributed by Paxton Access as part of the

Net2 SDK.

Configuration

Net2Exchange is both a data-source plug-in and an external plug-in. The data-source plug-

in part manages the reading and writing of user data and the creation of new card records

upon printing. The external plug-in part makes it possible to view and manage the user’s

card records. Both need to be configured separately.

Creating a new card

1. Start CardExchange and click Configuration – New card.

2. Provide a template name and optionally a category.

3. Click Next to go to the second wizard page.

4. Select I want help to make my card by using this wizard and click Next.

5. Specify whether the card is double sided, set its orientation and click Next.

6. Select Please connect my new card to my own database.
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7. Click (add a new database…) to open the database-connection wizard.

Creating a database connection

8. Click Add to add a new connection.

9. Set the connection’s name to Net2Exchange.

10. Set the database type to Data-source plug-in.

11. Type the name or IP address of Net2 server. Use localhost if Net2 is installed locally.

12. Set the port used by the Net2 server. Normally, you should type 8025 as port.

13. Click on the browse button to select a database, navigate to the CardExchange

installation folder and select the Net2Exchange.dll.

14. Enable Login with user name and password and supply the correct login

information.

15. Click Next to go the second wizard page.

16. Enable Read data-items from this database.

17. Choose Users as view name and UserId as primary key.

18. Click Next to go the third wizard page.

19. Choose Net2Exchange as database, Surname, FirstName, MiddleName and

UserId as record look-up fields.

20. Click Next to go the fourth wizard page.

21. Select Allow editing database records and allow both adding, updating and

deleting.

22. Select Primary keys generated by the database.

23. Click Next to go the fifth wizard page.

24. Unselect the option Visible for the following database columns: AccessLevel,

Department, UserGuid and UserImage.

25. Unselect the option Editable for the following database columns: Global,
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LastAccessTime, LastArea, LastAreaId and LastUpdated.

26. Select Drop-down menu with lookup table for the column AccessLevelId with

AccessLevels as table name, Key as storage value and Value as display value.

27. Select Drop-down menu with lookup table for the column DepartmentId with

Departments as table name, Key as storage value and Value as display value.

28. Click Next to go the last wizard page.

29. Click Add to create a new storage item and call it Photo.

30. Set the table name to Users, the primary key to UserId and the column name to

UserImage.

31. Click the Photos/Signatures tab and select Store the cardholder’s photo.

32. Click Add to create a new storage item and call it CardTypeId.

33. Set the table name to Cards, the primary key to CardNo and the column name to

CardType.

34. Click Add to create a new storage item and call it UserId.

35. Set the table name to Cards, the primary key to CardNo and the column name to

UserId.

36. Click Advanced options… and select Supply value for primary key and Always

insert (uniqueness primary key not guaranteed).

37. Click OK to close the storage-item properties and Finish to close the database-

connection wizard.

Creating a new card (continued)

38. Click Next to go to the next wizard page.

39. Choose a background image or color and a logo and click Next.

40. Select Use a combined name field on my new card with  FirstName UserImage

(Net2Exchange) as first name and Surname UserImage (Net2Exchange) as last

name.

41. Select Use a photo on my new card with UserImage (Net2Exchange) as
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associated database column.

42. Click Next.

43. Choose the database columns you want to show on the card layout and click Next.

44. Configure a bar code if desired and click Next.

45. Leave the option After Finish, start the Designer for modifying the layout…

selected and click Finish to open the designer.

Mapping the storage items

46. In the designer, open the Properties window and go to the Manual entries tab.

47. Click Add manual entry, call it Card-type ID and set its value to 1 (or another value

of choice).

48. Select the Data tab on the left hand side and Storage items on the bottom of the

tab.

49. Select CardTypeId in the Data tab and select the Content tab in the Properties

window.

50. Map the storage item CardTypeId to the manual entry Card-type ID.

51. Select UserId in the Data tab and map it to the database column UserId.

52. Select Storage-item keys on the bottom of the Data tab.

53. Select Cards in the Data tab.

54. Choose the desired mapping in the Content tab of the Properties window. The

mapping will determine the card numbers created in Net2. It is possible use a

manual entry, or a global counter to generate successive card numbers. It is also

possible to use the chip-serial number as card number, in which case the storage-

item key of the Cards table needs to be mapped as chip-serial number.

55. Finish the graphical card design according to your wishes. Them save and close the

card template.

Configuring the external plug-in

56. Back in the main window, click Configuration – Advanced options.
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57. Select Show advanced mappings and click OK.

58. Click Configuration – Card-definition wizard to open the card-definition wizard.

59. Select Do you want to use external functions or plug-ins? and click Edit.

60. Click Add to add a new plug-in definition and call it Cards.

61. Click on the browse button to select the Net2Exchange.dll file.

62. Unselect Call when printing and select Call using a button.

63. Click Finish to close the external-functions wizard.

64. Click Next to go to the mappings window.

65. Select Cards.UserId (no mapping) in the External-function input tab.

66. Select Database column in the type-of-data drop-down menu.

67. Select the database column UserId (Net2Exchange) and click Finish.

Usage

Back in the main CardExchange window, you should see the Net2 users listed in the name

list. If you open database-edit window, you can view and edit the user details, using drop-

down menus for the access level and the department.

When you click on the Cards button on the right-hand side, you enter a dialog that lists the

card records for the current user, showing the card number, the card type and the lost-card

flag respectively. In this window, you can change the card type, mark a card as lost and

delete cards from the database.

As soon as you print a card for a specific user, CardExchange will create a new card record

in Net2 for that user, setting the new card number to whatever you have mapped for the

storage-item key in the designer.

If the card number needs to be shown on the card, as text or in a bar code, you have to

make sure that the corresponding text object or bar code is mapped the same way as the

storage-item key.



Using Databases 297

© 2016 CardExchange Solutions, Inc.

15.2 Storage Items

If you want to store data into the connected databases (with the database module) or
database, you need to define Storage Items. Storage Items contains the information of
the column name in which you want to save your information like photos or print dates.
This Storage Items will be presented in the Storage Items section of the Data tab in the
Explorer Menu of the Designer and where they will be connect to the right Object Type.
See Objects and Standard Object Types sections of this Help file for more information.

For each connected database you can define storage items. Just click on the database
name on the left site to select and click on Add to define a storage item. You can add
unlimited storage item for each connected database.

Storage Items are supported starting from Premium and Higher Editions and are
configured in the last page of the Database Connection Wizard. For more information
about the Database Connection Wizard and examples of how to make Database
connections, please see the Databases section of this Help file. In this section we will
explain all the available functionality of the Storage Items section of the wizard.

The Storage Items section of the wizard is divided into three different sections which are
the Available Storage Items section on the left side showing all the available databases
and their created storage items, The Storage Items Properties group, and the Value
Properties group.

The Storage Item Properties
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This section, indicated with the red rectangle, shows four important properties:

Storage Item
Property

Description

Item name Enter a name for the storage item like Photo, Print Date, etc.
Table Name Select the table from the database where you are storing the data
Primary Key Select the Primary Key from the selected database
Column Name Select the column name from the selected table

CardExchange™ Producer not only offers storing data into multiple connected databases,
you can also store data in multiple tables. That makes this section so powerful. For
example, you are connected to a database containing a view that combines two tables,
for example Student and Student Photo, with a so called LEFT INNER JOIN connection.
A LEFT INNER JOIN view shows all the records of the Student table with the photos of
the Student Photo table. Even if there is no photo for the Student available in the
Student Photo table, the Student record will be shown.

Everybody knows that you cannot store data into the database via an LEFT INNER JOIN
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view because updating one record will update all records and therefore, in most of the
competitive applications you simply cannot store information back into the database when
connecting to a view like this.

With CardExchange™ Producer you select directly the Table, Primary Key, and Column
Name. In this example we would select the Table 'Student Photo', the Primary Key
'StudentID', and the Column 'StudentPhoto'. Now when we store the photo, it will be
stored directly into the correct column out passing the connected view.

The Value Properties

This section, indicated with the red rectangle, shows three properties. You can Supply
for a new value for the selected column which means that the data will always be
added to the table and will not only update the record. You can Use the column for
specials (like photos) so CardExchange™ Producer knows that he will handle images in
stead of normal columns. 

This is a very important setting because Storage Items are normally processed on the
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moment that the card is produced. Of course, when taking photos or capturing
signatures, you would prefer to store the image directly and not at the end of the print
process. When selecting this option, the Storage Item will be processed immediately.

You can also set the option Use selected column as counter. This will increase the
column every time you print a record.

Besides these properties you can also set some advanced properties for the Primary key
and Insert/update commands. Clicking on Advanced options will open the window below.

In the Advanced Storage Item Properties window you find three different groups that
you can set. First group is the Primary Key Properties group. By default the system
uses the Primary Key of the selected record for storing into the database. But it is also
possible to supply the value for the Primary Key.

In the Insert/Update Properties group by default the row is always updated when the
Primary Key exist. It will insert if not. You can also select to Always insert. That can be
handy if, for example, the amount of prints needs to be reported with date and time. Be
aware that the uniqueness of the Primary Key will not be guaranteed anymore.

In the last group you can set the Error behavior of the Storage Item. By default, the
Storage item will not be processed but you also select one of the other options like
process as usual, store a predefined value, or store the error message. Of course,
in case of the last two choices it is important to make sure the database column can hold
this type of content. Click on OK to return to the Wizard Page.
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When you have created all your Storage Items, the Wizard page should like something as
shown below:

When you click on Finish, you will return to the Designer interface.
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In the Designer Interface you click on the Data tab of the Explorer Menu and now you see
the Storage Item tab, indicated with the red arrow. Click on this tab and all the created
Storage Items will be shown as indicated in the area with the red rectangle. The bold
name indicates the connected database and the indent are the created storage items.

Now make sure that you have the Properties window open and make sure the Content tab
is selected. Select one of the Storage Items, in this example we selected the Photo item
from the Students database.
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When the Photo Storage Item is selected, you see that you have a new group in the
Content tab which is the Storage-item type. This group offers three selections;

· Standard (supply value)
· Photo
· Signature

Standard (supply value)
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The Standard option offers you to connect to any object available and works exactly the
same as explained in the section Standard Object Types of this Help file. For example we
want to store the print date into the database so we select Date Printed form the Storage
Item selection we created.

 

We select Standard in the Storage-item type group and select Print date from the
Standard Object Type drop down menu. We set the Format option to Date/time and
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enter the 'd' to make sure we store the short date only and not the time and you are
good to go!

Photo

The Photo option is specifically designed to make your life easier. When you want to store
the Photo into the database, just select the Photo Storage Item and select Photo from
the Storage-Item type group.
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CardExchange™ Producer automatically takes care of everything needed for storing the 
photo.

Signature

The Signature works exactly the same as the Photo option. Just select it and
CardExchange™ Producer takes care of all.

15.3 Drop Down Menu's

CardExchange™ Producer offers great functionality to add drop down menus to your Data
Edit Window. Using drop down menus limits the user error while entering new or updating
existing data.

Drop down menus are supported starting from Premium and higher editions and in this
section we will explain how to configure these drop down menus.

The creation of drop down menus is a part of the Database Connection Wizard.
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When adding a database and using a Premium or higher edition, on the fifth page of the
wizard, where you specify the data column settings, you see a tab called Editor selection.
The Requirements tab is only available starting from Professional and higher editions and is
described in the Data Requirements section of this Help file.

The Editor selection contains two different ways to create drop down menus. The first
option is creating a menu based on fixed values indicated with a red rectangle. The
second option is creating a drop down menu using a look-up table from the connected
database as indicated with a green rectangle.

Creating Drop Down Menus with Fixed Values
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To create a drop down menu with fixed values, you first select the column from Columns
Explorer on the left side as indicated with the red arrow and select the Drop-down
menu with fixed value option from the Editor selection tab. The text box becomes
available and you can simply add items for the drop down menu by entering them as text
as shown in the screenshot above.

It is also possible to import a CSV file containing the items for the drop down menu. To do
so, click on the Import button and browse to the file.
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And click on Open to select the file for Import.
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When the file is imported, the information of the file is shown in the text box indicated
with the red rectangle. If the file contains a header, make sure the Skip first line is
selected to make sure that it is not going to be a part of the drop down menu items, and
select the Delimiter used for the the file, in this case a comma, as indicated with the
red arrow.

Creating Drop Down Menus with Look Up Table
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To create a drop down menu using a Look Up Table, you first select the column from
Columns Explorer on the left side as indicated with the green arrow and select the
Drop-down menu with lookup table option from the Editor selection tab. Now you see
that three drop down menus become available. From the drop down menu of the Table
name field you select the table that is containing the Look Up data. In this example we
are using a table named tblCardProfile, which is shown below:
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In the table content we see a CardProfileID and a Description. We would like to store
the CardProfileID into the database when inserting and/or updating so we select from
the Storage value drop down menu, CardProfileID. Because a number does not make
any sense for a operator of the system, we would like to present the information from the 
Description column to the operator, therefore we select Description from the Display
value drop down menu.
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15.4 Data Requirements

When producing your cards, you want to make sure that all the data that is needed is
entered and entered correctly to eliminate cards being wasted. CardExchange™ Producer
Professional edition and higher offers great functionality to set specific requirements for
the available columns from the connected database. In this section we will explain how to
define the requirements for your connected database.

When using a Professional or higher edition, the Data Requirement option is a section
available in the Database Connection Wizard.
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When adding a database and using a Professional or higher edition, on the fifth page of
the wizard, where you specify the data column settings, you see a tab called 
Requirements. The Editor selection tab is available starting from Premium and higher
editions and is explained in the Drop Down Menu's section of this Help file.

When selecting the Requirements tab you find three check boxes that can be selected.

These section effects the handling of the data creates the  indicator right from the text
box in the Data Edit Window of the Main Interface of CardExchange™ Producer.

Selection 1 - Required column for inserting/updating record

When selected, the user will have to enter or select a value before the record can be
updated to the database.

Selection 2 - Required column for taking a photo

Because photo fields are not visible in the Data Edit Window but only in the card preview,



Using Databases 315

© 2016 CardExchange Solutions, Inc.

this check box needs to be set to make sure that the operator is informed that a photo
needs to be added before updating or inserting.

Selection 3 - Required column for capturing a signature

Just like the photo fields, signature fields are not visible in the Data Edit Window, this
check box needs to be set to make sure that the operator is informed that a signature
needs to be captured before updating or inserting.

Required column for printing record

Besides the requirements for the data, these requirements do not always reflect the needs
for print the record. It can be that a record is needed for showing in the Data Edit Window
but because the field is not used on the card, it has not to effect the card production. In
this group you can define the specific printing requirements for the selected column. First
of all you can select the option Column is not required for printing. When this option is
selected the card will be produced even if the column does not contain data or the
requirement is set to Required for inserting/updating.

Second option is to Skip the record when column is null or empty. When this
requirement is selected, the record will not be printed and the system will continue
printing the next record.

And the third option is to Halt batch when column is null or empty. When this option is
checked and the column does not contain any data, the system will just stop the whole
batch production.

Prompt for value before printing

Last but not least, it is also possible not to stop the whole batch production process but
prompt for a value.
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When the checked, every time the batch hits a record that has not all values needed for
printing, it will prompt a dialog where the operator can select or enter the information
needed for producing the card.
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When the values are selected or entered and the operator clicks on OK, the selected or
entered values will be stored into the database and the card will be produced.
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16 Authorizations

User roles and Authorizations are created and setup for a reason, and that reason is
security. From the Premium edition of CardExchange™ Producer, we offer advanced user
authorizations with login functionality. 

Because of the fact that CardExchange™ Producer is capable of handling multiple high
level functions, such as advanced inline encoding, we need to consider that in a lot of
cases we are working with information that is programmed into cards that may not be
available for users of the CardExchange™ Producer system. This can also be true for
security issues related to database connections. CardExchange™ Producer can be
connected to applications such as Access Control, Payment, Time Attendance, etc. In
most of these cases, the application provider has set strict rules regarding access to
information that can be viewed and used within the CardExchange™ Producer application.
To meet the demand for more efficient management of CardExchange™ Producer,
ExchangeIt has introduced a strict policy regarding the security of the CardExchange™
Producer application.

In order to create more control for the Administrators of CardExchange™ Producer, we
offer the ability to create user authorization levels. This helps limit user infractions and
protect areas within CardExchange™ Producer that the common user should not be
utilizing. This high level security allows you to protect the software connections and
functionality from user errors.

During the installation of CardExchange™ Producer, CardExchange™ Producer creates a
special file that contains all the security information called the UserAuth.dat file. This file
is located in the Data folder of CardExchange™ Producer. Every time CardExchange™
Producer will be started, a backup is created automatically to AppData folder and
contains the settings when closing CardExchange™ Producer the last time.

When the UserAuth.dat file is missing, CardExchange™ Producer will start up in locked
mode. Why can cause CardExchange™ Producer to be locked?

There can be several reasons for having this situation, but the most important one is
fraud. If somebody tries to get access to information that he or she is not allowed to see
or access and delete the UserAuth.dat file on purpose, the system will automatically
generate a response by locking itself.

In the event you have a locked CardExchange™ Producer license you will have to send
the Identification Code to CardExchange@ExchangeIt24.com. As soon as we receive this
code, we will generate the Unlock Code that can be entered into the User authorizations
file unlock window and send it back to the corresponding email address.

When the unlock code is entered and valid, CardExchange™ Producer will start again and
the user authorizations can be created again by the user and/or the supplier that has
setup the CardExchange™ Producer edition.

We will now continue with explaining the setup and use of the User Authorizations within
CardExchange™ Producer.

mailto:CardExchange@ExchangeIt24.com
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Setting up User Authorizations does not make any sense if you are not using a login
mechanism therefore first select the Enable logins feature as indicated with the red
arrow. When selecting a dialog will prompt for confirmation:

When you confirm this feature, the Account setup button will become available as
indicated with the blue arrow. When you click on Account setup, the User Account
Setup Wizard will start.
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In the section Create User Authorization we will explain how to create the user groups,
profiles, and users. To disable the User Authorizations, uncheck the Enable logins
feature check box, a dialog will pop up:

And select Yes to disable the functionality.
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16.1 Create User Authorizations

Creating User Authorizations starts with creating and/or managing groups. In this first
page of the wizard you find two important areas; The Group information group, indicated
with the red rectangle, and the Authorizations general settings, indicated with the
blue rectangle. The explorer on the left side shows all the available and created groups.

Important! There are always two groups available; the Admin and the User group. Non of these groups
can be removed.

With the Authorizations general settings group you can indicate when the passwords
need to expire. For example, putting in 30 means that after 30 days all users, when they
login, are requested to change their password. When leaving it to 0, passwords will
not expire.

In the Group information section you see the Group name and the Group description. It
also contains the Add and Remove button. To Add a new group, click on the Add button.
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When you have entered Group name, make sure you chose logical names, and entered a
Group description, the new created group will appear in the explorer on the left side as
indicated with the blue arrow.

In this example we have created groups for card production, data entry, and photo
production. There are no limitations on the amount of groups you can create.

If you want to delete a created group, just select the group in the explorer on the left
side and click on remove. Confirm with Yes to delete! Deleting a group does not delete
your users! 

When you are done adding groups you can proceed to the next level of the wizard by
clicking Next.

User Management
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In this page of the wizard you can create new or edit existing users of the system. On the
explorer on the left side you can find all the available users, on the right side you can find
all the user information.

When you click on Add, to create a new user, you will need to provide a User name,
this is the name used to login to CardExchange™ Producer, enter a Full name of the
user, and enter a Password and Confirm the password.

Just like in the Group Management page of the wizard, we also have two special users;
Administrator and Guest. The Guest account can be removed but the Administrator
account cannot! What you can change is the password of the Administrator and we
advice to do so but keep in mind changing the password means that you need to
remember the password. There is no option to retrieve or reset the Administrator
password... yet.

The default user name for the Administrator account is Administrator and the
Password is Administrator too! For the Guest the password and user name are both
Guest. Passwords are case sensitive! 
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Important! The Administrator has always access to all defined groups and users!

In the area indicated with the red rectangle, you find two special options. If you want the
user to generate their own password, just check the box User must change the
password at next login. This can be handy if you have a lot of different users to create
but you do not want to send out all these different passwords. When you select this
option, you can simply use a standard password which first needs to be changed before
the user can login to the system. If you have, like in this example, a group account it is
better not to use.

Disabling the user is also a handy option. By checking this box, the user cannot login to
the system anymore but is not removed from the system. If later the user needs to get
access to the system again, simply uncheck the User is disabled box and access is
granted again. 
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In the section indicated with the blue rectangle you can specify per user to which group it
will be assigned. Each user can be assigned to one of multiple groups. In this example, it
makes sense that the Production user is assigned to the Card Production group but you
can imagine that a some users need to have access to multiple groups.

When you have created or edited all your users of the system and assigned them to the
correct groups, you can proceed with the Authorizations management on the next and
final page by clicking Next.

Authorizations management
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In this last page of the wizard can assign and create the profiles per defined group or
specific, per user. In the explorer on the left side you can see all the created groups. If
you click on the expand sign  you can see the assigned user of the group.

On the right side, indicated with the blue arrow, you see nine separate tabs dividing the
available CardExchange™ Producer functionality. When you click on each available tab,
the corresponding functionality will be shown. For example, in the select tab, Card
templates, all on the system available templates are shown. Each tab and each
functionality has an colored indicator. There are basically three options

 No access to functionality

This means that the functionality is not available in the interface. It is not greyed out, it
is totally removed.

 Access to functionality

This means that the functionality is available for the user of the system.
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 Administrator or selected users and groups only

This means that all the functionality or selections of the functionality is only available for
the Administrator.

For example:

For the group Card Production there is no need to do anything with the Photo
functionality, Signatures, Configuration, etc. within CardExchange™ Producer. By clicking
on the  you can completely change the group to no access, even though the specif
functionality in the group is indicated with .
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When the functionality is indicated with , only the Administrator will be able to see the
functionality. Besides creating the policies for the groups, each separate user can have
some different rights besides the group profile. Simple select the user name from the
explorer on the left and set the correct authorizations for this user.

When you have defined all the groups, users, and assigned to the functionality allowed for
this group and/or user, you can click on Finish to store your account definitions and close
this wizard.
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16.2 Users Login Access

When User Authorizations is enabled, every time CardExchange™ Producer starts, the user
have to login. If it is a new account, it can be that the Administrator has set the option
to change the password at first login. When that is the case, the the standard login
window will appear as show below:

When the user enters his User name and password, and the Administrator has set the
option to change the password at first login, the message as shown below will appear:

To confirm this action you have to click OK and the Change Password window will appear:

Enter a new password and confirm the new password and click on OK. If the User name
and Password match, CardExchange™ Producer will load.
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When CardExchange™ Producer is loaded, you can directly see that things have changed.
First of all, the ribbon has only the Print and Service center tab available as indicated with
the red arrow. Also the filter section is removed.
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When you are an Administrator and you need to do some maintenance on the users
computer, just simple select Log off as indicated with the red arrow and enter your
Administrator User name and Password to make changes.
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17 Contactless Encoding

A contactless smart card is any pocket-sized card with embedded integrated circuits that

can process and store data, and communicate with a terminal via radio waves. There are

two broad categories of contactless smart cards. Memory cards contain non-volatile

memory storage components, and perhaps some specific security logic. Contactless smart

cards do not contain an ordinary read-only RFID, but they do contain a re-writeable

smart card microchip that can be transcribed via radio waves.

A contactless smart card is a card in which the chip communicates with the card reader

through an induction technology similar to that of an RFID (at data rates of 106 to 848

kbit/s). These cards require only close proximity to an antenna to complete a transaction.

They are often used when transactions must be processed quickly or hands-free, such as

on mass transit systems, where a smart card can be used without even removing it from a

wallet.

The standard for contactless smart card communications is ISO/IEC 14443. It defines

two types of contactless cards ("A" and "B") and allows for communications at distances

up to 10 cm.

A related contactless technology is RFID (radio frequency identification). In certain

cases, it can be used for applications similar to those of contactless smart cards, such as

for electronic toll collection. RFID devices usually do not include writeable memory or micro

controller processing capability as contactless smart cards often do.

There are dual-interface cards that implement contactless and contact interfaces on a

single card with some shared storage and processing. An example is Porto's multi-

application transport card, called Andante, that uses a chip in contact and contactless

(ISO/IEC 14443 type B) mode.

Like smart cards with contacts, contactless cards do not have a battery. Instead, they

use a built-in inductor, using the principle of resonant inductive coupling, to capture some

of the incident electromagnetic signal, rectify it, and use it to power the card's

electronics.

CardExchange™ Producer Ultimate supports inline encoding and reading for three different

type of contactless technologies;

· MIFARE® DESFire, 

· MIFARE® Classic,

· and reading of HID® Proximity cards.

In this section of the Help file we will explain how to use these technologies with

CardExchange™ Producer. It is however important to have at least basic knowledge of

these technologies used by CardExchange™ Producer.

Please visit http://www.nxp.com for more information about MIFARE® technology.

http://www.nxp.com
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17.1 MIFARE® Classic

CardExchange™ Producer supports inline encoding and reading of MIFARE® Classic 1K

and 4K cards. What information should be read or written can be configured by means of

the MIFARE® Wizard, which will be the subject of this chapter. For a full understanding

of the MIFARE® Wizard, it is essential to have knowledge about the functionality of the

MIFARE® Classic chip. Please, refer to the MIFARE® Classic documentation published by

NXP for more information

Please visit http://www.nxp.com for more information.

It is possible that the MIFARE® Wizard does not offer all functionality you need to

achieve your goals. For example, you might need functionality of the Classic protocol that

is not configurable via the wizard, or special transformations of the database data before

they can be written to the chip. For this type of situations, we can offer a solution by

means of an External Plug In. Please, contact sales for more information about External

Plug Ins.

17.1.1 Creating Classic Encoding

To encode MIFARE® Classic encoding we have to set the system up for this. Encoding is

setup via the Designer so click on Card Setup to start the Designer.

http://www.nxp.com
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Select the MIFARE® tab as indicated with the red arrow.

Click on New, as indicated with the red arrow to start the MIFARE® Classic Setup Wizard

and follow the steps as described in the sub sections of this topic.

It is possible to select an existing Classic setup by clicking on the Select button. It is

important to notice that, compared to using DESFire, for Classic you will need to create

separate setups for reading and/or writing to the Classic chip. Read definitions are

mostly only created if the CSN (Chip Serial Number) of the Classic card needs to read and

stored into the database or printed on the card. In this section of the Help file we will

explain how to create a definition for writing to a Classic chip.

17.1.1.1 Step 1: Selecting Memory Size

When we have entered a name for the definition into the text box and we click on 
Create, a dialog box 'Create New Mifare Definition' will be shown asking to make a
choice for the type of MIFARE® Classic chip.
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You can select to create a definition for a MIFARE® 1K or 4K card. As you can see, you
can also select HID Proximity. This is because we also use the same wizard for defining
HID® Proximity encoding. See our HID® Proximity section of this Help file for more
information.

The most common used MIFARE® Classic chip is the 1K card, which we will use. The 4K
chip basically works the same with exception of the size of the sectors starting from
sector 16 and up, and it has two MAD sections.

In this case we select MIFARE® 1K and click Yes to confirm and proceed with Step 2.
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17.1.1.2 Step 2: Define General Settings

The General settings group box allows choosing the reader type, the serial port to
which the reader is connected and the baud rate to be used. CardExchange™ Producer
supports a lot of readers for encoding MIFARE® Classic. Currently we support DigiOn24,
GemEasyLink 680, ACG, Zebra MIFARE®, Pro-Active, PPC/El-Tech, and PC/SC 1
and 2 readers like OmniKey and CrazyWriter.

PC/SC readers are only available when installed on your system. If the reader is not
available, please make sure it is installed properly. You can click on the Refresh button to
reload the list with available readers.   You are able to test if the connected reader is
working and responding correctly. Click on the Test button to open the MIFARE® Reader
Test window.
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When pressing the Test button, CardExchange™ Producer will try to connect with the
reader and, if a card is present, it will try to read the CSN. If the test succeed and the
reader is working and a card is present on the reader, you will have two green lights.

The card type cannot be changed after the definition has been created, as the definition
includes all information about the structure of the card memory. When reading the CSN
from the first four bytes of block 0 of sector 0, the first byte is treated by default as the
least significant byte. For example, the byte series 161 198 51 70 is interpreted as
1,177,798,305. This behavior can be changed by checking the option Invert chip serial
number in the Advanced Mappings, as explained in Step 5. If checked, the first byte will
be treated as the most significant byte and the same byte series will interpreted as
2,714,121,030.

The MAD settings group box makes it possible to activate the MAD-related functionality.
Checking the first check box causes the general-purpose byte of the sector trailer of
sector 0 to be read and interpreted. This byte contains information about the MIFARE®
Application Directory.
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Three types of requirements can be defined by clicking on the  button right from the
Requirements text box: 

· whether the card has a MAD or not, 
· whether the card is a multi- or a monoapplication card,
· and whether the MAD is version 1 (Mifare 1K) or version 2 (Mifare 4K).

The second check box makes it possible to Activate or change these MAD properties. If it
is checked, the MAD will be Activated. The user can choose whether it should be a
multi-application card or not. The MAD version written depends on the card type
specified for this definition.

The last check box allows specifying whether the MAD should be read and updated
automatically. If the card has a MAD or if the MAD is activated in the definition and the
user does not check this option, he cannot use any MAD-related functionality other than
setting the general purpose byte of sector 0 and he will have to define a data item to
write the correct entries into the MAD.

Click Next to proceed with the creation of the Classic Definition and go to Step 3.
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17.1.1.3 Step 3: Define Data Items

The navigator object on the left-hand side of this pages shows a list of all Data Items
that have been defined. Data Items can be added and removed by using the respective
buttons indicated with the red rectangle. By selecting a data item, its properties can be
viewed and edited in the Data-Item Properties group on the right-hand side.

The Data Item name may include any character and can be freely chosen as long as the
name is unique. The Data Item name is used in the Advanced Mappings window to
uniquely identify the Data Item.

The Value Type determines which kind of data is read from or written to the data
blocks. The options Text, Binary, Hexadecimal, and BCD treat the blocks as read/
write blocks, whereas the option Value treats the blocks as value blocks. In the latter
case, the size of the data item cannot be changed and is one by default. In the former
case, data items can be an arbitrary number of blocks in size, as long as it does not
exceed the size of the memory on the chip. The difference between the first three types
is not in the way the data is stored, but in the way the data to be stored is provided. 
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Text items expect strings and will store the ASCII codes of the individual characters.
Binary items expect binary data to be copied into data blocks. Hexadecimal items
expect strings that contain the hexadecimal representation of the binary data to be
copied into the data blocks. BCD items expect integers and will store them as binary
coded decimals.

The Sector and the Block number indicate where on the MIFARE® Classic card the first
block of data of this item is located. Data Items are allowed to span various blocks, but
always consist of a whole number of blocks. If a write item does not supply sufficient data
for all indicated blocks, the data is supplemented with zeros.

By default, items that span various blocks will skip sector trailers when distributing the
data over the subsequent blocks. If for example the item size is four blocks and the item is
written to sector 3 block 1, the data will be distributed over sector 3 block 1 and 2 and
sector 4 block 0 and 1, skipping the sector trailer of block 3. However, if the information
to be written to the sector trailer is contained in the data item, the option Includes sector
trailers should be checked to force the data item to include the sector trailers.

Click Next to proceed with the creation of the Classic Definition and go to Step 4.
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17.1.1.4 Step 4: Configure Blocks and Sectors

The navigator object on the left-hand side shows all blocks and sectors grouped in
various ways and in a hierarchical manner. It allows the user to select a single data block,
but also entire sectors and groups of sectors. On the right-hand side the settings for the
selected sector or group of sectors and the selected block or group of blocks can
modified, and can be viewed provided that all sectors or blocks in the group share the
same setting. If any modification is done, it will apply to all selected sectors and blocks.
For example, if in the above screen shot the access conditions are changed for the data
blocks, this setting will apply to all data blocks of sector 10. After that, it is possible to
select block 0 of sector 10 and change the access conditions for this block only, without
affecting blocks 9 and 11. In general, it is advisable to start a definition with settings
shared by many blocks and work down to the exceptions to the general rule.

The first group of settings are defined on the sector level and contain the keys to be used
to logon to the sector(s). The keys are entered in hexadecimal format. If the fields do not
contain a valid hexadecimal string or contain the wrong key values, processing the
definition will result in an error. If one of the keys is not used, it is not necessary to enter
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a specific value and the default value FFFFFFFFFFFF can be left unchanged. This group
also contains a field called Data AID, that can only be edited when the selected sectors
are referred to by one or more data items and when you are reading and updating the 
MAD automatically. This is the so-called Application Identifier, which is defined on a
sector level to allow for optimal flexibility. It should be noted, however, that the Data AID
essentially refers to the data of the Data Items defined for that sector and not to the
sector itself. CardExchange™ Producer might be allowed to write application data to
another sector than specified in the definition.

If one of the selected data blocks is the target of a Data Item, it has to be indicated
whether the logon to the sectors of those blocks is to be done with key A or key B.
This is a property that can be set for each block individually and is therefore found in the
second group of settings, which contains all block-level settings.

Between the sector-level and the block-level properties, a check box allows the user
to indicate whether he wants to modify the sector trailers of the selected sectors. If
any of those has a trailer that will be written to by a Data Item, this option cannot be
selected. Otherwise, the user should provide the necessary information for writing to the
sector trailers, which is: the key to be used to logon to the sector before writing the
sector trailer, the new key values to be written and the access conditions for both the
data blocks and the sector trailer itself to be written.

The login key for the sector trailers, the new key values and the access conditions for
the sector trailers are grouped in the third block of settings, which contain all trailer-
level settings.

The access conditions for the data blocks can be set for each block individually on
MIFARE® Classic 1K. For MIFARE® Classic 4K, the access conditions are shared

between five data blocks and cannot be set for individual blocks. The small buttons 
right of the combo boxes allow the access conditions to be entered in hexadecimal
format.

Setting the access conditions this way will always affect all blocks of the selected
sector, even if only one of those blocks has been selected. A six-digit (three-byte)
hexadecimal string that represents a valid set of access conditions should be entered.
Byte nine of the sector trailer is not considered to be part of the access conditions and
will always be set to zero, except for sector 0 if MAD is used.

Click Next to proceed with the creation of the Classic Definition and go to Step 5.
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17.1.1.5 Step 5: Configure Applications

The last wizard page is only visible when reading and updating the MAD automatically.
On the left hand side the user can select an entire application and then define
application-specific settings on the right hand side. The first option determines whether
the application should be registered in the MAD. Registration can be done for both writing
and reading applications, although the latter case is somewhat awkward. At most one of
the registered applications can be designated as card-publisher application. If this is done,
a pointer the first sector of this application is written to the info byte in sector 0 block 1,
as specified by the MIFARE® Classic protocol. Otherwise, the info byte will not be
modified.

For each application, various tests can be performed on the MAD before any data item is
read or written. If the test fails, the user can choose to throw an exception, to skip
this application or to search for sectors that do fulfill the requirements. If the latter
option is chosen, the search options in the second block have to be set correctly. If Keep
sectors together is checked, CardExchange™ Producer will only search for contiguous
sectors that fulfill the requirements.
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By default, CardExchange™ Producer uses the login keys that have been defined for the
sector to which the application is actually written. In other words, by default, the login
keys defined in the previous screen are sector bound. Generally, this is the desired
behavior when writing data to empty sectors, because in that case the keys are known
for each sector individually, provided that the sector is still free. When reading an
application, the login keys are usually application bound, that is, it is known which keys
belong to a the application, but it is not known in which sector that application resides.
By checking the corresponding check box, the login keys can be made application
bound. Note that the information written to the sector trailer, including the new key
values, is always application bound. If an application is written to another sector than
specified in the definition, the trailer data will also be moved to the alternative sector.

When clicking on Finish, the wizard will prompt whether you want to hide the keys.

If you click yes, the keys will not be readable anymore the next time you open the

wizard. We recommend waiting with hiding the keys until after finishing the test phase,

when you are sure that all keys are correct. Once the keys are hidden, they CANNOT be

made visible anymore.

It is still necessary to map the data of the Data Items to database fields, card

objects, storage items, etc. This can be done in the Advanced Mappings and we refer

you to the corresponding section for more information. Once your Classic definition is

configured, the Data Items will be available in the card-items navigator of the

mappings window, as shown below:
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In the drop-down menu Type of data to be displayed in the selected card item, you

can now choose the Database column as data source.
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The created definition always contains the possibility to read the CNS, it is possible to

map those read items to a text object on the card or to a storage item.
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Last but not least, as discussed in Step 1, the CNS can be formatted with a Reversed

byte CNS number. When selecting the Chip Serial Number from the drop down menu you

will have access to some advanced Format options as indicated with the red rectangle.

For the CSN you can assign a minimum number of digits, you can set the CSN to

Hexadecimal, Reverse the byte order, and set it to Seven-byte serial number.

The last option is there because in the past MIFARE® Classic cards had a four-byte serial

number. When they started running out of unique CNS numbers, NXP decided to start

supplying Seven-byte serial number.

17.2 MIFARE® DESFire

CardExchange™ Producer supports inline encoding and reading of MIFARE® DESFire

cards. What information should be read or written can be configured by means of the 

DESFire Wizard, which will be the subject of this chapter. For a full understanding of the

DESFire Wizard, it is essential to have knowledge about the functionality of the

MIFARE® DESFire chip. Please, refer to the MIFARE® DESFire documentation published by

NXP for more information

Please visit http://www.nxp.com for more information.

http://www.nxp.com
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It is possible that the DESFire Wizard does not offer all functionality you need to achieve

your goals. For example, you might need functionality of the DESFire protocol that is not

configurable via the wizard, or special transformations of the database data before they

can be written to the chip. For this type of situations, we can offer a solution by means

of an External Plug In. Please, contact sales for more information about External Plug Ins.

Please, note that currently the following limitations exist with respect to MIFARE®

DESFire encoding:

· The supported readers are DigiOn24, ProActive and OmniKey CardMan 5x21.

· The supported file types are Standard data files and Value files.

· MIFARE® DESFire EV1 is only supported on the OmniKey CardMan 5x21.

· Value files are only supported on OmniKey CardMan 5x21.

· Key diversification is only supported for AES keys.

· If a MIFARE® SAM is used for authentication, this should be a MIFARE® SAM

AV2 and it should be inserted in an OmniKey CardMan 5x21 reader.

Note: EV1 refers to the hardware version of the MIFARE® DESFire chips.

Note: SAM stands for Secure Application Module. It is a chip on which the DESFire keys

can be stored in such a way, that nobody involved in the encoding process has access to

the actual key values, not even when the CardExchange™ Producer software or

computer would be hacked. AV2 refers to the hardware version of the MIFARE® SAM.
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17.2.1 Read and Write Items

With the DESFire Wizard it is possible to define DESFire read items and DESFire write

items. With read items, you can read data from DESFire and print it on the card or store

it in the database. With write items, you can encode data from the database or other

data sources on DESFire. Read and write items can be intertwined in a single DESFire

definition, in which case it is important to realize the order of the different actions that

make up the print process.

· Execute External Plug Ins with the evaluation moment ‘Before moving the card

into the printer’.

· Move the card into encoding position.

· Execute External Plug Ins with the evaluation moment ‘Before reading from

MIFARE®’.

· Read data from the MIFARE®.
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· Execute External Plug Ins with the evaluation moment ‘Before writing to

MIFARE®’.

· Write data to MIFARE®.

· Execute External Plug Ins with the evaluation moment ‘After reading/writing to

MIFARE®’.

· Print the card.

· Execute External Plug Ins with the evaluation moment ‘After printing the card’.

· Write data to the database (Storage Items).

· Execute External Plug Ins with the evaluation moment ‘Before writing to the

database’.

It is possible to read data from the chip, manipulate it with an External Plug In and write it

back to the chip.

17.2.2 Creating DESFire Encoding

To encode MIFARE® DESFire encoding we have to set the system up for this. Encoding is

setup via the Designer so click on Card Setup to start the Designer.
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Click on New, as indicated with the red arrow to start the MIFARE® DESFire Setup Wizard

and follow the steps as described in the sub sections of this topic.
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17.2.2.1 Step 1: Define Reader Settings

The first wizard page allows for choosing the contactless reader and setting the SAM-

authentication settings in case a Secure Authentication Module is used. Use the

Reader type drop down menu to select the contactless reader you want to use for

reading/writing the DESFire card.

CardExchange™ Producer supports the DigiOn24, ProActive and OmniKey CardMan 5x21

contactless readers. The OmniKey readers are only shown in the menu, if they have been

connected to the system and are accessible by CardExchange™ Producer. The

contactless readers “with SAM” are only listed if an OmniKey CardMan 5x21 reader is

attached to the system and a MIFARE® SAM AV2 card is inserted in the contact slot of

the reader.

For DigiOn24 readers, it is necessary to specify the Serial port to which the reader is

connected and the Baud rate at which the reader operates. For ProActive readers, you

can either specify the correct serial port, or set the serial port to zero in order to have
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the CardExchange™ Producer search for the first available ProActive reader.

You can use the Test button to check whether the reader is operational and whether it

recognizes a card placed on the reader. In case the card is recognized correctly, the chip

serial number or unique identifier (UID) will be shown (see screen shot below). Otherwise,

an error message will be shown in the Message box.

In case you have selected a reader “with SAM”, you have to specify whether the SAM

requires host authentication (Does the SAM AV2 module require host

authentication?). If so, specify the correct Key number, Key version and Key value

of the hos-authentication key on the SAM. The key value should be a 16-byte

hexadecimal string, with optional spaces between successive bytes, as in the above

screen shot.

Click Next to proceed with the creation of the DESFire Definition and go to Step 2.
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17.2.2.2 Step 2: Define Master Key Settings

This wizard page allows for defining PICC-level settings. The acronym PICC refers to

Proximity Integrated Circuit Chip and is used to designate the entire chip, in contrast

to specific files of applications on the chip. Enabling the option Do you want to format

this card? (only available on DESFire EV1) will remove all files and applications from the

card before starting the encoding. It does not reset the PICC master key and key

settings.  Formatting the card is only possible if you know the PICC master key and if

the PICC master-key settings allow this operation. The option is mainly meant for

reusing cards in a test situation.

Please, note that formatting the card does not recover the memory space used by the

files and applications. Repeatedly formatting a card will end up in exhausting the available

memory space.

The option Do you want to disable formatting for this card? (only available on DESFire

EV1) disables the possibility to format the card in the future irreversibly.
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The option Do you want to enable random ID for this card? (only available on DESFire

EV1) offers en extra security layer for the card. It makes sure that in the future, the chip

serial number or UID of the card can only be read after a successful authentication with

either the PICC master key or one of the application keys. Once this option is set,

selecting the card will return a random 4-byte UID, instead of the real 7-byte UID.

Special care has to be taken when reading cards that have the Random ID already

enabled. If you want to store the DESFire UID in the database or use it for key

diversification, you need instruct CardExchange™ Producer to perform an authentication

and retrieve the Real UID. This can be done with the  button next to the Random-ID

option. It will open the following dialog box and allows you to specify the key and key

value to be used for authentication. This key should not be diversified, as diversified

keys can only be calculated when the real DESFire UID is known.

When selecting the option Do you want to change the master key?, CardExchange™

Producer will change the PICC master key after encoding all files and applications, but

before changing the PICC master-key settings. The new master key, as well as the

key’s crypto method, will need to be specified. Without this option, only the current

master key and its crypto methods need to be specified.

When selecting the option Do you want to change the master-key settings?,

CardExchange™ Producer will change the PICC master-key settings as specified, after

optionally changing the master key. Both for changing the master key and the master-key

settings, it is necessary that the original master-key settings allow for such a change.

Click Next to proceed with the creation of the DESFire Definition and go to Step 3.

17.2.2.2.1  Specifying Key Values

Each key value is entered as a 16-byte hexadecimal string with optional spaces

between successive bytes, except when choosing the 3K3DES (three-key triple DES)

encryption method, in which case the key has 24 bytes. The crypto methods 3K3DES

and AES are only available for DESFire EV1. Note that AES is the recommended crypto

method, as it complies with the internationally recognized security standards. 3K3DES is
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known to give technical problems with the OmniKey CardMan 5x21 readers and is NOT

recommended.

By the default, the key specified in the key-value text boxes are the DESFire keys

themselves. However, CardExchange™ Producer offers the possibility to use diversified or

randomized keys. Next to the crypto-method drop-down menu, a  button allows for

choosing between these options.

Diversified keys are a protocol in which the actual DESFire keys are different on all

cards, thus offering an extra security layer. The actual keys can be calculated by using a

master key and a diversification input. The diversification input contains the card’s UID,

which ensures that the results of the calculations are different for every card. When

diversified keys are enabled, CardExchange™ Producer expects you to specify the

diversification master key, rather than the DESFire key itself.

In case of diversified keys, it is necessary to specify the diversification input. The

diversification input always starts with the DESFire UID and can be followed by any data

the user desires (like the application AID and/or the key number). Note that key

diversification has only been implemented for AES keys and follow the application note

AN10922 published by NXP. In this document the byte 0x01 that precedes the

diversification input is not considered part of the diversification input, but it is important

to realize that CardExchange™ Producer does actually add this byte to construct the

CMAC input parameter D.

When randomized keys are enabled, CardExchange™ Producer will use a random key

value rather than the one you typed. This option should only be used for new keys, as the

result will never coincide with an existing key, and you should only use it if you are sure

that you never want to use that key again. It is a way to lock the possibility to make

certain changes to the card, in addition to the key settings.

Using the MIFARE® SAM AV2 secure application module is another case in which you will

not supply the real DESFire keys either. Instead, you will need to use the key-value box to

supply encoded instructions about how to authenticate with the SAM. You have to

specify the following information:
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· Byte 0 contains either the SAM key number or the application key number.

· Byte 1 contains the key version.

· Byte 2 contains the authentication mode, which can have the following values

(other options are not supported by the DESFire-definition wizard):

o 0 when the key is not diversified and byte 0 contains the SAM key number.

o 2 when the key is not diversified and byte 0 contains the application key

number.

Key diversification can be used in combination with the SAM AV2 module. CardExchange™

Producer will always use the MIFARE® SAM AV2 mode diversification and set the

corresponding bits of the authentication mode automatically.

17.2.2.3 Step 3: Defining Data Items

All data transfers between DESFire files and CardExchange™ Producer is done through

DESFire items. A DESFire item is considered to be a meaningful piece of data that is readily

available in the database (in case of write items) or can be printed or stored in the

database without further transformations (in the case of read items). DESFire items can

combine data of several DESFire files into a single value, whereas multiple DESFire items

can be stored in a single DESFire file. DESFire items can convert data back and forth

between binary and other representations of the data, like ASCII text, integer values,

binary coded decimals and hexadecimal strings. The possibility to define DESFire items

makes the DESFire-definition wizard particularly flexible.
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With the Add and Remove buttons DESFire items, indicated with the red rectangle, can

be added and removed. There is no other limit with respect to the number of items you

define than the amount of memory available on the DESFire chip.

Each item is characterized by an Item Name, which can be any text string that explains

the meaning of the data.

The Item Type determines what data transformations are performed between the binary

data in the DESFire files and the External Data mapped to the DESFire items. These

are the available options, with an explanation of the data transformations in case the

DESFire item is a write item:

Text The input data is

interpreted as ASCII

encoded text and

the ASCII values

ABC becomes 41 42 43 00 00 00 00 …
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are stored in the

DESFire file.

Binary The input data must

be binary data and

will be encoded as

such in the DESFire

file, without any

data transformation.

Hexade

cimal

The input data is

interpreted as a

hexadecimal string

and can only

contain the

hexadecimal

characters and

spaces. The input

data will be

transformed to

binary data byte per

byte.

412143 becomes 41 42 43 00 00 00 00 …

Binary

integer

The input data is an

eight-byte integer

(or smaller) that will

be encoded in a

binary fashion with

the least significant

byte first.

414243 becomes 23 52 06 00 00 00 00 …

Binary

coded

decima

l

The input data in an

eight-byte integer

(or smaller) that will

be encoded as BCD

with the most

significant digit first.

414243 becomes 41 42 43 00 00 00 00 …

ASCII

coded

decima

l

The input data in an

eight-byte integer

(or smaller) that will

be encoded as

ASCII text with the

most significant

digit first.

414243 -> becomes 34 31 34 32 34 33 00 …

For all representations, the data is padded with zero bytes if the size of the data item is

bigger than the amount of data presented. On the other hand, if more data is presented
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than what fits in the data item, the data is silently truncated. This will not cause any

error message.  In general, CardExchange™ Producer is very flexible with respect to

discrepancies between the presented data and the item type. For example, if you present

binary data to a data item, the data will be encoded as such, no matter whether you

selected the binary item type or not. On the other hand, if you present text data to one

of the integer item types, it will try to convert that text to an integer. Exceptions will only

be thrown if CardExchange™ Producer does not succeed in doing a silent conversion.

The size of the data item is specified by means of the length in bytes. Be aware that

integers are limited to eight bytes in size, so for any data that exceeds this size, the data

representation should be text, binary or hexadecimal. If needed, an External Plug In

can be used to transform database data to a representation that can be handled by the 

DESFire wizard.

The Processing options determine whether a DESFire item is a read or a write item.

For write items, it is possible to perform a write verify to ensure that the data is really

encoded onto the DESFire chip. It is possible that a single item is both a read and a

write item. In that case the item is first read and then written. This makes only sense if

a External Plug In performs some data manipulation in between the read and the write

actions.

There are a number of Advanced settings, whose availability depends on the chosen

item type.

· The option Hexadecimal input strings is only available for binary integers, binary

coded decimals and ASCII coded decimals. If this option is selected, the input data

will be considered as hexadecimal data instead of decimal data. So, if the

presented data to a binary integer is for example 16, CardExchange™ Producer will

interpret this as the decimal value 22  and encode it as 16 00 00 00 …

· Right align is available for all item types. When selected items will be preceded

with zero bytes, rather than padded, to make the data fit in the item. For example,

if the item size is 5, ‘ABC’ will be converted to 00 00 41 42 43.

· Reverse bytes reverses the order of all bytes in a data item. For example, if the

item size is 5 and right align is not selected, ‘ABC’ will be converted to 00 00 43 42

42.

If the selected item type is a binary or ASCII coded decimal, the option Trailer digits

specifies what hexadecimal digits should be encoded after the actual data. For example,

if the number 414243 is presented to a BCD-item and the Trailer digits are set to ‘FFF’,

CardExchange™ Producer will encode 41 42 43 FF F0 00 … In practice, binary or ASCII

coded decimals should either have a fixed length, be right aligned or have a non-decimal

trailer digit.

Click Next to proceed with the creation of the DESFire Definition and go to Step 4.
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17.2.2.4 Step 4: Define Your Applications

This page allows for defining which applications should be created or already exist on the

DESFire card.

DESFire Applications can be added and removed with the Add and Remove buttons

indicated with the red rectangle. They are characterized by their Application ID, which

is a six-digit (three-byte) hexadecimal string. For DESFire EV1 cards, it is possible to

specify an ISO file ID (two hexadecimal digits) and a DF name (maximum sixteen

characters text). The latter two properties are not used by CardExchange when reading

applications, but they can be encoded to be compliant with ISO standards. Finally, you

need to specify the Number of keys to be defined for this application and the

Cryptographic method (DES-triple DES, three-key triple DES or AES).

With regard to the DF Name, there is a hidden option in case you want to use a DF name

that does not consist of readable ASCII text. In that case, it is possible to specify the DF

name with a hexadecimal string. To indicate that you are using this option, you should
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start the DF name with &H or 0x, followed by the hexadecimal string.

The Processing options allow for specifying whether an application should be created if

it does not exist on the DESFire chip yet, Create if not found, which is normally checked

for DESFire definitions with write items that operate on blank cards. When an application is

created, all its keys are set to zero and it will be necessary to check Change keys in

order to set the keys to the desired values. Normally, applications can be created with the

desired final key settings, but sometimes, these key settings are too restrictive. In

practice, you only need to use the option Change key settings if the application master

key needs to be set to a non-zero value and you do not want to allow future changes of

the application master key. In that case, you create the application allowing future

changes of the master key, then change the master key, and then change the key

settings to not allowing future changes of the master key.

The initial and final keys and key settings can be set by clicking the respective button

with three dots. The Current or initially created key settings should contain zero keys

for new applications and the actual keys for existing applications, as far as these are

known and needed. When creating a new application, the initial key settings should be

selected such, that the configured actions in the DESFire wizard can be executed. That

means that you should not restrict future changes of the master key if you still need to

change the master key. For existing applications, CardExchange™ Producer will try to read

the current key settings from the card and only use the selected ones if that fails or is

not allowed.
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The Final key settings window is exactly the same, with the only difference that now

you specify the desired keys and key settings after writing the application and changing

the keys.

Note: it is not common to create applications, change keys or change key settings, if a

DESFire definition only contains read items.

Note: key values can be diversified, randomized or be read from a MIFARE® SAM AV2.

This is configured in the same way as already described for the PICC master key, as can

be seen the section Specifying key values above.

Click Next to proceed with the creation of the DESFire Definition and go to Step 5.
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17.2.2.5 Step 5: Define Your Files

On this page of the wizard you will define for each application which file should be

created, read and/or written. They can be added and removed with the Add and Remove

buttons, as indicated with the red rectangle, and are characterized by a File ID (a one-

byte hexadecimal value) and optionally an ISO File ID (a two-byte hexadecimal value, EV1

only).

CardExchange supports two file types:

· Standard data files, which contain an arbitrary amount of bytes in an arbitrary

format, and

· Value files, which contain a four-byte integer value.

Currently, value files are only supported for OmniKey CardMan 5x21 readers, but that

might change in the future. The length of a standard data file must be specified (Size in

bytes). The length of a value file is always four, but for a value file, other settings are
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configurable by clicking on the  button.

The most common application of a value file is the MAD-3 standard, which requires that

application FFFFFF file 01 is a value file that contains the value 3. The above screen shot

reflect the settings that the MAD-3 file requires. Especially, the Free GetValue feature

needs to be enabled for MAD 3.

An important difference between standard data files and value files is that it is possible

to write data to existing standard data files. Any data you map to a value file will only be

written if the file is created, and will be neglected if the file already exists on the DESFire

chip.

There are three Processing options:

· Create if not found makes sure that the file is created if it does not exist yet, and

is normally checked when writing data to newly created applications.

· Change file setting makes it possible to change the file settings after writing the

data to it. For value files, this option will normally not be needed, as you cannot

write data and you can create the file directly with the correct final file settings.

For standard data files, it might be necessary to have the initial file settings less

restrictive than the final file settings, for example if the final file settings forbid

writing data to the file.

· The DESFire file settings allow for defining a read key, a write key and a read/

write key, which might be the same key, but they can also be different. If the

read/write key is different from the read or write key, CardExchange will use the

read or write key by default for authentication. In rare cases, it might be possible

that you need to write to or read from existing applications while only knowing the

read/write key. In that case, select the option Use read/write key to ensure that

CardExchange™ Producer uses the read/write key.

In the File settings section, you can specify the current or initially created file

settings. For new files, CardExchange™ Producer will create the file with these settings.
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For existing files, CardExchange™ Producer will try to read the file settings from the chip,

but if that is not possible, it will assume that the specified current file settings apply.

Two file settings need to be defined: the Communication mode and the Access mode.

The Communication mode is either Plain, Maced or Enciphered (do not use the

option Plain2). Please, refer to the DESFire documentation for more information about

this option. Effectively, Plain means that the data in the file is freely accessible, Maced

means that the data is not encrypted, but that it is digitally signed and only accessible

after a valid authentication. Enciphered means that the data is fully encrypted and that

authentication with the correct key is required to decrypt the data.

The Access mode defines what functions the application keys have for this file. The first

digit specifies the read key, the second digit the write key, the third digit the read/write

key and the final digit the change-access-rights key. The digits can be either 0 to D to

refer to one of the application keys, E to indicate that the action can be done without

authentication (free access), and F to indicate that the action is forbidden (deny access).

The button with the three dots allows for setting the access mode in a more intuitive

way.

If you selected Change file settings, you also have to specify the Final file settings,

which is done in the same way.

Click Next to proceed with the creation of the DESFire Definition and go to the last step

of this wizard, Step 6.
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17.2.2.6 Step 6: Map Items to Files

Now, your DESFire items, applications and files have been defined, the only thing that

remains to be done is mapping the bytes of the DESFire items to the bytes of the

DESFire files which is done at this last wizard page.

On the left-hand site, all DESFire files are listed. By selecting the DESFire file and

clicking the Add or Remove button, indicated with the red rectangle, you can add file

fragments to each file. For each file fragment, you select from which Data item it will

contain data and with the File offset in bytes you indicate where in the file the file

fragment starts. If you select Map entire DESFire item, the entire DESFire item will be

mapped to the file, starting at the indicated offset position. On the contrary, you have to

specify which part of the DESFire item needs to be mapped, by setting the Start byte

and the Length in bytes.

In many cases, you will want to map an entire DESFire item to an entire file. In that case,

you add a single file fragment to the file, set the File offset in bytes to zero and select
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Map entire DESFire item, as in the above screen shot. The length of the DESFire file and

item will need to be the same. The DESFire definition has now been configured.

When clicking on Finish, the wizard will prompt whether you want to hide the keys. If

you click yes, the keys will not be readable anymore the next time you open the

wizard. We recommend waiting with hiding the keys until after finishing the test phase,

when you are sure that all keys are correct. Once the keys are hidden, they CANNOT be

made visible anymore.

It is still necessary to map the data of the DESFire items to database fields, card

objects, storage items, etc. This can be done in the Advanced Mappings and we refer

you to the corresponding section for more information. Once your DESFire definition is

configured, the DESFire write items will be available in the card-items navigator of the

mappings window, as shown below:

In the drop-down menu Type of data to be displayed in the selected card item, you

can now choose the DESFire serial number as data source.
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If the DESFire definition contains any read items, it is possible to map those read items

to a text object on the card or to a storage item.
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17.3 HID® Proximity

To set-up a new HID® Proximity definition, please make sure that the Show Advanced

Mappings is enabled in the Advanced Options menu. First click Edit card definition as

indicated with the red arrow to open the Card Definition Wizard.

It is important to know that we use the MIFARE® Classic definitions to create HID

definitions files. Therefore the procedure looks similar in the beginning for HID as it is with

Classic. The main difference is the fact that we cannot write to HID Proximity cards, only

reading!
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Now proceed as following:

· select Do you want to enable contactless encoding? indicated with the red

arrow,  

· select Do you want to read from MIFARE® Classic? indicated with the purple

arrow, 

· type a valid file name for your definition file in the text box next to the above

option indicated with the blue rectangle, 

· and click on the Create button to open the Classic Definition Wizard, indicated

with the black arrow.

It is possible to select an existing Classic Definition with the Browse button ( ), or by

typing a file name that already exists on your system. In that case, the Edit button will

be enabled instead of the Create button, and clicking it will open the Classic Definition

Wizard for the existing definition.
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17.3.1 Create HID Encoding

To set-up a new HID® Proximity definition, please make sure that the Show Advanced

Mappings is enabled in the Advanced Options menu. First click Edit card definition as

indicated with the red arrow to open the Card Definition Wizard.

It is important to know that we use the MIFARE® Classic definitions to create HID

definitions files. Therefore the procedure looks similar in the beginning for HID as it is with

Classic. The main difference is the fact that we cannot write to HID Proximity cards, only

reading!

Now proceed as following:

· select Do you want to enable contactless encoding? indicated with the red

arrow,  
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· select Do you want to read from MIFARE® Classic? indicated with the purple

arrow, 

· type a valid file name for your definition file in the text box next to the above

option indicated with the blue rectangle, 

· and click on the Create button to open the Classic Definition Wizard, indicated

with the black arrow.

It is possible to select an existing Classic Definition with the Browse button ( ), or by

typing a file name that already exists on your system. In that case, the Edit button will

be enabled instead of the Create button, and clicking it will open the Classic Definition

Wizard for the existing definition.

17.3.1.1 Step 1: Select Card Type

When we have entered a name for the definition into the text box and we click on 
Create, a dialog box 'Create New Mifare Definition' will be shown asking to make a
choice for the type of card to use.

You can select to create a definition for a HID® Proximity encoding. As you can see, you
can also select MIFARE® 1K or 4K. This is because we also use the same wizard for
defining MIFARE® Classic encoding. See our MIFARE® Classic section of this Help file for
more information.

In this case we select HID® Proximity and click Yes to confirm and proceed with Step 2.
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17.3.1.2 Step 2: Define General Settings

The General settings group box allows choosing the reader type, the serial port to
which the reader is connected and the baud rate to be used. CardExchange™ Producer
does not support a lot of readers for encoding HID® Proximity. Currently we support 
DigiOn24 and PC/SC 1 and 2 readers like OmniKey.

PC/SC readers are only available when installed on your system. If the reader is not
available, please make sure it is installed properly. You can click on the Refresh button to
reload the list with available readers.   You are able to test if the connected reader is
working and responding correctly. Click on the Test button to open the MIFARE® Reader
Test window.
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When pressing the Test button, CardExchange™ Producer will try to connect with the
reader and, if a card is present, it will try to read the CSN. If the test succeed and the
reader is working and a card is present on the reader, you will have two green lights.

When you have selected and tested the reader, you are done with the wizard and you
can click Finish.

Compared to DESFire or Classic encoding, the HID definition does not contain any Data

Items. The HID definition contains a set of items collected inside a MIFARE® item. This is

done in the Advanced Mappings and we refer you to the corresponding section for more

information. Once your HID definition is configured, the MIFARE Item will be available in

the card-items navigator of the mappings window, as indicated below with the red

arrow:
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When you have selected the MIFARE Item, you will be able to select a separate Item from

the drop down menu as indicated with the red arrow below:
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The HID definition created offers six different flavors to chose from:

· Card number

· Country code

· Facility code

· Number of bits

· Raw data

· State code
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18 Service Center

With the release of CardExchange™ Producer 8 we brought unique innovation to your
desktop by offering everything that you need to produce cards in a fast and secure way
at hand in the CardExchange™ Producer Service Center.

Help, Forum, Videos, etc., it is all available in this section of your CardExchange™
Producer product. When you enter the Service Center by selecting the corresponding tab,
you will directly see an Outlook style interface showing on the left the available news
items and on the right the content of this news item.

CardExchange™ Producer uses this section to keep you informed about new updates and
release plans so you will always be able to run the latest version. But also the reseller who
has sold the product to you will keep you informed about his latest and greatest.

Take a look at the separate subjects in this section of the Help file and see how this is
going to benefit you!

18.1 Help
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Have access to online help file directly by clicking on the Help button indicated with the
red arrow.

Our online Help files are always up to date and contain always examples with each
available functionality. On the left side you see all the available and selectable subjects,
and on the right the content of the selected subject. Of course you need to have an
online internet connection. When no internet connection is available, the internal Help file
will be loaded:
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We always strive to have the internal Help file updated to with the latest release but
unfortunately we cannot guarantee this. 

18.2 Forum

Unique for our industry is our end-user forum. On this forum you can find information from
and by other users of CardExchange™ Producer.
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Take a look at all the recent topics and search for solutions you need. Is your solution not
available, just register yourself and post it on the forum. Besides other high level users of
CardExchange™ Producer, all our developers are answering forum questions. We are proud
to say that our average response time on this forum is one and a half hour.

Are you looking for answers and solutions? This is the place to be. Don't forget, by posting
your questions you are not only helping yourself, you are also helping other users of
CardExchange™ Producer!

18.3 Video Tutorials
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Sometimes it is handy to see how things are done in stead of reading text or other
information. Therefore CardExchange™ Producer offers a large selection of How-To Videos
in our Video Tutorials section.

In this section you can find videos about installing CardExchange™ Producer,
activating and moving licenses, MS Excel Connections, How to use Photos, etc.

All available videos are offered in English and Spanish!

18.4 Upgrade Your License
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In the section Activation and Registration we have explained how you activate your new
CardExchange™ Producer license. When you decided that you want to upgrade to a higher
edition, and you have ordered the upgrade, you have probably received a new serial
number and activation code via email from your reseller.

To get to the higher edition, you will have to activate the new license first. To activate
your upgrade, click in the Activation Window button indicated with the red arrow and
the CardExchange™ Producer License Activation Wizard will start.

Enter the serial number and activation code into the text boxes and click on Activate
to start the process.
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If needed you can make changes to your previous registration information, if not, click 
Next to proceed.
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If you would like to be contacted, just select how and when, and your reseller will contact
you on the preferred date selected. You can also change your subscription to our
newsletter.

Click Next to proceed to the Final page of the activation process.
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When you click on Finish, the dialog below will pop up:

Click on OK to confirm and restart CardExchange™ Producer.

18.5 Update Your Registration Info

When you have registered your software, you can always update your registration
information. Click on the Register License button indicated with the red arrow and
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CardExchange™ Producer License Activation Wizard will start.

The registration process is a part of the activation process and therefore the same
process is used. It does not effect your license information, only your registration
information.

Now change the information you want to change and proceed to the Next page when
done.
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If you would like to be contacted, just select how and when, and your reseller will contact
you on the preferred date selected. You can also change your subscription to our
newsletter.

Click Next to proceed to the Final page of the Registration process.
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18.6 About CardExchange®

Sometimes when you need support you will be asked which edition and version you are
running of CardExchange™ Producer. All this type of information can be found in the 
About CardExchange™ Producer section. Just click on the button indicated with the
red arrow, and the window below will be presented:
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In this window you can find the edition and version you are running. This can be
important to see if you are running the latest version with regards to solved bugs.

You also can see your serial number which enables us or your reseller to request your
activation code, if needed. It also contains the Client code of your license. The Client
code indicated who has supplied your license. Last but least, it shows the Machine ID,
the digital fingerprint of your computer for your CardExchange™ Producer license.

When you are running a Entry edition and you would like to know what type of
functionality is offered in other editions of CardExchange™ Producer, just click on the 
Compare editions button indicated with the red arrow and it will bring you to the
Compare editions section on our website:
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Here you can see all the offered functionality available for each separate edition.

18.7 Contact Information

All CardExchange™ Producer Resellers and Distributors have a long history in the ID Card
Printing market and can advice and help you to make the right choices. But unfortunately
it is not always know for the user of our software who supplied the software and were to
go to for support.

With the release of CardExchange™ Producer version 8 we have solved that problem for
you. At the section indicated with the red rectangle you always find one button
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indicated with the red arrow. This button contains the Company Logo of the
CardExchange™ Producer partner that supplied you the software and if you click on the
button, it will directly bring you to his home page so you can find all his contact
information.

When applicable, in the same section you can find a second button, indicated with the
blue arrow, that will bring you directly to the web shop of our partner so you can buy
upgrades, supplies, etc.

Together with all the other functionality offered in our Service Center, we strive to offer 
high quality with high service without limitations.
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19 External Plug In's

External Plug-Ins is CardExchange™ Producer most powerful and flexible custom
functionality offered! An External Plug-In is basically a wrapper that can contain any
possible functionality you can imagine. Most common is the embedding of third party
SDK's. For example, want to embed a specific bio-metric fingerprint scanner, or a driver-
license scanner, etc., we can simply embed the functionality of the readers into an
External Plug-In and make the functionality available inside CardExchange™ Producer.
External Plug-Ins are developed by ExchangeIt and have quick turnarounds with low cost
and offer unlimited possibilities to get into project business without spending thousands
and thousands in customization.

How does it work?

When you have specific need for, for example, a finger print scanner, first contact your
CardExchange™ Producer Reseller. Inform them about what reader you want to use, if
there is an SDK available, what you want to accomplish, for example, do you want to
store the finger print image but also the template, etc.

The reseller will contact ExchangeIt for a quote and will get back to you with a price and
time frame. When you decide to proceed with the External Plug-In, in most cases you will
have to make a reader and the SDK available for ExchangeIt and ship this to us have your
reseller ship it to us. Don't know your reseller? Please take a look in the Service Center
and see who you reseller is to contact.
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19.1 Configure External Plug Ins

When you have ordered and received a External Plug-In you will have to configure
CardExchange™ Producer to be able to use this Plug-In. To get access to the Plug-In
functionality, you will first have to access the Card Definition Wizard.

To call the Card Definition Wizard you have to click on the Edit card definition button in
the Configuration tab. If you do not see this button, please change the configuration
settings as described in the Advanced Options section of this Help file.

When the Edit card definition button is pressed, the Card definition wizards opens and you
need to select "Do you want to use external functions or plug-ins?" and click on Edit to
start the wizard. 
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General Properties

· Name - Enter a name for the External Plug-In, for example Fingerprint Scan
· DLL File - Browse and select the External Plug-In file you received
· Call when printing - Select if the plug-in needs to be called during the print process
· Call using a button - Select if the plug-in needs to be made available via an button in

the Main Interface
· Call when showing preview - Select if the plug-in needs to be executed every time

the preview is reloaded

Evaluation moment

Check one of the available evaluation moments. For example, if you have an external plug-
in that calculates a special value based on the CSN of a MIFARE® Classic 1K card you use
before writing to MIFARE® so the calculated value is available for storage or printing in
the template.

Click on Finish to store the settings.



CardExchange® Producer Help396

© 2016 CardExchange Solutions, Inc.

Click on Next in the Card Definition Wizard and select the External-function input tab and
connect it to the preferred mapping.

IMPORTANT! External Plug-Ins can have input as well output funtionality!

19.2 Void Plug Ins

Void plug-ins

The CardExchange™ Producer external plug-in framework has a hidden feature, which is

the possibility to define a void plug-in. Void plug-ins offer two possibilities that are

otherwise not possible: controlling when a .NET Function is executed and using a single

manual entry for multiple card items.

Description

A void plug-in is created by defining a plug-in that does not reference a real plug-in DLL.

If CardExchange™ Producer detects that no real plug-in is selected, it creates an internal

plug-in with one input parameter, called "Definition", and one output parameter, called

"Result". When executed, the plug-in copies the value of the input parameter to the
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output parameter.

By mapping a .NET function to the Definition parameter of a void plug-in, it is possible to

combine the advantages of .NET Functions with the advantages of plug-ins, that is, you

can develop your own  .NET functions and you can still control when the function is

executed by using the settings in the plug-in wizard.

By mapping the Definition parameter to a manual entry, you can use the result of a single

manual entry in multiple mappings. That makes it possible to have a single manual entry

whose value is both printed on the card and stored in the database.

For manual entries, you will often want the void plug-in to be executed whenever you call

a preview. However, when the void plug-in is used in combination with a .NET function,

you will often prefer to execute it during the print process only, or when clicking a button.

Example

To illustrate how void plug-ins work, we will create a card definition with a single manual

entry that is both printed on the card and stored in the database.

1. To start, add a new card definition that consists of a card layout with a data text

object called "ManualText" and a data definition  with a storage item called

"ManualText".

2. Select "Do you want to use external functions or plug-ins" in the card-definition wizard

and click the Edit button to configure the plug-in.

3. Add a plug-in called "ManualText" and type "void" in the DLL-file field. Then click Finish.
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4. Click Next to go to the mappings window and map the visible item called "ManualText"
to the plug-in output "ManualText.Result". Then map the plug-in input
"ManualText.Definition" to "Enter manually".
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5. Select the Storage items tab and map the storage item "ManualText" to the external
function output.

6. Cick Finish to close the card-definiton wizard en open the manual-entry window. You
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will see, that there is a single manual entry.

7. Print the card. You will now see that the manual entry is stored in the database.
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